
EuroCUT Basic 8 Manual





Table of Contents

Software License Agreement............................................................................................1

Important Information for EuroCUT Clients.....................................................................7
System requirements......................................................................................................7
Restriction of Warranty....................................................................................................7
Trademark.......................................................................................................................8
Support And Sales Information.......................................................................................8
Imprint.............................................................................................................................9

Second User License.......................................................................................................11

Copyright...........................................................................................................................13
EuroCUT uses the OpenCV..........................................................................................13
EuroCUT uses NLog.....................................................................................................14

About This Manual............................................................................................................15
Typographical Orientation Guides.................................................................................16

1 Preface............................................................................................................................17

2 Abilities of EuroCUT - Feature List..............................................................................19

3 Quickstart and Installation............................................................................................27
3.1 Quickstart................................................................................................................27

3.1.1 How to Install EuroCUT?................................................................................27
3.1.2 Enter License Data (without Dongle)..............................................................31
3.1.3 Enter License Data (with Dongle)...................................................................33

3.2 The Cut Marks Toolbar............................................................................................34
3.2.1 The Cut Marks Workflow.................................................................................34
3.2.2 The Cut Marks Toolbar in CorelDRAW X3-X8 and 2017-2022.......................34
3.2.3 The File Menu Entries in Illustrator CS3-CS6 and CC....................................35

3.3 Autoexport - Scripts.................................................................................................39
3.3.1 Corun Installer.................................................................................................39
3.3.2 Insert EuroCUT Icon in CorelDRAW Toolbar..................................................40
3.3.3 EuroCUT Script in Inkscape............................................................................41
3.3.4 EuroCUT Script in Adobe Illustrator 8-10, CS-CS6, CC.................................41
3.3.5 EuroCUT Script in Adobe InDesign CS4-CS6, CC.........................................42
3.3.6 EuroCUT Script in AutoCAD...........................................................................42

3.4 Selection of The Device Driver................................................................................43

4 How to work with EuroCUT...........................................................................................45
4.1 Desktop and Working Sheet....................................................................................45

4.1.1 I. Desktop........................................................................................................45
4.1.2 II. Working Area..............................................................................................45

4.2 Job Preparation.......................................................................................................48
4.2.1 Import..............................................................................................................49

4.3 The EuroCUT Layer dialog......................................................................................52
4.4 Tool Assignment Via Layer.....................................................................................53

4.4.1 Define Layer Assignment................................................................................53

EuroCUT Basic 8 Manual

i



Table of Contents

4 How to work with EuroCUT
4.4.2 How the Tool Sequence Is Determined?........................................................56

4.5 The Output..............................................................................................................57
4.5.1 Device Setting - Interface Setup (Local Device).............................................57
4.5.2 Device Setting (Network Device)....................................................................59
4.5.3 Start Output from the EuroCUT Working Surface...........................................60

4.6 Export......................................................................................................................68
4.6.1 PDF Export.....................................................................................................70

4.7 Flex-Cut, Half-Cut - Punch Function.......................................................................72
4.7.1 EuroCUT Driver Options Using a Roll Plotter.................................................72
4.7.2 Step by Step Instruction..................................................................................72

4.8 Excursion: Contour vs Outline vs Contour Line.......................................................76
4.8.1 1. Contour.......................................................................................................76
4.8.2 2. Outline.........................................................................................................78
4.8.3 3. Contour Line...............................................................................................79

4.9 Excursus: Welding of Vector Objects......................................................................81
4.9.1 A Selection of the Most Important Welding Sub Types...................................81

4.10 Label Production with Cutters with Optical Sensor...............................................84
4.10.1 1. Step: Job Preparation...............................................................................84
4.10.2 Jog Marks for Optical Recognition Systems.................................................85
4.10.3 2. Step: The Print Process............................................................................86
4.10.4 3. Step: The Cutting Process........................................................................86

4.11 Cutting - Milling - Creasing - Drawing …...............................................................89
4.11.1 The Output Preview .....................................................................................89

4.12 The Layout View Mode..........................................................................................96
4.12.1 Definition:......................................................................................................96
4.12.2 Definition Container......................................................................................96
4.12.3 Overview Container Types............................................................................98
4.12.4 Working With Containers..............................................................................98

4.13 Printing................................................................................................................106
4.13.1 Without RIP Software..................................................................................106
4.13.2 With Pjannto RIP software..........................................................................114

5 Reference Part.............................................................................................................115
5.1 The File Menu.......................................................................................................115

5.1.1 The New… Command..................................................................................115
5.1.2 The New from Template Command..............................................................115
5.1.3 The Last Version Command.........................................................................115
5.1.4 The Open… Command.................................................................................115
5.1.5 The Save Command ....................................................................................115
5.1.6 The Save as… Command.............................................................................116
5.1.7 The Save all Command................................................................................116
5.1.8 The Send by Email… Command..................................................................116
5.1.9 The Import… Command...............................................................................116
5.1.10 The Export… Command.............................................................................116
5.1.11 The Send to RIP… Command....................................................................116
5.1.12 The Print… Command................................................................................117
5.1.13 The Output… Command.............................................................................117
5.1.14 The Scan... Command................................................................................117

EuroCUT Basic 8 Manual

ii



Table of Contents

5 Reference Part
5.1.15 The Choose Scanner… Command.............................................................117
5.1.16 The Quit Command.....................................................................................117
5.1.17 The Job History...........................................................................................117

5.2 The Edit Menu.......................................................................................................118
5.2.1 The Undo Command.....................................................................................118
5.2.2 The Undo Stack… Command.......................................................................118
5.2.3 The Redo Command.....................................................................................118
5.2.4 The Redo Stack… Command.......................................................................118
5.2.5 The Cut Command........................................................................................118
5.2.6 The Copy Command.....................................................................................119
5.2.7 The Paste Command....................................................................................119
5.2.8 The Paste Special... Command....................................................................119
5.2.9 The Select All Command..............................................................................119
5.2.10 The Reverse Selection  Command.............................................................119
5.2.11 The Job Info… Command...........................................................................119
5.2.12 The Color Layer… Command.....................................................................119
5.2.13 The Prepare to Cut… Command................................................................120
5.2.14 The Multi Copy… Command.......................................................................120

5.3 The Design Menu..................................................................................................121
5.3.1 The Rotate Axis Command...........................................................................121
5.3.2 The Rotate Axis With Page Command.........................................................121
5.3.3 The Horizontal Mirror Command...................................................................121
5.3.4 The Vertical Mirror Command.......................................................................121
5.3.5 The Delete Command...................................................................................121
5.3.6 The Mirror on the X Axis Command..............................................................121
5.3.7 The Mirror on the Y Axis Command..............................................................121
5.3.8 The Duplicate Command..............................................................................121
5.3.9 The Clone Command....................................................................................122
5.3.10 The Group Command.................................................................................122
5.3.11 The Break Group Command.......................................................................122
5.3.12 The Combine Command.............................................................................122
5.3.13 The Break Combination Command.............................................................123
5.3.14 The Fill Function.........................................................................................123
5.3.15 The Contour Function.................................................................................123
5.3.16 The Draw Command...................................................................................124
5.3.17 The Align… Command................................................................................126
5.3.18 The Sort With Simulation… Command.......................................................127
5.3.19 The Sort Manually… Command..................................................................127
5.3.20 The Clockwise Command...........................................................................127
5.3.21 The Counterclockwise Command...............................................................127
5.3.22 The Close Contour Command....................................................................127
5.3.23 The Open Contour Command.....................................................................128
5.3.24 The Round Corners… Command...............................................................128
5.3.25 The Reduce Nodes Command...................................................................128
5.3.26 The Insert Bridge Command.......................................................................128
5.3.27 The Add to Clipart Group Command..........................................................128
5.3.28 The Change to Container… Command......................................................128
5.3.29 The Cancel Container State Command......................................................129

EuroCUT Basic 8 Manual

iii



Table of Contents

5 Reference Part
5.3.30 The Container Setup… Command..............................................................129
5.3.31 The Weeding Border Command.................................................................129
5.3.32 The Object Properties… Command............................................................129

5.4 The View Menu.....................................................................................................130
5.4.1 The Zoom In Command................................................................................130
5.4.2 The Zoom Out Command ............................................................................130
5.4.3 The Full Page Command..............................................................................130
5.4.4 The Show All Command...............................................................................130
5.4.5 The Show Selected Objects Command........................................................130
5.4.6 The To Front Command................................................................................130
5.4.7 The To Back Command................................................................................131
5.4.8 The Forward One Command........................................................................131
5.4.9 The Back One Command.............................................................................131
5.4.10 The Reverse Order Command....................................................................131
5.4.11 The Change Order Command....................................................................131
5.4.12 The Show Layout Command......................................................................131
5.4.13 The Contour View Command......................................................................131
5.4.14 The Enhanced View Command..................................................................132
5.4.15 The Always on top Command.....................................................................132
5.4.16 The Refresh Screen Command..................................................................132

5.5 The Tools Menu....................................................................................................133
5.5.1 The Vectorizing… Function...........................................................................133
5.5.2 The Revectorizing Function..........................................................................133
5.5.3 The Contour Line… Function........................................................................133
5.5.4 The PhotoCut… Function.............................................................................133
5.5.5 The Insert Program… Command..................................................................134
5.5.6 The Edit Program List… Command..............................................................134
5.5.7 The Set Jog Marks Command......................................................................134
5.5.8 The Search / Replace Video Marks Command.............................................134
5.5.9 The Measure Command...............................................................................134
5.5.10 The Box Nesting… Function.......................................................................135
5.5.11 The Outline… Function...............................................................................135
5.5.12 The Welding Command..............................................................................135

5.6 The Text Menu......................................................................................................136
5.6.1 The Add Text Command...............................................................................136
5.6.2 The Edit Text Command...............................................................................136
5.6.3 The Textbox… Command.............................................................................136
5.6.4 The Convert Text to Curves Command........................................................136
5.6.5 The Convert Text to Lines Command...........................................................136
5.6.6 The Fontmanager Command........................................................................136

5.7 The Settings Menu................................................................................................138
5.7.1 The Standard Settings Menu........................................................................138
5.7.2 The Color Palette Command........................................................................154
5.7.3 The Control Panel… Command....................................................................155
5.7.4 The Working Area… Command....................................................................155
5.7.5 The Rulers… Function..................................................................................156
5.7.6 The Unit of Measurement Function...............................................................157
5.7.7 The Grid… Function......................................................................................157

EuroCUT Basic 8 Manual

iv



Table of Contents

5 Reference Part
5.7.8 The Origin Function......................................................................................158
5.7.9 The Undo / Redo Command.........................................................................161
5.7.10 The Cross-Hair Command..........................................................................161
5.7.11 The Guidelines… Function.........................................................................161
5.7.12 The Snap Mode Function............................................................................162
5.7.13 The Lock Guidelines Command..................................................................162
5.7.14 The Guidelines Visible Command...............................................................162
5.7.15 The Choose Language… Command..........................................................163

5.8 The Window Menu................................................................................................164
5.8.1 The New Window Command........................................................................164
5.8.2 The Tile Horizontally Command....................................................................164
5.8.3 The Tile Vertically Command........................................................................164
5.8.4 The Cascade Command...............................................................................164
5.8.5 The Close Command....................................................................................164
5.8.6 The Close All Command...............................................................................164
5.8.7 The Standard Command...............................................................................164
5.8.8 The Sidebar Command.................................................................................164
5.8.9 The Setup Command....................................................................................165
5.8.10 The Common Tools Command...................................................................165
5.8.11 The Text Command....................................................................................165
5.8.12 The Object Tools Command.......................................................................165
5.8.13 The Object Parameters Command.............................................................165
5.8.14 The Status Bar Object Info Command........................................................165
5.8.15 The Status Bar Element Info Command.....................................................165
5.8.16 The Active Windows List.............................................................................165
5.8.17 The Further Windows… Command............................................................166

5.9 The Help Menu......................................................................................................167
5.9.1 The About … Command...............................................................................167
5.9.2 The Help… Command..................................................................................167
5.9.3 The Object Info… Command........................................................................167
5.9.4 The Install Autoimport Plug-Ins… Command................................................167
5.9.5 The Online Support Command.....................................................................167
5.9.6 The Remote Support… Command...............................................................168
5.9.7 The Live Update Command..........................................................................168

5.10 Context Menu Left Mouse Button........................................................................169
5.10.1 Context Menu Ruler....................................................................................169

5.11 Context Menus Right Mouse Button....................................................................171
5.11.1 Reference List of All Context Menu Commands.........................................171
5.11.2 Context Menu on Empty Working Area.......................................................174
5.11.3 Context Menu Text Block............................................................................175
5.11.4 Context Menus Node Editing......................................................................181

6 Reference Part Output Preview..................................................................................187
6.1 The Output Menu..................................................................................................187

6.1.1 The Output Command..................................................................................187
6.2 The Options Menu.................................................................................................187

6.2.1 The Save As… Command............................................................................187
6.2.2 The Rotate Axis Command...........................................................................187

EuroCUT Basic 8 Manual

v



Table of Contents

6 Reference Part Output Preview
6.2.3 The Horizontal Mirror Command...................................................................187
6.2.4 The Vertical Mirror Command.......................................................................187
6.2.5 The Optimization… Command......................................................................187
6.2.6 The Sort With Simulation… Command.........................................................188
6.2.7 The Recalculate Command..........................................................................188
6.2.8 The Initial View Command............................................................................188
6.2.9 The Horizontal Weeding Lines Command....................................................188
6.2.10 The Vertical Weeding Lines Command......................................................188
6.2.11 The Test Drive Command...........................................................................189

6.3 The View Menu.....................................................................................................189
6.3.1 The Material Width Command......................................................................189
6.3.2 The All Objects Command............................................................................189
6.3.3 The Selected Objects Command..................................................................189
6.3.4 The Total Area Command.............................................................................189

6.4 The Window Menu................................................................................................190
6.4.1 The New Window Command........................................................................190
6.4.2 The Tile Horizontally Command....................................................................190
6.4.3 The Tile Vertically Command........................................................................190
6.4.4 The Cascade Command...............................................................................190
6.4.5 The Close Command....................................................................................190
6.4.6 The Close All Command...............................................................................190
6.4.7 The Common Tools Command.....................................................................190
6.4.8 The Object Parameters Command...............................................................190
6.4.9 The Status Bar Object Info Command..........................................................190
6.4.10 The Status Bar Element Info Command.....................................................191
6.4.11 The Active Windows List.............................................................................191
6.4.12 The Further Windows… Command............................................................191

6.5 The Help Menu......................................................................................................191
6.5.1 The About … Command...............................................................................191
6.5.2 The Help… Command..................................................................................191
6.5.3 The Install Autoimport Plug-Ins… Command................................................191
6.5.4 The Online Support Command.....................................................................192
6.5.5 The Remote Support… Command...............................................................192
6.5.6 The Live Update Command..........................................................................192

6.6 Context Menu of The Right Mouse Button............................................................192
6.6.1 Context Menu Output Preview......................................................................192

7 Toolbars........................................................................................................................193
7.1 The Standard Toolbar...........................................................................................193
7.2 The Setup Toolbar.................................................................................................193
7.3 The Text Editor Toolbar.........................................................................................194
7.4 The Node Toolbar.................................................................................................196

7.4.1 Direct Input of Coordinates of Node Positions..............................................201
7.5 The Object Tools Toolbar......................................................................................203
7.6 The Object Parameter Toolbar..............................................................................204

7.6.1 The Multi Copy Command............................................................................204
7.7 The Status Line Object Info...................................................................................206
7.8 The Status Line Element Info................................................................................206

EuroCUT Basic 8 Manual

vi



Table of Contents

7 Toolbars
7.9 The Preview Tools Toolbar...................................................................................206
7.10 The Preview Object Parameters Toolbar............................................................208

8 Tools.............................................................................................................................209
8.1 The Desktop..........................................................................................................209

8.1.1 Cursor forms on the working area and their meaning...................................210
8.2 The Textbox Dialog...............................................................................................211

8.2.1 Edit Text........................................................................................................220
8.3 The Outline Function.............................................................................................225
8.4 The Undo Redo Stack...........................................................................................228
8.5 The Alignment Function........................................................................................230
8.6 The Sort with Simulation… Tool............................................................................231

8.6.1 Zone A1 - Object Position, Color Bar, …......................................................231
8.6.2 Zone A2 - The Simulator...............................................................................233
8.6.3 Zone A3........................................................................................................233
8.6.4 Zone A4 - Sorting, Settings, ….....................................................................235

8.7 The Pen Attributes Tool.........................................................................................238
8.8 The Welding Tool..................................................................................................242

8.8.1 Mask.............................................................................................................244
8.8.2 Seams...........................................................................................................245

8.9 The Color Bucket Tool...........................................................................................246
8.10 The Measure / Measurement Tool......................................................................253
8.11 The Stop Watch...................................................................................................254
8.12 The Tracing Tool (Vectorization).........................................................................255

8.12.1.....................................................................................................................255
8.12.2 Color assignment........................................................................................255
8.12.3 Parameters ................................................................................................256
8.12.4 Sliders.........................................................................................................257

8.13 The Contour (Line) Function...............................................................................259
8.14 The Job Info........................................................................................................262
8.15 The Plot Manager................................................................................................265

8.15.1 Creation And Modification of Device Configurations...................................265
8.15.2 Monitoring the Output Processes of the Jobs.............................................265
8.15.3 Output of Data to Local Ports......................................................................265
8.15.4 Administration of Hotfolders........................................................................265
8.15.5 Plot Server Function...................................................................................265
8.15.6 Devices Folder............................................................................................266
8.15.7 Settings of the Plot Manager.......................................................................270

8.16 The PhotoCUT Function......................................................................................274
8.16.1 The PhotoCUT Dialog.................................................................................274

9 The Sidebar..................................................................................................................281
9.1 Term Definition Sidebar.........................................................................................281
9.2 The Anchorage Control.........................................................................................281
9.3 The Layer Tab.......................................................................................................283

9.3.1 A) The Layer Area.........................................................................................283
9.3.2 B) The Layer Options....................................................................................283
9.3.3 C) The Palettes Options................................................................................284

EuroCUT Basic 8 Manual

vii



Table of Contents

9 The Sidebar
9.3.4 Status Indicator Layer...................................................................................286
9.3.5 I. Layer Settings Output Setup......................................................................288
9.3.6 II. Layer Settings Color Setup.......................................................................289
9.3.7 Hotkeys in the Layer Processing..................................................................291

9.4 The Cliparts Tab....................................................................................................292
9.4.1 Clipart Management......................................................................................292
9.4.2 The Context Menus.......................................................................................299

10 Add Ons......................................................................................................................301
10.1 The PhraseWriter................................................................................................301

10.1.1 How to build Text Modules?........................................................................301
10.1.2 The Icon In The Windows Info Bar..............................................................302
10.1.3 The Context Menu In The Info Bar..............................................................302
10.1.4 The Settings Window..................................................................................303
10.1.5 Reference Part PhraseWriter......................................................................306

10.2 Fontmanager.......................................................................................................309
10.2.1 What Can The Fontmanager?....................................................................309
10.2.2 Toolbars......................................................................................................310
10.2.3 Reference Section......................................................................................318
10.2.4 The Context Menus.....................................................................................338

11 Tips & Tricks - Trouble Shooting.............................................................................339
11.1 Code is not accepted with Windows 7, 8, 10 or 11 (No Dongle).........................339
11.2 Buffer Overflow Serial Port..................................................................................339
11.3 Output Size Mimaki.............................................................................................339
11.4 Output Size Graphtec..........................................................................................340
11.5 Calibration of the Output Size.............................................................................340
11.6 Computer without serial COM port......................................................................342
11.7 Tracing (Vectorization)........................................................................................343
11.8 Cutter Does Not Respond!..................................................................................343
11.9 Buffer Overflow....................................................................................................344
11.10 Fonts and Windows 10 / 11...............................................................................344
11.11 Script Font Welding...........................................................................................344
11.12 Generate Circle Segments................................................................................344
11.13 Data Import From Apple Computers.................................................................345
11.14 Typical Sources of Errors When Cutting...........................................................345
11.15 Plotter Via USB Is Not Working!........................................................................346
11.16 Summa Plotter Does Not Read Out!.................................................................347
11.17 The Values for Cutting Pressure And Speed Are Not Saved............................347
11.18 Error Message While Output into File...............................................................347

Annex...............................................................................................................................349
A Hotkey Overview......................................................................................................349
B The ANSI Character Table.......................................................................................351
C EuroCUT Basic 8 Fonts...........................................................................................352
D EuroCUT fonts.........................................................................................................355
E EuroCUT symbol fonts.............................................................................................372

E.1 Sign symbols (ECSignsymbole)......................................................................372

EuroCUT Basic 8 Manual

viii



Table of Contents

Annex
E.2 Sport symbols (ECSportsymbole)...................................................................375
E.3 Frame symbols (ECRahmensymbole).............................................................377

F Driver List.................................................................................................................378
G Dictionary of Technical Terms.................................................................................387
H Glossary...................................................................................................................396

Index................................................................................................................................401

EuroCUT Basic 8 Manual

ix



EuroCUT Basic 8 Manual

x



Software License Agreement

Below you will find set out the conditions of the agreement for the use of Euro-Systems
Software by you, the end-user (hereinafter also called the Licensee). This legal document
is a legally valid contract between you, the end-user, and Euro-Systems S.à
r.l. (hereinafter also called the Licensor). With the installation, the first use or by opening
the disk package, you are agreeing to become bound by the terms of this agreement.
Therefore, please read the following text carefully and in full. If you do not agree to the
terms of this agreement, do not use the software open the disk package, promptly return
the unopened disk package and the other items (including all written documentations, ring
binders, if applicable dongle / copy protection or any other boxes) of the purchased
product to the place where you purchased them.

SINGLE USER / MAIN LICENSE - SECOND USER LICENSE(S) - ADDITONAL LICENSE
- DEMO LICENSE - TEST LICENSE - SCHOOL LICENSE / MULTI USER - COMPANY
LICENSE - ENTERPRISE LICENSE - SUBSCRIPTION LICENCE

1. Scope of the License Agreement
The agreement applies to computer programs and files stored on data carriers, computer
programs and files made available online, by data transfer or by installation on the
computer of the Licensee, the program description and operating instructions and any
other related written material and hardware, hereinafter also called Software. The Licensor
is entitled to implement program-internal protection measures into the software in order to
secure his protective rights. This also applies to future updates / upgrades of the program
provided to the Licensee. The Licensor points out that the present level of technology does
not allow computer software to be produced in such a way that it works perfectly in all
applications and combinations. Thus, the agreement is only applicable to software which is
basically usable in accordance with the program description and the user operating
instructions.

2. Granting of License

Important Note: If the copy protection (Dongle) gets lost, the license also expires!

Single User / Main License
The Licensor grants you the right to use the copy of the Software on only one terminal
connected to a single computer. It is prohibited to network the software beyond the scope
of the software. You are not allowed to use the Software on more than one computer or
computer terminal in any way or at any time whatsoever unless the Licensee additionally
possesses so called Second-User Licenses or Additional Licenses.

Second User License
A Second-User License as well is only valid in combination with a Single-User or Main
License. It is protected in the same way as the Single User / Main License. The functions
of a Second-User License are the same as those of a Main License. A maximum of two
additional Second User Licenses may be acquired for each Single User / Main License. If
more than three licenses are required in a multi user environment, it is first of all necessary
to acquire a further Single User / Main License. This license can then be used to acquire
two more Second User Licenses. Beyond - extra licenses are to be agreed individually and
in writing with the Licensor.
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Additional License
An Additional License authorizes the Licensee to use the copy of the software provided by
the Licensor on an additional computer. It is copy-protected in the same way as the Single
User / Main License. The functional scope of an Additional License is identical to that of a
Main License.

Demo License
The Demo License authorizes the Licensee to test the software in its scope of functions
(functionally partly limited), in particular to check whether the user value expected by the
Licensee can be achieved with the software and / or compatibility with its current computer
system. It is expressly forbidden to use the Software for commercial purposes, to transmit
it to third parties or to copy it without explicit written consent of the Licensor.

Test License
The Test License authorizes the Licensee to test the software in its scope of functions
(limited in time), in particular to check whether the user value expected by the Licensee
can be achieved with the software and / or compatibility with its current computer system.
Redistribution or reproduction without the express written permission of the licensor is
prohibited. The trial period begins with the creation of the trial license. The licensor
reserves the right to deactivate the test license in case of misuse, with the consequence
that the software can no longer be used.

School License / Multi User License
A School License consists out of a Main License for one teacher workplace and a so
called Multi User license for student's workplaces. The Multi User license is a functionally
restricted version of the software. Usage is allowed on multiple workplaces / computers in
the offices of the Single User / Main Licensee.

Company License
The Company License authorizes the Licensee to use a copy of the software provided by
the Licensor on several computers and / or multiple output devices on a company site. The
number of licenses must be agreed individually and in writing with the Licensor. If a
company has several locations, the Company License must be purchased separately for
each location. The Licensee is not allowed to transfer the licenses of one location to
another. If a company has several locations, an Enterprise License must be obtained

Enterprise License
The Enterprise License authorizes the Licensee to use the copy of the software provided
by the Licensor on several computers and / or multiple output devices at multiple company
locations. The number of licenses must be agreed in writing with the Licensor.

Subscription License
Euro-Systems S.à r.l. authorizes RCS Systemsteuerungen GmbH to distribute subscription
licenses. Euro-Systems grants the licensee a time-limited, simple, non-transferable right to
use the software for the intended use against payment of the remuneration to RCS
Systemsteuerungen GmbH or an authorized seller. The licensee has the right to use the
provided copy of the software on a single terminal connected to a single computer. You
may not network the Software beyond the scope provided in the Software. You may not
use the Software in any other manner at any time on more than one computer or computer
terminal unless Licensee has so-called Additional Licenses.

Software License Agreement
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3. Copyright
The Software is the property of the Licensor and is protected against copying by laws on
copyright, international agreements and other national regulations. If the Software does
not have a device to protect it from being copied you may either make one copy as backup
or for your records or copy it to a hard disk as long as the original copy is to be stored
exclusively as backup or for your records. You are not permitted to delete the reference to
copyright in the Software or the registration or serial code or dongle numbers. It is
expressly forbidden to copy the Software and the written material such as manuals either
in full or in part or to reproduce them in any way.

4. Special Restrictions
As Licensee you are not permitted

* to transfer, assign, rent, lease or otherwise dispose of the Software or related material to
a third party without the prior written consent of the Licensor. But you are allowed to
permanently assign the rights from this License Agreement to another person, provided
that you transfer the License Agreement together with all copies of the Software and the
accompanying hardware and the recipient consents to be bound by the terms of the
agreement. The transfer must include the latest update and all earlier versions and the
Licensor must be notified in writing.

* to transfer subscription licenses to a third party

* to modify, translate, reverse engineer decompile or disassemble the Software without the
prior written consent of the Licensor.

* to create derivative works based on the Software or reproduce the written material.

* to translate or modify the written material or produce derivative material.

5. Ownership of Rights
With the purchase of the product you only possess the physical data carrier on which the
Software is recorded or fixed. A purchase of rights of the Software is not connected with
it. In particular, the Licensor reserves all rights to publish, copy, edit and exploit the
Software.

6. Duration of the Contract
This License is effective indefinitely. This license will terminate automatically without notice
from EUROSYSTEMS if you fail to comply with any provision of the License. Upon
termination you are obliged to destroy the original data carriers as well as all copies of the
Software, modified copies including the written materials. You must return the hardware
and dongle to the manufacturer.

In the case of subscription licenses, the term is limited to the period specified when the
contract is concluded. The subscription license is automatically extended if the contract is
not terminated by the licensee in due time.

7. Damages for Non-Compliance with the Agreement
The Licensor points out that you are liable for any damage resulting from breach of
copyright incurred by the Licensor on account of your non-compliance with the terms of
this agreement.

Software License Agreement
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8. Modifications and Updates
The Licensor may create updated versions of the Software at its own discretion. The
Licensor is not bound to make such updates available to Licensees who have not properly
registered the Software by registration card or online form or have not paid the update fee.

For subscription licenses, software updates are provided throughout the subscription
period - subject to payment of the subscription fee.

9. Limited Warranty and Disclaimer of Warranty
The Licensor assumes no liability for the Software being free of errors. In particular, the
Licensor does not warrant that the Software will meet the requirements and purposes of
the licensee or will work together with other programs selected by the acquirer. The
responsibility for the correct selection and the consequences of the use of the software as
well as the results intended or achieved with it is borne by the acquirer. The same applies
to the written material accompanying the software. If the software is not fundamentally
usable, the acquirer has the right to cancel the contract.

The Licensor is not liable for damage unless the damage was caused deliberately or
through gross negligence on the part of the Licensor. Any liability for gross negligence
towards dealers is excluded. Liability due to properties maybe warranted by the
Licensor remains unaffected. Liability for consequential harms caused by a defect that is
not included in the warranty is excluded.

10. Traders
If the Licensee is a trader, this agreement shall be subject to the law of Luxembourg and
the jurisdiction of national and federal courts located in Luxembourg.

11. Data Transmission
* 1: The Licensee authorizes the Licensor to store and process his customer data
communicated in connection with the business relationship.

* 2: The Licensee agrees to the transfer of software data to the Licensor for the protection
of legitimate interests, such as to ensure copy protection, license verification and the
provision of Live Update functionality.

* 3: The Licensee agrees that any data sent by the Software online to the Licensor for the
provision of online services (online support, driver download, license purchase, provision
of production macros, and the like) shall be stored and processed from the Licensor.

* 4: The Licensee agrees that data that serves the needs-based development of the
Software are transmitted to the Licensor and stored and processed by him.

* 5: The Licensee agrees that data will be sent to the Software to inform the Licensee
about updates / upgrades, product news and important support information.

LIMITED WARRANTY

* Limited Warranty - The Licensor guarantees that the Software functions largely in
accordance with the accompanying product manual for a period of 90 days from receipt.

Software License Agreement
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This guarantee is given by the Licensor in its capacity as producer; it does not replace or
restrict any possible legal claims regarding warranty or liability which may be made on the
distributor from whom you purchased your copy of the Software.

* Customer's Rights - The Licensor's entire liability and your sole right consists in a refund
of the price paid or the repair or replacement of the Software which is inadequate under
the terms of the Licensor's' limited warranty and which has been returned to the
Licensor together with a copy of the invoice. This limited warranty does not apply when the
non-functioning of the Software or hardware is due to an accident, improper use or
incorrect application.

* No Further Guarantee - The Licensor excludes any further warranty for the Software,
accompanying manuals and written materials or the accompanying hardware.

* No Liability for Consequential Damage - Neither the Licensor nor the distributors of the
Licensor are liable for any damages (unlimited included are damages for loss of business
profits, business interruption, loss of
business information or data or from other financial loss) arising out of the use or inability
to use such product even if the Licensor has been advised of the possibility of such
damage. The Licensor is not liable for damages, as far as the Licensee could have
prevented their occurrence by means of reasonable measures - in particular program and
data backup. In any case the Licensor's liability is confined to the amount actually paid for
the product. This disclaimer does not apply to damage caused deliberately or by gross
negligence on the part of the Licensor. Neither does it affect any rights based on legal
regulations concerning product liability.

* When outputting data to connected devices (locally connected to the computer or in a
network (LAN / WAN) the safety instructions of the machine manufacturer must be strictly
observed in any case.

If you have questions about this contract, please contact the Licensor: Euro-Systems S.à
r.l, Villa Machera, 1 Rue Kummert, L-6743 Grevenmacher, Luxembourg
© Euro-Systems 2022

Software License Agreement
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Important Information for EuroCUT Clients

Please check the merchandise after the reception upon completeness and announce
possible absence of single parts immediately to your trader.
EuroCUT is available in different versions: EuroCUT Professional, EuroCUT
Basic, EuroCUT Design (schools also)

The single versions differ in the complexity of functions.

The scope of delivery of a EuroCUT version includes:

- Program CD (apart from download version)
- Hardware copy protection - USB dongle (Professional only)
- Manual (as PDF file for download version)

Code number

The sticker is on the inner side of the manual cover. In case of online buy code number is
delivered via email.

Important Note: If the copy protection is lost, the license is terminated!

Please check (Professional only):

1. Beside your program CD it is most important to check the existence of the copy
protection (dongle) as this is at the same time your license.

2. The number on your copy protection must correspond to the 1. block of the serial
number (000123-EC8B-...).

Underneath the product description is your personal code number serial number
(e.g. 000123-EC8B-123973-00089754). This code will be inquired after the successful
installation of the software  - at the first start - as initialization. Another start of the program
is only possible after the verification of the code.

System requirements

Pentium 4 or newer with min. 1 GB RAM•   
Windows 7 / 8 / 10 / 11 (32 or 64 bit)•   
Minimum graphic resolution: 1024 x 768 pixels•   

Restriction of Warranty

We have given the greatest effort with the illustrations and while writing the texts.
Nevertheless, mistakes for this manual and the corresponding programs can not be
entirely excluded. No guarantee is taken for the correctness of the content of this manual,
its translation, its completeness and exactness.
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We expel the liability for all losses which appear by the use of the EuroCUT or its
documentation. The content of this manual can be changed without announcement and is
not to be considered as an obligation of EUROSYSTEMS S.à r.l.

The authors cannot take over any responsibility or liability for incorrect information and
their consequences.

Trademark

Possibly found trademarks are used without their usability can be guaranteed.

The following programs were applied among other things: CorelDRAW, Postscript,
Microsoft, Windows, Illustrator, InDesign, Freehand and AutoCAD. These trademarks are
owned by the respective producer.

Support And Sales Information

Dear user,

in order to guarantee the direct communication with your competent contact person in
case of problems and questions and in order to avoid or shorten waiting times on the
phone we offer the service of the technical hotline.

This service is available from:

Monday - Friday from 9:00 a.m. until 12:00 noon MET

Phone: ++49 6502-9288-11

Further helpful information as well as tips and tricks are on our website:

www.eurosystems.lu

under the category Support / FAQ

Our support staff members only give information to registered users. Therefore, please
give following information upon each call:

- Version-No.: e.g.  EuroCUT Professional 8.005
- Dongle or serial number of respective product

Thank you for your understanding that inqueries by phone can only be handled by using
this phone number. Other direct dialling numbers that may be known to you are reserved
for purchase and sales department.

In order to guarantee a smooth and competent support for yourself and others, we kindly
ask you to get registered. Immediately after the reception of your registration card, your
registration per fax or online, you will be added to our user-database.

Restriction of Warranty
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RCS Systemsteuerungen GmbH
Generaldistributor für EUROSYSTEMS-Produkte.

PS.: For written inquiries or the fast registration per fax or online, please use the following
number or address:

Fax:  ++49 6502-9288-15

Web Site: www.eurosystems.lu

Imprint

Comment to the production:

This manual was created with our own document system. Modifications and errors
reserved.

Used font family: Arial

English version:
Heidi Hansen, Peter Bettendorf
RCS Systemsteuerungen GmbH

Date: 10/11/22

Support And Sales Information
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Imprint
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Second User License

Requirement for its use is a registered main license.

With the EuroCUT second user license you purchase an adequate further program
package with dongle that can be used specially separated from your main system. The
second user license is especially suitable for branches or for the mobile application. Order
congestions or plant extensions can thus be handled flexibly. The installation of the
second user license is identical with the installation of the main version. All second-user
licenses get the same dongle number as the main license.

For EUROSYSTEMS software products, which are protected via hardware copy
protection (dongle), with each second user license another dongle is provided. For
EUROSYSTEMS software products, which are protected via software copy protection
(code number), with each second user license another full license code is provided.
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Second User License
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Copyright

Copyright © 2022 by Euro-Systems S.à.r.l. - All rights reserved.

Any duplication of this manual as well as the computer software EuroCUT for Windows will
be prosecuted.

The rights for the documentation to EuroCUT lie with
Euro-Systems S.à r.l., Villa Machera, 1 Rue Kummert, L-6743 Grevenmacher,
Luxembourg

Typeset and composition: Peter Bettendorf
Text: Peter Bettendorf, Frank Thömmes

The legitimate acquisition via data carrier or download allows the use of the program,
analogously to the use of a book. According to the impossibility that a book is read at the
same time in different places by several persons the software program EuroCUT may not
be used at the same time from different persons in different places and on different
devices. Copies may be created only for the purpose of data backup.

EuroCUT uses the OpenCV

(Open Source Computer Vision Library)

IMPORTANT: READ BEFORE DOWNLOADING, COPYING, INSTALLING OR USING.

By downloading, copying, installing or using the software you agree to this license. If you
do not agree to this license, do not download, install, copy or use the software.

Intel License Agreement

For Open Source Computer Vision Library

Copyright (C) 2000, 2001, Intel Corporation, all rights reserved.

Third party copyrights are property of their respective owners.  Redistribution and use in
source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

* The name of Intel Corporation may not be used to endorse or promote products derived
from this software without specific prior written permission.
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This software is provided by the copyright holders and contributors 'as is' and any express
or implied warranties, including, but not limited to, the implied warranties of merchantability
and fitness for a particular purpose are disclaimed.

In no event shall the Intel Corporation or contributors be liable for any direct, indirect,
incidental, special, exemplary, or consequential damages (including, but not limited to,
procurement of substitute goods or services; loss of use, data, or profits; or business
interruption) however caused and on any theory of liability, whether in contract, strict
liability, or tort (including negligence or otherwise) arising in any way out of the use of this
software, even if advised of the possibility of such damage.

EuroCUT uses NLog

NLog is a free logging platform for .NET, Silverlight and Windows Phone with rich log
routing and management capabilities. It makes it easy to produce and manage high-quality
logs for your application regardless of its size or complexity.

Copyright (c) 2004-2011 Jaroslaw Kowalski

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

* Neither the name of Jaroslaw Kowalski nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

EuroCUT uses the OpenCV
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About This Manual

With this manual you receive EuroCUT. This manual is divided in 8 chapters.

In chapter „Quickstart and Installation“ the installation of EuroCUT on your Windows
computer will be explained. Please follow the installation instruction carefully as the correct
installation is the basic for the smooth usage of EuroCUT.

The chapter „How to work with EuroCUT?“ is an introduction in handling, tools and
functions. The functional principle will be concretized by means of practical examples.

In chapter „Reference Part“ all menus and their menu items in their chronological order
are explained. This chapter is thought of as reference book and should be used in case of
doubts about the exact functioning of a command.

In chapter „Reference Part Output Preview” all menus and their menu items in the
display preview in their chronological order are explained. As chapter "Reference Part" it is
thought of as reference book and should be used in case of doubts about the exact
functioning of a command.

In the next chapter all „Toolbars” are described. Toolbars contain important tools that are
placed in a freely movable toolbar. 

In the following chapter the functioning of the „Tools” is described in detail.

In the chapter „The Sidebar” the side toolbar with tabs (similar to the so-called dockers in
CorelDRAW) is described in detail in its functioning. Summarized are layer editing, cliparts,
object manager and file management. The selection of the various functional areas is
implemented via so-called tabs.

In chapter „Add Ons” additional program modules are described in detail. Add Ons are
program components that are separated from the main program. Usually they are provided
by user defined installation.

In chapter „Tips and Tricks - Trouble Shooting“ we have explained a selection of daily
problems from our hotline and support experience and give you information for dealing
with technical problems.
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Typographical Orientation Guides

Display Meaning

Bold Headlines

Italic Indications, accentuations

Bold, italic Menus, fields, options e.g. new-command

CAPITAL
LETTERS

Name of keys on the keyboard e.g. INS, SRTG, …

KEY1+KEY2 The plus (+) between the key names means that the first key must be
kept pressed while pressing the second key. Afterwards, let go the two
keys.

KEY1,KEY2 A comma (,) between the key names means that you press the keys one
after the other and let them go.
Shortcuts and hotkeys

… Three dots after menu entries and commands always mean that, when
activating, a dialog window will be opened.

Typographical Orientation Guides
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1 Preface

Welcome to EuroCUT, the innovative signmaking software that will help you design all
types of signs and sign related products and cut them out of a variety of materials.

Whether you are new to sign-making or consider yourself an expert, EuroCUT gives you
all the tools you need for professional results.

You will soon realize just how powerful EuroCUT is, whether your application is display or
vehicle graphics, signmaking or exhibit building.

You may be involved in screen printing or signage - EuroCUT is equally capable of
handling any of these tasks. And there are many more applications: e.g. 

Stone masons – sandblasting applications
Department
stores

– window displays

Film, photo
and TV studios

– sceneries, decorations,
directional
signage

Builders,
architects

– construction and
architectural
signage

Major
corporations

– interior and exterior
signage,
exhibit displays

Wood-working – pos. and neg.
sandblasting

Before you begin working with EuroCUT, you should be familiar with the basics of
operating your PC and Microsoft Windows.
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1 Preface
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2 Abilities of EuroCUT - Feature List

Compare Products
Design Tools

Draw

Duplicate

Square

Circle

Line

Digitizing Mode

Freehand

Geometric Shape

Drill Hole

Register Mark

Universal Object

Block Shadow

Envelope

Perspective

Bitmap Functions

Bas-Relief

Brightness

Contrast

Convert to Bitmap

Crossfade

Cut Region

Gamma Correction

Gray Scales

Invert

Posterize

Properties

Reduce Colors

Rotate in 0.1° Steps

Saturation

Sharpness

PhotoCUT

Convert Halftone Templates

Different Reliefs

Result Invertible

Stripe Direction Selectable

Stripe Distance Adjustable

Stripe Form Selectable

Stripe Width Adjustable

Variable Clip Width

Weeding Frame

Welding

Automatic

By Color

Fill

Full Surface

Manually

19



Compare Products
Open Trimming

Screen Printing

Trimming

Sidebar

Clipart Manager

CLA Import

Clipart Group Management

Clipart Management

Display in List

Display in Mosaic

Drag & Drop Support

File Info Window

Search in File Names

Thumbnail Preview

Variable Display

File Manager

Background Update

*.CDR and *.CMX Import 1)
*.CDR and *.CMX Preview 1)
Display in List

Display in Mosaic

Drag & Drop Support

File Info Window

Folder Monitoring

Import File Option

Open Job Option

Search in File Names

Search Paths Definable

Status Surveillance

Thumbnail Preview

Variable Display

Layer Manager

Individual Color Palettes

Info Window

Layer Number

Material Display

Models CMYK / RGB / HSB

Select Layer Objects

Spot Colors Definable

Tool Assignment

Tool Parameterization

Unblocked / Blocked

Visible / Invisible

Macros Tab

Step By Step

Object Manager

Attributes Tab

Color Bar

Navigator

2 Abilities of EuroCUT - Feature List
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Compare Products
Object List

Object Names

Object Names Tab

Object Preview

Object Selection with Preview

Object Tree

Object Types Tab

Show Object Attributes

Tree Buttons

Zoom Buttons

Zoom Slider

Miscellaneous

Align

Axis Change

Bitmap Fill

Outline Pen

Contour mode

Crosshair

Dimensioning

Fill

Gradient Fill

Guide Lines (also transversely)

Magnifier

Measure (Distance, Angle)

Metric

Mirror Horizontal

Mirror Vertical

Raster

Rotate in 0.1° Steps

Rulers

Snap Mode

Stopwatch

Node Editing

Align Horizontally

Align Vertically

Break Nodes

Bridges

Curve to Line

Cusp Node

Delete Nodes

Direct Input of Coordinates

Insert Nodes

Join Nodes

Line to Curve

New Origin

Orthogonalize

Reduce Nodes

Rounding

Smooth Curve

2 Abilities of EuroCUT - Feature List
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Compare Products
Symmetric Nodes

Outline / Inline

Productivity Tools

CMX Transfer (Drag & Drop)

Best Import of TTF Contours

Export from CorelDRAW as CMX

Job Filter in CorelDRAW

Takes Color and Gradients

Print

Color Separation

Define Print Ratio

Print on Roll

Print to File

Tile Preview

Tile Selection

Tiles with Overlapping

Export Filter

PDF

Access Rights Management

Document Encryption

Twin Password Protection

CMX

DXF

EMF

EPS with OPI

HPGL

JOB (EuroCUT 4, 5, 6)

JPG, TIF, BMP, PCX, PNG

SOR

Routing & Engraving

Hatch Fill

Island Fill

Start Tool Path (Lead In / Out)

Routing Path Preview

Path Adjustment Inline

Path Adjustment Outline

Import Filter

GIF, JPG, TIF, BMP, PCX, PNG

AI

CCJ (CoCut Job)

CMX, CDR, CDT 2)
DXF

EMF, WMF

EPS

GTP

IK (URW Signus)

PDF

PLT (HPGL)

SVG 3)

2 Abilities of EuroCUT - Feature List
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Compare Products
Job Info

Creation Date

Customer Address

Kind of Material / Color Number

Length / Height / Number / Price

Memo Field

Optional Fields Definable

Password Protection

Printable Job-Info

Processor / Processing Time

Job Calculation

Font Height+Material Mode

Font Type+Material Mode

Object Mode

Signboard Area

Special Character Option

Optimization

Foil

Mark

Plate

Segment

Smartfeed

Automation / Macros

Clone

Close Objects Automatically

Contour Line (Print & Cut)

Object Orientation changeable

Positioning 1/100 mm exact

Reference Job (*.JRF)

Serial Numbers

Video Marks (Print & Cut)

Sort Manual

Sort with Simulation

Templates (*.JTP)

Text Editor

Fonts

102 EC Fonts (Type 1)

Font Sign Symbols

Font Sport Symbols

Font Frame Parts

Font Barcode (EAN)

Alignment

Autom. Run Length Adjustment

Caps Height

Change Kerning Values (Type 1)

Character Spacing

Character Table

Container Function

Create Kerning Table (Type 1)

2 Abilities of EuroCUT - Feature List
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Compare Products
Font Size

Font Type

Font Weight

Line Spacing

No Linefeed - Fit All Line Heights

No Linefeed - Reduce Line Height

Spaces (1/1, 1/2, 1/4, 1/8)

Subscript

Superscript

Tabulators

Text Export (*.TXT, *.RTF, *.ECT)

Text Import (*.TXT, *.RTF, *.ECT)

Text on Circle

URW BE Fonts

Word Spacing

Trace Tool

Automatic Node Minimization

Color Matching

Contour Filter

Result Preview with Zoom

Revectorize

Text Object Optimization

Auto Import Plug-Ins

Adobe Illustrator

Adobe InDesign

AutoCAD

CorelDesigner

CorelDRAW

Cut Mark Workflow Toolbar

Inkscape

Basic Features

Autosave - adjustable in minutes

Backup File

Combine Objects

Context Sensitive Menus

Crosslines Cursor

Cut Marks

Grid with Offset

Group Objects

Key Assignment similar to Corel

Layer

Metrics mm, cm, inch

Online Help

Origin Moveable

Page Margins

Raster with Positioning Help

Remote Maintenance

Ruler

Send via email

2 Abilities of EuroCUT - Feature List
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Compare Products
Size of Working Area scalable

Undo / Redo

Add-Ons

Fontmanager

Activate / Deactivate Fonts

Add / Duplicate Fonts

Font Preview

Font Search by Name / Style

Fonts in Databases

Import Font Databases

Search Font Databases

TT, OpenType, Type 1, BE Fonts

Window for each Font Type

PhraseWriter

Create / Edit Text Block

Group Text Blocks

Insert Text Block

Selection of Variables

Drivers

Mini Cutters

Roll Cutters

Flatbed Cutters

Multifunctional Cutters

Laser Engraver

Engraver

Device Control

Plot-Manager

Active and Passive Jobs

Hotfolder Support

Job History

Job Preview

Job Repetition

Multi Device Configuration

Multi Interface Support

Parallel Device Output

Plot Server Function (TCP/IP)

Pre-Output Message Window

Queue Function

Spool Function

Surveil Output Process

Track Logging

Any Number of Copies

Any Number of Outputs

Auto Outline Pen Metamorphosis

Bypass Cutting

Calibrate Output Size

Color Separated Cutting

Cut Object Preselection

Display Material Consumption

2 Abilities of EuroCUT - Feature List
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Compare Products
Driver Editor

Global Weeding Frame

Multiple Cutting

Optimization of Vinyl Usage

Output Preview

Output to File

Pile

Segmentation with Overlapping

Tryout Drive

Wait after Segment

Weed-Ex Driver Option

Weeding Frame for Single Object

Weeding Lines horiz. / vert.

Program Type

Standalone

Multi User Licenses available

Dongle Protection

Code Number Protection

1) CDR only if CorelDRAW is installed

2) CDR / CDT only if CorelDRAW is installed

3) SVG only if Inkscape is installed (non-portable version)

2 Abilities of EuroCUT - Feature List
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3 Quickstart and Installation

3.1 Quickstart

3.1.1 How to Install EuroCUT?

3.1.1.1 Step 1: Connection

Cutter control via USB

Install cutter USB drivers, which were delivered by the cutter manufacturer. Please use the
instructions given by cutter manual.

Cutter control via COM port (serial)

Make sure, that cutter and serial Windows port are configured identically.

You´ll find this port configuration in the system Control Panel under:
System/Hardware/Device Manager/Ports/Communications Port. Select via double click the
respective port (e. g. COM1) and activate Port Settings.

Default settings are: Bits per second: 9600 or 19200, Data bits: 8, Parity: None, Stop bits:
1, Flow control: Hardware

Check also Resources: COM 1: I/O Range 03F8 and IRQ 4 and COM 2:
I/O Range 02F8 and IRQ 3 respectively

3.1.1.2 Step 2: Installation

Insert the EuroCUT installation CD. With the Autorun function switched on following
dialog opens. If the Autorun function is deactivated open the Windows Explorer and start
the file install.exe in the main directory of the CD. Select product EuroCUT Basic 8 and
start installation.
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Fig. 3.1-1: Autorun window

Note: Installation process is done again for each selected application.

Fig. 3.1-2: EUROSYSTEMS Software License Agreement

In this dialog the installation folder for EuroCUT Basic 8 is chosen. By default the folder
C:\Program Files\EUROSYSTEMS\EuroCUT Basic 8 is suggested.

3.1.1 How to Install EuroCUT?
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If EuroCUT should be installed to another folder, please click Browse button and select
the desired destination folder.

Fig. 3.1-3: Selection of destination folder

Hint: To install additional drivers select custom setup.

3.1.1 How to Install EuroCUT?
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Fig. 3.1-4: Selection of setup type

Default program folder in the start menu is EUROSYSTEMS\EuroCUT Basic 8.

3.1.1 How to Install EuroCUT?
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Fig. 3.1-5: Position in start menu

3.1.2 Enter License Data (without Dongle)

3.1.2.1 Use .ecfn file: Recommended, if license data was sent via
email.

In the eMail with license data you´ll find an attached file with the extension .ecfn.

A double click on this file will license your software automatically!

3.1.2.2 Manually, if license data is printed on a sticker, which is
located in the package (inner left hand side).

On this sticker you´ll find information about program version, serial number, user data and
the code itself.

Important! All license data must be entered exactly how printed!

3.1.2 Enter License Data (without Dongle)
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Fig. 3.1-6: Start window with invalid code

By clicking "License..." button following dialog is opened.

Fig. 3.1-7: Option for first installation of EuroCUT Basic 8

3.1.2 Enter License Data (without Dongle)
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Fig. 3.1-8: These fields have to be filled with license data

3.1.3 Enter License Data (with Dongle)

If copy protection is realized using a dongle (frequently in case of upgrades),
don´t forget to connect the dongle with a port on your PC.

3.1.3.1 Manually, if license data is printed on a sticker, which is
located in the package (inner left hand side).

On this sticker you´ll find information about program version, serial number and the code
itself.

Important! All license data must be entered exactly how printed!

3.1.3 Enter License Data (with Dongle)
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3.2 The Cut Marks Toolbar

All object functions of the Cut Marks Toolbar act directly on the host program's
(CorelDRAW or Illustrator) objects. This extends host program's functionality with these
tools so that the whole Print & Cut workflow can be prepared and given out with
CorelDRAW or Illustrator. Of course, EuroCUT Basic 8 can be started without a host
program. The described tools are also available in the standalone version.

Important note: The functionality described here is only possible with CorelDRAW
X3-X8 & 2017-2022 and Illustrator CS3-CS6 & CC!

3.2.1 The Cut Marks Workflow

The following graphic illustrates the Print & Cut workflow (Cut Marks Workflow) inside the
host program (CorelDRAW or Illustrator).

Starting point of the Cut Marks Workflow is a bitmap, which gets contoured as first step. In
the second step multiple copies are generated. In the next step suitable register marks are
placed around the copies.
This Job must be printed on a suitable printer and is finished with a cutting plotter (cutter)
equipped with an optical sensor. The so called registration - Cut Marks recognition -
corrects the prints deviations and the job is cutted. The results of this process are exactly
cutted copies in any number and size.

3.2.2 The Cut Marks Toolbar in CorelDRAW X3-X8 and 2017-2022

Fig. 3.2-1: Toolbar in CorelDRAW X3-X8 and 2017-2022

The buttons were so arranged from left to right that the Cut Marks Workflow can be
performed perfectly.

3.2 The Cut Marks Toolbar
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3.2.3 The File Menu Entries in Illustrator CS3-CS6 and CC

Fig. 3.2-2: Illustrator sub menu EuroCUT Basic 8

The menu entries are arranged from top to bottom in a way that the Cut Marks Workflow
can be performed perfectly.

3.2.3.1 Buttons of the Cut Marks Toolbar

Important note: The following descriptions are valid also for Illustrator!

1 The Create Contour Button

Fig. 3.2-3: Create Contour Icon

please refer to 8.13: The Contour (Line) Function

2 The Multi Copy Button

Fig. 3.2-4: Multi Copy Icon

please refer to 7.6: The Object Parameter Toolbar

3 The Set Jog Marks Button

Fig. 3.2-5: Set Jog Marks Icon

please refer to 4.10.2: Jog Marks for Optical Recognition Systems

3.2.3 The File Menu Entries in Illustrator CS3-CS6 and CC
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4 The Cut Button

Fig. 3.2-6: Cut Icon

please refer to 4.11: Cutting - Milling - Creasing - Drawing …

5 The Direct Cutting Button

Fig. 3.2-7: Direct cutting Icon

Activating this button ensures that no window appears before the data output. The output
data is sent directly to the connected device.

6 The Export Button

Fig. 3.2-8: Export Icon

Activating this button ensures that the selected data is exported into the specified folder
(see Settings dialog).

Note: In CorelDRAW, the data are saved in the CMX file format, otherwise in PDF
format.

7 The Create Outline Button

Fig. 3.2-9: Create Outline Icon

please refer to 8.3: The Outline Function

8 The Create Outline Layer Button

Fig. 3.2-10: Create Outline Layer Icon

After activating this button the object attribute is changed and a spot color for the selected
contour, which was not generated with the EuroCUT Basic 8 button, is assigned.

3.2.3 The File Menu Entries in Illustrator CS3-CS6 and CC
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9 The Welding Button

Fig. 3.2-11: Welding Icon

Activating this button welds the selected objects.

please refer to 8.8: The Welding Tool

10 The Settings Button

Fig. 3.2-12: Settings Icon

A click on the Settings Button opens the Settings window.

3.2.3.2 The Settings Dialog

Eurosystems Software Field

Fig. 3.2-13: 2 Point Icon

A click on the 2 point button enables the selected program and allows changing of Settings
parameters.

3.2.3 The File Menu Entries in Illustrator CS3-CS6 and CC
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Jog Marks Field

Fig. 3.2-14: 2 Point Icon

A click on the 2 point button opens the Setup - Jog Marks dialog. It allows the selection of
the appropriate cut marks for the plotter, in case your cutter has an optical sensor and its
driver supports this feature.

please refer to 4.10: Label Production with Cutters with Optical Sensor

Export Field

Fig. 3.2-15: 2 Point Icon

A click on the 2-point button opens the Search folder dialog. It allows the selection of the
export folder where the exported file should be saved.

Name of Layer for Jog Marks Option

This option enables the assignment of an individual layer name. Then this jog marks layer
can be identified at any time and the jog marks can be selected. Preset is Regmark.

Name of Layer for Outline Option

This option enables the assignment of an individual layer name. Then this outline layer
can be identified at any time and the outline(s) can be selected. Preset is Outline.

3.2.3 The File Menu Entries in Illustrator CS3-CS6 and CC
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The Output Parameters… Button

Activating the Output Parameters button opens the cutting dialog and allows you to set
individual settings when cutting.

Show Always Contour and Outline Settings Option

If this option is enabled then the dialogs which allow the parameter definition are always
displayed, when the appropriate button was activated.

During the Cut Process only Transfer 'Regmark' and 'Outline' layer Option

If this option is activated then only the objects are transferred to EuroCUT Basic 8 to
which this two layers have been assigned: regardless of the current selection!

Create New File While Cutting Option

If this option is enabled then after pressing the Cut button a new window in EuroCUT
Basic 8 is opened and all or all selected objects are copied into the new window.

Open Output Dialog While Cutting Option

If this option is activated then after pressing the Cut button the Output dialog is opened.

3.3 Autoexport - Scripts

Autoexport means that data from external programs (CorelDRAW, CorelDesigner,
Illustrator, Freehand, Inkscape, InDesign or AutoCAD) are imported automatically into
EuroCUT - quasi at the push of a button. To do this the scripts are either integrated into
the external program's menu structure or toolbar.

3.3.1 Corun Installer

With the Corun Installer you can install EuroCUT the plugins. In the Name column all host
programs are listed, in which the plug-ins can be implemented. In the Plugin path column
is displayed in which the folder the plug-in files are located after installation. In the
Eurosystem software list all programs are listed that have a plug-in functionality. Select the
appropriate program from the list. Activating the Install button starts the process.

Note: The Corun Installer is required if the host application was installed BEFORE
the EUROSYSTEMS program or if plugins must be re-installed.

3.3 Autoexport - Scripts
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Fig. 3.3-1: Corun Installer dialog window with detected host programs and path indicators.

3.3.2 Insert EuroCUT Icon in CorelDRAW Toolbar

3.3.2.1 CorelDRAW X3-X8 and 2017-2022

Indication: CorelDRAW must be installed with the option “Visual Basic for
Application”.

This option can be installed as follows:

3.3.1 Corun Installer
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Insert CorelDRAW medium into the drive / start setup / select type of installation „Custom
setup”. If already a CorelDRAW-version is installed on your computer, first select „user
defined setup” and then „Custom setup”.

In the dialog that opens now, double click on main applications or one click on the
Plus-field. Here, double click on productivity support and activate the option „Visual
Basic for Application”. After the installation of EuroCUT you have to link the EuroCUT
Script with the toolbar.

Select the menu Tools / Customization•   
Select the option Workspace / Customization / Commands  in the left option
bar

•   

Right next to the option bar, click once on File and select Macros and drag
Corun... or Cocut... to the toolbar of CorelDRAW.

•   

Activate the tab Appearance. Here, press the Import-button and select any
symbol.

•   

Select the option Workspace/Customization/Command Bars  in the left option
bar .

•   

Change the name of the toolbar „New ToolBar 1” to EuroCUT.•   
Click on OK.•   

If you now mark one or several objects and click on the thus created icon, the objects are
passed on to EuroCUT and can be plotted.

3.3.3 EuroCUT Script in Inkscape

The EuroCUT - script for Inkscape is located in the Extensions menu. The output routine
is activated using the cutting menu entry in the EuroCUT Basic 8 sub menu.

Important note: The plugin only works with the non-portable version of Inkscape.

3.3.4 EuroCUT Script in Adobe Illustrator 8-10, CS-CS6, CC

EuroCUT is in the file menu underneath the menu item export.

How does the transfer of data from Illustrator 8, 9, 10, CS, CS2, CS3, CS4, CS5, CS6,
CC to EuroCUT take place?

Start EuroCUT from the file  menu. If the objects are marked, only the marked objects are
passed on to EuroCUT. If also texts are passed on they will automatically be converted to
curves.

Indication: If no objects are marked, EuroCUT is not active!

Indication: Special process color fills are not passed on.

3.3.2 Insert EuroCUT Icon in CorelDRAW Toolbar
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3.3.5 EuroCUT Script in Adobe InDesign CS4-CS6, CC

The EuroCUT script is in the Plug-ins menu, under the following sub-menu:
EUROSYSTEMS, Auto Export. From the function list, select the appropriate function with
a click.

3.3.6 EuroCUT Script in AutoCAD

3.3.6.1 Menu File for AutoCAD 2000(i), 2002-2023, 2002LT-2023LT

In the menu Extras select the menu item adjust menus.
(Indication: Alternatively you can also open the dialog via the command 
_menuload)

•   

In the dialog that now opens select the tab menu groups and press the browse
button.

•   

The file selection dialog opens. Change the file ending to *.mnu in this dialog.•   
Select the file corun.mnu  and close the dialog.•   
Now press the Load button and confirm the inquiry dialog with ok.•   
The EuroCUT menu is now loaded.•   
Now change the menu bar dialog in the upper tab. In the menu group select
EuroCUT Plot and insert it into the desired place in the AutoCAD menu.

•   

3.3.6.2 Menu File for AutoCAD LT 98 And R14

In the menu Extras select the menu item Adjust/Menus.•   
In the dialog that now opens press the browse button.•   
The file selection dialog opens. Change the file ending to *.mnu in this dialog.•   
Select the file corun.mnu  and close the dialog.•   
Now press the Load button and confirm the inquiry dialog with ok.•   
The EuroCUT-menu is now loaded.•   
Now change to the menu bar dialog in the upper tab. In the menu group select
EuroCUT Plot and insert it into the desired place in the AutoCAD menu.

•   

In the menu file  select the menu item printer installation.•   
In the dialog that now opens press the open  button and select the file
cocutlt98.pc2 (LT98) respectively cocutr14pc2 (R14).

•   

Close the dialog.•   
Start now the print-job by activating the menu item print  in the file menu in
order to do following settings: activate the button Plot in file, set the scale
factor to 1:1 and the unit to mm.

•   

In the menu is now EuroCUT entry and in the toolbars EuroCUT toolbar was added.

Important: Be careful that at the first output the checkbox "plot to file" is activated.
With this procedure, all graph elements are passed on. The change-pen commands
are interpreted from the PLT file so that the 8 layers are separable. AutoCAD does
not plot with Arcs, which means that all elements are resolved in lines and dots are
interpreted as bores.

3.3.5 EuroCUT Script in Adobe InDesign CS4-CS6, CC
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Indication: If DXF is used, you have to press twice the ENTER button after the
selection of the object as the execution of the macro menu is aborted by the object
selection. At the passing on via DXF the dimensions and texts are not passed on
but it is possible to select and output them. The curves are not converted to lines
but the Splines or Arcs in the DXF file are converted to Bezier curves. The layer
amount is not limited to 8.

In the startup group of Windows a link to the program autoimp.exe is installed during the
installation with which the passing on of files to EuroCUT is realized. If autoimp.exe is
started an icon is shown in the system tray (lower right corner of the screen). Double
clicking on the icon ends the program.

Attention: If the icon is switched off the transfer to EuroCUT does not work anymore!

Via Start / All Programs / Startup / Auto Import for EuroCUT it can be started again.

Indication: During the installation you have to pay attention that EuroCUT is always
installed for the last used AutoCAD version if several AutoCAD versions are
installed on your computer.

3.4 Selection of The Device Driver

Please, select first your output device from the list driver. In the field name of device  the
identical name for the selected device that is shown in the cutting dialog appears. This
name can be changed individually in this field. After the selection of the driver please
select - in the area type of connection - the device type with which the device is
connected to the computer.

Tip: If the driver you search for is not in the list you can try another driver from the
same manufacturer.

3.3.6 EuroCUT Script in AutoCAD
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Fig. 3.4-1: Dialog for the selection of the device driver

Detailed information for the setting of the local interface is here: please refer to 4.11:
Cutting - Milling - Creasing - Drawing …

3.4 Selection of The Device Driver
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4 How to work with EuroCUT

4.1 Desktop and Working Sheet

4.1.1 I. Desktop

The so-called Desktop means the whole visible program window including Toolbars,
Working Sheet and Desktop background.

Note: On the background can be placed any desired number of objects. The size of
the background is limited only by the resources of your computer. Thus the layout
can be done basically in 1:1 scale.

Fig. 4.1-1: Desktop with working sheet (here: gray), Background (here: white), Toolbars,
Sidebar, Rulers, Statusbar

4.1.2 II. Working Area

The workspace is a subset of the EuroCUT desktop. The workspace is usually in the
format that will later be output on a machine. In addition to the known DIN formats, any
formats can be applied, e.g. for different table sizes.
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Note: The working area is used primarily for guidance. The format of the working
area has no influence on the output on a connected device. The output preview
window displays what is given out.

please refer to 4.11: Cutting - Milling - Creasing - Drawing …

Fig. 4.1-2: The Working Area Dialog

4.1.2.1 The Buttons

The New Button

The New button creates a new format. The values for width and height of the selected line
are transferred to the new row.

The Delete Button

The Delete button removes the marked row.

The Change Button

This button saves all changed parameters and options.

The Default* Button

This button marks the name with a * (star). The star-marked format is used every time
EuroCUT is started.

4.1.2 II. Working Area
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The Read from connected device Button

By means of this button - if the read-out command of the driver is processed by the
machine controller - the width value can be read from the connected device and inserted
into the width field.

The Change orientation Button

This button changes the orientation of the working space from portrait to landscape and
vice versa.

The OK Button

The OK button accepts the changed values and closes the dialog.

The Cancel Button

This button closes the dialog without saving any changes.

4.1.2.2 The Areas

The Preview Area

In this area, the worksheet, the desktop background, their colors, as well as the orientation
are displayed proportionally reduced.

The Format Area

Name

The name of the format is entered in this field and the name of the selected one is
displayed.

Width

In this field, the width of the format is determined.

Height

In this field, the height of the format is set.

The Margins Area

Left, Right, Top, Unten

These 4 fields define the distance of the borders from the edge of the working area.

Note: Negative values are also allowed.

4.1.2 II. Working Area
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The Color Area

Foreground

Here, the color of the worksheet can be defined as RGB value.

Background

Here the color of the background desktop can be defined as RGB value.

4.1.2.3 The Options

The Fit to objects Option

This option captures the objects outside the working sheet and extends the sheet by the
amount necessary to accommodate all the objects on the working sheet.

The Show margins Option

This option displays the defined borders as dashed lines in front of the working sheet.

The Select image Option

This option displays the selected bitmap in the preview and later on the working sheet.
The ... button opens the file dialog for selecting the desired bitmap.

The Scale Objects too Option

If the height or width of the working sheet is changed, all objects on the working sheet are
reduced or enlarged by the same amount.

The Rotate Objects too Option

This option determines whether the objects on the working sheet and on the desktop
background will also be rotated when the orientation is changed.

The Accept working area dynamically from current device Option

This option ensures that the width and height values of the working area are read from the
connected device and used. For each device, a format is created with the name of the
device in the list.

4.2 Job Preparation

4.1.2 II. Working Area
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4.2.1 Import

With this command the graphics that have not been saved in the EuroCUT-job-format are
transfered to the working surface.

The functionality of this dialog box corresponds to the open file command. Differences are
only due to the possibility to change the size of the data to be imported by means of the
parameter X- and Y-factor. The desired file is chosen respectively specified via the name
of file, type of file and directories (search in).

Fig. 4.2-1: Import window with preview

With the preview window in the import dialog all following formats can be displayed.

*.ai/eps, *.pcx, *.jtp, *.tif, *.bmp, *.wmf, *.emf, *.dxf, *.gif, *.hpgl, *.gtp, *.ik, *.svg

Indication: With text files (*.txt) the preview window is switched off.

4.2.1.1 Import Presettings

For many import operations, constraints can be defined to be taken into account before,
during or after importing the data. Constraints can effect the DXF or HPGL import or all
import operations.
Also for export constraints are definable in this window. Thus, a special option on job files
can be activated, for example, the PDF export. The constraints are extensively recorded

4.2.1 Import
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in the following article. please refer to 5.7.1.7: The Import Setup

4.2.1.2 PDF Import

4.2.1.2.1 Additional Options

Fig. 4.2-2: Options concerning import of data

Integrated Job File

The Extract Button

Enabling the Extract ... button ensures, that the import function loads the integrated job
file on the desktop, while extracting the PDF file.

Note:  A prerequisite for this is that when you export the appropriate option in the
preferences (see above) was made.

Raster Options

Import as Bitmap Option

4.2.1 Import
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If the Import as Bitmap option is enabled, then all vectors will be rastered into a bitmap
before the import.

Resolution

The value in dpi

Element Selection

Ignore Images Option

If the Ignore Images option is enabled, then no images will be imported.

Ignore Text Option

If the Ignore Text option is enabled, then no texts will be imported.

Page Selection

In the input field the page number can be entered, which should be imported.

All Pages Option

If the All Pages option is enabled, then all pages of the document will be imported.

Search in

In the row Search in the path can be set that shall be searched.

File name

If the file name is know it can be entered into this field

Type of file

Here, you have to choose the format of the file to be imported in order to activate the
corresponding import filter

Preview

The activation of this option draws a preview of the file content to the left preview window

Insert at Position (0,0)

This option inserts the objects at the 0 (zero) position of the EuroCUT-working surface.

X Factor, Y Factor

With these two factors the data can be scaled (increased or decreased) during the import.
The scale can be proportional or unproportional.

4.2.1 Import
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4.3 The EuroCUT Layer dialog

In the layer-settings dialog the parameters necessary for the output are set and attributed
to an object, a color respective a layer. The dialog opens by a right mouse click on the
EuroCUT layer-toolbar in the main window.

Fig. 4.3-1: Layer setup with adjustment of output parameters

In the Information field a name for the layer can be entered. This name is shown later in
all dialogs in which the colors of the objects are needed. 

In the Mode / Tool field the output tool can be selected from a list. The tools shown here
depend on the used output driver.

In the Material field already saved material-configuration can be called up. The
material-configuration can be created, saved or deleted with the button right of the
selection box.

Indication: By clicking with the left mouse button on another color the settings are
saved and the values of another layer can be edited.

4.3 The EuroCUT Layer dialog
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4.4 Tool Assignment Via Layer

Tools which are provided from an output device are pre-defined in the device driver. The
tool selection is done with the output dialog of the Mode / Tool list field.

Fig. 4.4-1: Tools and toos parameter which were defined in the device driver

4.4.1 Define Layer Assignment

What tool is located in which layer - that is necessary to define the order of execution - will
be assigned in the layer settings window. A click with the right mouse button on the to
edit layer opens the layer settings window. Tool assignment is not possible here.

4.4 Tool Assignment Via Layer
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Fig. 4.4-2: Window before switching into the output view

4.4.1.1 The Output Button

If the Output button is enabled, the layer settings window switches in the following view:

4.4.1 Define Layer Assignment
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Now, all from the respective driver provided tool modes are listed. When you select a tool,
then the editable parameters and values appear in the list in the upper area of the output
parameter window. Values can now be edited. A doubleclick in the desired field allows
editing of its value. Repeat this operation for each layer and mode which is scheduled for
output.

Fig. 4.4-3: Layer with tool nomination (left-hand) - tool assignment (Middle) - Layer with
assigned tool (right-hand)

Note: When the red hook is visible, a tool assignment had been done. An additional
control is possible via a tool tip in the layer box by placing the mouse cursor on the
layer under investigation and is waiting for some time.

Depending on the output device, different tools and output modes are available. In the
example below, for example, tools of a flatbed cutter are been used. Here it is important to
determine the correct order in which the tools should work.

Fig. 4.4-4: Tool tip control for the "Cut Through Layer"

4.4.1 Define Layer Assignment
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4.4.2 How the Tool Sequence Is Determined?

In principle, it should be noted that the processing of the layer is done top down and the
logical sequence of different tools, is applied, so that for example, drawing is active ahead
the cut tool. This sequence can be reordered individually.

Fig. 4.4-5: Layer sequence which should be reordered

The change order function is enabled via the layer order menu item. In the move
layer area you'll find the buttons to change the layer order.

Fig. 4.4-6: Tool sequence reordered - Through Cut above Crease

4.4.2 How the Tool Sequence Is Determined?
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Conclusion:  The tool assignment allows first, the definition of tools, second, the
parameters for each tool, third, the selection of the color (layer) in which the to be
processed objects lie and in the fourth place, the sequence in which the operation should
be processed. EuroCUT Basic 8 gives you the flexibility you need in dealing with different
output scenarios and workflows.

4.5 The Output

4.5.1 Device Setting - Interface Setup (Local Device)

The EuroCUT output

With this command you activate the module for cutting, milling, creasing and drawing of
your data.

You activate this function via the  button in the tools toolbar or via the file
menu, menu entry output…

S

Fig. 4.5-1: The output button

When first opening another dialog will be opened before in which the driver of the device
as well as the connection has to be defined.

Fig. 4.5-2: Driver and selection of the connection 

4.5 The Output

57



General

Under the part of the dialog named General you select the driver of the device.

In the right list all device drivers are listed that are available in EuroCUT. In the left list an
individual name for the driver can be distributed. This name will be used in the output
dialogs of EuroCUT.

Enable as server

Requirements are at least 2 licenses of EuroCUT.

If the option enable as server is activated the output device will be marked as plot server
and can be used by another Plot Manager for the output.

The characteristic features of an output device are that a driver for the processing of the
data has to be distributed to this output device. On the computer on which the Plot
Manager is running the job data for the output are transformed into device data by means
of a driver. The output of the device data can be done in several ways:

Types of connection

Local interfaces

Local interfaces are the interfaces (COM1, COM2, ..., LPT1, LPT2, ...) that are directly on
your computer.

The activation of the settings button opens a dialog for the configuration of the
interface. These settings that are done here apply for the whole system.

Fig. 4.5-3: Dialog for the setting of the interface parameters

4.5.1 Device Setting - Interface Setup (Local Device)
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Indication: When steering serially you have to pay attention that all settings on the
side of the computer as well as on the side of the output device correspond.
Otherwise there is no or faulty communication between them.
USB / Firewire Devices

Here, all momentarily connected USB / Firewire devices are listed.

TCP / IP

Here, you have to enter the TCP / IP address and the port number to which shall be
output.

Spooler

Here, you can select a Windows printer driver.

When opening the output dialog again it will be opened directly with the previously set
device driver.

4.5.2 Device Setting (Network Device)

When selecting the menu item create network device … following dialog will be opened:

Fig. 4.5-4: Dialog for the configuration of a plot server

4.5.2 Device Setting (Network Device)
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A network device enables the output of EuroCUT jobs on a Plot Manager that runs on
another computer. Contrary to a "normal device" the data are not locally transformed into
device data but transferred unchanged to the plot server for the further processing.  

Device name

In the entry line enter the name of the device.

Server selection

In the area named server selection enter the TCP/IP address if you use a TCP / IP
connection or the name of the computer that is used.

Network

If a connection shall be done via a network the configuration file of the plot server,
the plotman.ini, must be selected.

Devices (of server)

If the actualize button is pressed the devices of the server are read.

Indication: The device of the server can only be read if the server was selected as
only then, the devices of the server are available.

Driver

In the field driver the device driver is entered that the server uses for this device.

Indication: This driver must also be created locally, which means as local device. 

4.5.3 Start Output from the EuroCUT Working Surface

The output is started using the plotter icon .

Fig. 4.5-5: Pre-processing line weight and color gradient

If a EuroCUT job contains objects with the attributes pen thickness and/or color
graduation a preceding dialog appears. The object attributes can be transformed into

4.5.3 Start Output from the EuroCUT Working Surface
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vectors so that they are taken into consideration at the output. After clicking on the OK
button the object attributes are transformed into curves.

4.5.3.1 Output to Device

Fig. 4.5-6: Output dialog

Output

In the area named output of the output to device dialog you can control most of
the parameters that are directly or indirectly in contact with the output device.

Device

In the device field the previously defined output device is shown.

4.5.3 Start Output from the EuroCUT Working Surface
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Mode

In the mode field  the required output mode is preset.

Output Profile

In the field output profile the required profile with individual settings and values is
selected.

Manage Profiles Button

Clicking on the  button opens the following popup menu:

Add

Activating the Add menu item writes a new data record into the profile database.

Save Profile

Selecting the menu item Save profile the prior to this edited and changed values are
written into the profile database.

Profile Defaults

Activating the menu item Profile defaults resets all Values to the default value. The
profile values are reread.

Mode / Tool Defaults

Activating the menu item Mode / Tool defaults resets all Parameters to the internal
driver values.

4.5.3 Start Output from the EuroCUT Working Surface
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Number of Jobs

The value in the field number of jobs repeats the last output without the reading of the
video marks with identical output parameters such as scaling, etc. Only layers with tools
are given out. This variant protects against the fact that layers are output with no tool
assignment. This means that there is no error output due to the use of the last active tool.

Copies per Job

In the field copies per job you define how often the selected objects shall be cut. After the
cutting this value is automatically reset to 1.

Copy Spacing Y-Direction

The value in the field Copy spacing y-direction defines if the copies shall be stacked
vertically and which space has to be kept between the copies. Pre-condition for the
activation of this option is that the selected object can be cut more than one time on top of
each other!

Indication: In the preview the first object is shown „normally“. Each further object of
the stack is shown dashed in blue.

Copy Spacing X-Direction

The value in the field Copy spacing x-direction defines the space between the copies
that were entered in the field Copies per job.

Weed Border Distance

With the option Weed border distance it is defined if and with which space a rectangle is
cut around the plot that facilitates the weeding of the foil. In the output preview the frame
- if activated - is shown dashed in blue.

Segment Spacing

The segment spacing defines the horizontal space between the single segments.
Segments always occur if the job has to be sectioned which means divided.

Only Output Tool-Assigned Layers

By activating this option, only objects from a layer with an assigned tool are transferred to
the Plot-Manager.

Send Design Relative to Origin

Via this option the zero point (0/0) of the cutter can be moved. If this option is not
active EuroCUT selects automatically the physical zero point as starting point for the
cutting.

If the Send design relative to origin option is active the physical zero point is
moved relatively to the offset coordinate of the reference point. The coordinates of the

4.5.3 Start Output from the EuroCUT Working Surface
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reference point corresponds to the position of the down left corner of the object to be cut
on the EuroCUT working surface.

Plot to File

If the option plot to file is active all output data are directed to a file you have named and
written onto the hard drive.

Enable Tool Tips

If this option is enabled, explanatory texts regarding parameters, values or options are
displayed, if the mouse cursor is located directly above.

Pause after Feeding a Segment

Sectioning / Segmentation: If a job is too big for the output EuroCUT separates the
job automatically in so many parts (segments) that are necessary for the complete output
of the job.

If the option Pause after feeding a segment is active the output is interrupted after each
segment and the material can be re-adjusted if necessary.

Save Settings Button

By activating the Save settings button all values that have previously been entered in the
output dialog are stored and assigned to the currently active output device.

4.5.3.2 Sort Options

Sort before Output

If the option Sort before output is activated all objects in the working surface are sorted
1. in head direction and 2. in transport direction.

Actual Setting

Fig. 4.5-7: Main direction icon

The icon shows which main direction is selected in the output to device dialog.

Always Prefer Job Order

This option ensures, that the sorting that was made before, is not changed through an
alternative sortation.

4.5.3 Start Output from the EuroCUT Working Surface
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The Button

The sort options button opens the output settings dialog.

please refer to 8.6.4.1: The Sort Settings Tab

Accuracy

The Accuracy field offers the following settings: very low, low, normal, high and very
high. As default, the value normal is set.

The accuracy defines of how many vector parts an object should consist. This is only
relevant with objects whose size range in ten thousands of a millimeter. Other object sizes
are calculated automatically by EuroCUT.

Feed / Origin

Depending on the selected driver the field name is either feed or origin.

Friction Feed Cutter

With origin the options are new origin or don't set. If the option new origin is selected
the device goes into X-direction at a fix set value behind the last cut object and this
position is then the new origin. If don't set is activated the physical zero point is the new
origin after the output.

Flatbed Cutter

With feed the options are feed or no feed. If the option feed is activated the material feed
is carried out with the sectioning and with the output from the roll if the flatbed cutter has
an automatic material feed.

Objects

The field Objects allows the selection of the objects to be output. Besides the modes all
objects and selected objects EuroCUT also allows the cutting of color sequences or of
single color layers. The two last named are explained more in detail in the chapter „color
separation when cutting".

Fig. 4.5-8: List field objects with selection modes.

4.5.3 Start Output from the EuroCUT Working Surface
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4.5.3.3 Parameter / Value Table

The table Parameter / Value allows the access to the parameters of device and
driver. The area is divided in parameter and value. The width of the display can be
changed by moving the vertical line between the areas with the mouse. Whenever Edit…
is displayed in the value column a double-click opens the corresponding window for the
setup of a group of parameters.

Fig. 4.5-9: Example for an opened parameter group

Info Line

In the Info Line information relating to the output process is displayed additionally, e. g.
"Job will be sectioned".

Test Drive

If the test drive button is activated the connected device drives along the weeding frame
with the tool head lifted. This also happens if the option weeding frame is not active.

Preview or Direct Output

The Preview button opens the output preview. Direct output suppresses the preview
window. After pressing the output button, the plotter commands are transferred to the
plotter together with the data.

Output

The Output button transfers the data directly to the Plot Manager and to the connected
device.

4.5.3 Start Output from the EuroCUT Working Surface
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Read Material Size

The Read material size button delivers back to all connected devices the height of the
area to be plotted if an accordant command is intended in the firmware for the device.
Devices that do not offer this option no value respective zero is delivered back.

4.5.3.4 Color Separation when Cutting

Each layer color used in the draft appears again in the objects list with the number that
clearly defines each layer color. In addition, in this list field two horizontal color bars
appear. After having transferred the data of a color layer, in the info area of the Windows
status bar the Plot Manager icon ( ) appears.

Double clicking on this icon activates the Plot Manager job control. If the mouse cursor is
positioned on the icon and the right mouse button is pressed, a pop up menu appears in
which the Plot Manager can be closed or the program version can be shown. In the layer
selection the color layers that have not been processed yet occur in the order in which
they had been selected. The order in the stack can be changed at any time.

Fig. 4.5-10: Definition of the order in which the single layers shall be processed by up /
down buttons

The order is defined via the up / down buttons. Layer colors that are not necessary are

deleted from the list with the  button.

Tip: For the color separated cutting use the register marks from the draw
tool. Register marks are cut at the same place on the foil independently from the
used color.

4.5.3 Start Output from the EuroCUT Working Surface
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4.6 Export

If you want to use a job-file also in other programs the data must be made available in
another format than the EuroCUT-job-format. This process is called „export”

Indication: Exporting is done with the highest quality and lowest compression.

Fig. 4.6-1: EuroCUT Export window with file selection

Save

With the icons next to the Save-field you choose the path in which the export-file shall be
saved.

File name

In this field you enter the name of the export-file.

Type of file

Here, you select in which other format the data on the desktop is to be written.

Following export-filters are available in EuroCUT: *.eps (opi), *.cmx (Corel6-X6), *.plt
(HPGL), *: jpg, .pcx, *.tif, *.bmp.

Indication: If objects are selected only those are exported, otherwise all of them.

4.6 Export
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Selected objects

If this option is activated only the marked objects are written in the export-file.

All objects

 If this option is activated all objects are written in the export-file.

Maintain worksheet

With this option the contour of the worksheet is written as object in the export-file.

Bitmap-Export

Fig. 4.6-2: Shade and resolution at Bitmap-export

Shade

The number in front of „Bit per pixel” indicates the exponent of the shade.

Example: 8 bits per pixel = 28 = 256 colors

Resolution

This value defines the amount of pixels per inch. The higher the value the finer becomes
the resolution. The value dpi 300 for example is sufficient for the offset printing.

Indication: Higher values are often not suggestive as the size of the file increases
with higher dpi.

Antialias

The export of a bitmap can also be done with antialiasing short: Antialias, which is a
jaggies smoothing or edge smoothing.

4.6 Export
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4.6.1 PDF Export

4.6.1.1 Additional Options

4.6.1.2 Encrypt Document Option

Enabling the Encrypt Document option allows input of an individual password.

Password

In the input field any password for the document can be filed.

Note: Please make sure that a secure password is used. It should be at least 8
characters long and made of numbers, letters, capital letters and special characters.

4.6.1.3 Set Access Rights Option

Enabling Set Access Rights option allows you to enter an individual password.

Password

In the input field any password for the following access rights of the document can be
filed.

Note: Please make sure that a secure password is used. It should be at least 8
characters long and made of numbers, letters, capital letters and special characters.

PS: The EuroCUT PDF export includes a double-stage password protection. The

4.6.1 PDF Export
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first stage refers to the entire document and the second stage to a specific access
rights of the document.

4.6.1.4 Access Rights

Printing not allowed Option

When this option is enabled, printing of the document - without knowing the password -
is not possible.

Content cannot be extracted Option

When this option is enabled, extracting of contents - without knowing the password - is
not possible.

Do not allow "Change Contents" Option

When this option is enabled, editing of contents - without knowing the password - is not
possible.

4.6.1 PDF Export
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4.7 Flex-Cut, Half-Cut - Punch Function

4.7.1 EuroCUT Driver Options Using a Roll Plotter

Definition

Flex-Cut - short for: Flex(ible)-Cut; Term which is used
from Summa (Plotter manufacturer). Mimaki speaks
of "Half-Cut".

Flex-Cut: Flexible cutting: Flexible, because with 2 cutting
pressures and variable cutting lengths are parameterized.
There is a cutting pressure value for the cutting (cut-through)
of the material plus medium, and a second cutting pressure
value for the so-called kiss-cut, in which only the material itself
is cut and not the medium below.

Application Field

Application field is the production of decals of foil or cardboard (only limited possible) like
labels. This application field is normally a domain of flat bed cutters. But even with the
latest-generation of roll cutter such a production can be built. This function can be realized
both with an optical sensor, as well - even faster and more accurate - with a camera.

Suitability of Roll Cutters

Basically, the cutter must offer this option. Summa and Mimaki are supporting this function
in their professional cutter series. If a cutter is suitable for a special workflow, depends in
first place on the material, and secondarily on the size of the copies and into third place on
the possibilities of cutting software. EuroCUT has all functions, which are required for
sensor-based systems (OPOS, OPAAL, ...) As a professional software solution for
driving  camera-based systems should be mentioned here OptiScout Roll Cutter Edition
from EUROSYSTEMS.

Limits

Limits are mainly those where the material e.g. heavy cardboard can not adequately be
transported from a roll plotter or materials, in which a cutting pressure of 600g is not
enough to cut through them. This field of applications remains reserved to flatbed cutters.

4.7.2 Step by Step Instruction

1. Step: Assignment of The Cut Mode in The Layer Toolbar

Preparation:

The job is prepared with EuroCUT Basic 8 ( please refer to 4.10: Label Production with
Cutters with Optical Sensor).

4.7 Flex-Cut, Half-Cut - Punch Function
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Here is the abstract:

The is prepared for printing with the use of the following functions: 1. Contour function, 2.
Cloning, 3. Multi copies, and 4. Set Jog Marks. Printing can be started directly from
EuroCUT Basic 8, if PjanntoRIP, EuroVPM or PosterPrint as print programs were installed.
If another then the mentioned RIPs is used, the EPS (OPI) export may be used, in order to
preprocess the job data.

Fig. 4.7-1: Job ready for output - Layer toolbar wit tool selection

2. Step: Setup Kiss-Cut Parameter

In the layer settings an appropriate cutting mode must be selected (see blue marking). The
basic setting of the tool has to be preset in the list of output parameter. The black layer
was selected for objects, which should be processed in the so-called kiss-cut mode. The
red hook shows that a tool assignment was done.

4.7.2 Step by Step Instruction
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Fig. 4.7-2: Setup of the tool mode: Kiss-Cut

3. Step: Set Flex-Cut Parameter

In the layer settings the Flex-Cut cutting mode must be selected (see blue marking). The
basic setting of the tool must be preset in the list of the oupt parameter. The magenta layer
was selected fpr objects, which should be processed in the Flex-Cut mode - here:
magenta external contour.

Note: Here the basic setting of cutting length with flex pressure and normal
pressure may be done. The cutting length determines the length of the bridges that
need to remain standing so that the decals do not fall out of the carrier material.

4.7.2 Step by Step Instruction
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Fig. 4.7-3: Setup of the tool mode: Flex-Cut with pressure and cutting length

4. Step: Set Driver Parameter in The Cutting Dialog

In the cutting dialog the mode Flex-Cut must be selected. It is particularly pay attention
to the blue shaded parameters in Fig. 4.7-4 . These parameters are only visible, if the
appropriate cutting mode was selected (here: Flex-Cut).

Note: The in the cutting dialog visible Flex-Cut graphic is not! included. It should
only make it clear what the parameters mean.

4.7.2 Step by Step Instruction
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Fig. 4.7-4: Setup of the Flex-Cut parameters (Common settings)

5. Step: Output on The Cutter

After pressing the output button the job is cut, with these values. The result of this output
are perforated, removable decals.

4.8 Excursion: Contour vs Outline vs Contour Line

Often, there is confusion among EuroCUT Basic 8 users, because the differences
between this terms are not clear and there can be seen no difference on the EuroCUT
working sheet, if the so-called full surface mode is enabled. Not until then the so-called
contour mode - switch on or off using F9 key - differences can be seen. Obviously
completely different functions are meant.

In the following the terms are examined for their similarities and differences.

4.8.1 1. Contour

Definition:

Contour is a property, an attribute of a vector object or a type face, comparable with a
color fill. Color and width can be defined individually.This contour is given out on a laser or

ink jet printer. The tool for the definition of a contour is the pen .

4.8 Excursion: Contour vs Outline vs Contour Line
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Fig. 4.8-1: Pen attributes dialog

Fig. 4.8-2: Full surface mode

Fig. 4.8-3: Contour mode

Attention: A contour is not! given out on a cutter, unless the "Convert contours"
function was executed before data  transfer to the output module.

Fig. 4.8-4: Dialog for conversion of contours into cuttable objects

If the option Convert contours is enabled, a vector combination in the thickness of the
contour is generated. This combination is put in a layer with the same color.

Additionally the following dialog appears with a pre-selection of the correct welding method
(here: Weld by Color).

4.8.1 1. Contour
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Fig. 4.8-5: Welding dialog with presetting "by color"

Tip: For testing can be switched into the contour mode in order to control which
objects will be given out.

4.8.2 2. Outline

Definition

Outline is a vector contour around another vector object oder a type face. In differenc to
the term contour the generated contour is a real vector which can be outputted. Another
difference is, that  interior parts are contoured as well with a so-called Inline. Example:
Letters like a, e where the interior parts are also contoured (see fig. below) 

Note: The Outline function is linked with the welding function, so that if contours
are overlapping each other, an error-free output to vinyl gets possible.

Fig. 4.8-6: Outline dialog

4.8.2 2. Outline
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Fig. 4.8-7: Full surface mode

Fig. 4.8-8: Contour mode

4.8.3 3. Contour Line

Definition

By a contour line is often referred in connection with the term: "print & cut". In "Print & Cut"
bitmaps mostly logos - graphics without vectors - are contoured with a vector line, in order
to produce decals, label, sticker on a cutter with OPOS sensor. The contour line is the line
that is cut around each sticker. It is like the pen contour an outline around the entire object.

Note: In this case the thickness of an object cannot be defined; as default a
so-called hairline (0.01 mm) is generated.

Fig. 4.8-9: Contour line dialog

Fig. 4.8-10: Full surface mode

4.8.3 3. Contour Line
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Fig. 4.8-11: Contour mode

Conclusion: The above examples should made clear that it is important to keep apart the
notions. Although, there cannot be seen any difference on the scree when in the full
surface mode, different tools and functions are involved. This example also shows how
flexible the tools of EuroCUT Basic 8 are.

4.8.3 3. Contour Line
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4.9 Excursus: Welding of Vector Objects

4.9.1 A Selection of the Most Important Welding Sub Types

The welding function merges two or more vector objects together to a combination.
Depending on number and shape of the selected objects, you can select between the
following options: Manually, Automatically, Trim (which cuts objects with lines or
curves), Open trimming, Fill, By color, Full surface or Screen printing.

4.9.1.1 Automatically

Automatically calculates the common areas of the objects. All overlapping pieces are
merged with each other; transparent interiors are taken into account.

The option Automatically is especially appropriate for the welding of serifs of scripts. The
serif of the preceding letter often overlaps with the following letter itself or its serif. Without
welding the material would be cut at this intersections. The automatic welding eleminates
this overlap and serves to a cuttable transient of the serifs.

Note: Please note that by this option objects with different color are welded to one!
combination object. Should the object colors taken into account, then choose either
one of the options: By color, full surface, or screen printing.

Tip: If after the automatic welding some parts are missing, then you should reduce
the character spacing in your text editor by 100% to 99%. As a result, identically on
top of each other lying node points get moved in a way, that they can recognized as
separate nodes and then the welding function runs correctly.

4.9.1.2 By Color

By color removes all areas, which are masked from overlying colors. It does not matter,
how much objects or colors you select. If open objects are also selected, they can be
closed or be provided with a line width.

4.9.1.3 Full Surface

4.9 Excursus: Welding of Vector Objects
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The option Full Surface underfills objects in one color, whose areas cover the areas of
another. The partially covered objects are handled in a way, that the overlying ones cover
the underlapped totally.

Tip: The most common application is the window lettering. Here, the option 'by
Color' is often too difficult to handle. At 2 or 3 foil colors, you should take the full
surface option, in which the individual foil colors are glued one above the other.

4.9.1.4 Screen Printing

The welding option screen printing is particulary powerful tool for screen printers. First of
all it eleminates overlaps of the color layers. Afterwards the colors are stacked in the color
sequence. Finally, a bridge (an outflow wedge) gets inserted as an overlap.

4.9.1.5 The Color Stack of Screen Printing

Changing the color stack: In screen printing the sequence of printing colors is from light
to dark. Lighter colors are printed before darker colors. With a mouse click a color layer
can be picked up and moved to the desired position. The color stack shows the location of
the individual layers above the medium. The output sequence takes, the changings of the
color stack, into account. 

4.9.1.6 Trim

Trim means, that you can cut closed objects with lines or curve objects and the resulting
subobjects are then closed again automatically. Depending on the request, you can put
one or more objects - like a "knife" - on the objects which should be dissipated. If you use

4.9.1 A Selection of the Most Important Welding Sub Types
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more "knives", this objects must lie in the same layer or must be combined. With the help
of the trim function the underlying objects are dissected along the "knives". Also, a
dissection in multiple tiles is easily achievable, because the knives may overlap. The
resulting subpieces are then sorted according to their location and condensed to
particulary groups.

4.9.1 A Selection of the Most Important Welding Sub Types
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4.10 Label Production with Cutters with Optical Sensor

EuroCUT Basic 8 is predestined for the so-called "Print & Cut" production of labels or
stickers on self-adhesive material. The term "print & Cut" means, that on the medium gets
printed first and then the labels are cut outlined with a cutting plotter. The cutter therefor
should be equipped with an optical sensor, which recognizes so-called register marks or
jog marks, so that print inaccuracies can be compensated. For the "Print & Cut" process it
doesn't matter with which method the material was printed - screen print or digital inkjet
print.

Definition: OPOS - Acronym for Optical POsitioning System

4.10.1 1. Step: Job Preparation

The job is prepared with EuroCUT Basic 8. All tools which are needed for the production of
labels are included. With the CoRUN export function out of host programs like
CorelDRAW, Freehand, AutoCAD or Illustrator external data can be imported and
processed in EuroCUT.

Fig. 4.10-1: Job preparation

Using the special functions 1. Contour Line, 2. Clones, 3. Multi Copies, and 4. Set Jog
Marks a job is prepared for printing. Printing can be done directly using EuroCUT Basic
8, if for example PjanntoRIP or EuroVPM as a print program is installed as well. If another
RIP than those specified is in use, you must use the EPS (OPI) export in order to prepare
the job data for printing.

Tip: For the generation of identical copies, the clone tools should be used. This
ensures a small amount of data and a high processing speed.

Thus the cutter can provide the print job with cut outline, manufacturer-specific jog marks
can be used and printed additionally! Setting of the jog marks can be done with the
Settings / Common Settings / Register Marks menu in EuroCUT.

4.10 Label Production with Cutters with Optical Sensor
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Limits: EuroCUT Basic 8 has no resp. only rudimentary image processing tools. The
image processing must be done in a host program such as Photoshop. Afterwards, the
image data are imported into EuroCUT and processed.

4.10.2 Jog Marks for Optical Recognition Systems

4.10.2.1 Field of Application: Contour Cutting (Print & Cut):

Wherever printed materials must be cut or milled with contours, the usage of jog
marks is indispensable, in order to produce with the required accuracy. Beyond
that, inaccuracies which occur during the print process, must be
compensated.  Preset ist done in the Settings / Common Settings / Register Marks
menu. The jog marks are set using the  tools  menu with the Set Jog Marks
submenu item.

Note: The jog marks function can be used with all cutters with optical sensors or
with flatbed cutters or milling machines equipped with camera systems for mark
recognition.

Fig. 4.10-2: Settings menu in EuroCUT with jog mark selection

4.10.2.2 Definition

Jog marks and video marks are used synonymously for marks related to optical detection
of marks. Register marks describe a tool, that is used for the assembly of colored signs.
Print and cut marks describe marks, that are used commonly in printing and desktop
publishing.

4.10.1 1. Step: Job Preparation
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Note:  Jog marks are usually associated with an optical sensor; video marks with
camera usage.

4.10.2.3 Jog Marks

A detailed description of all parameters can be found here: please refer to 5.7.1.4: The
Register / Crop Marks… Setup

After preselecting the producer-specific jog marks, this jog marks can be set around the
job, so that in the 2nd step they will be part of the printing job. Hotkey for this function in
EuroCUT is SHIFT+J.

Fig. 4.10-3: Tool menu for setting of jog marks

4.10.3 2. Step: The Print Process

Print processing is either done in screen print or digital inkjet print with solvent ink. The
RIP does the rastering, the linearization and the density correction. Additionally control
parameter like heater temperature, resolution, etc. are managed. Modern solvent printer
print on un-coated materials which often do not have to be laminated. All users which do
not have an own printer, can delegate the print process to an external provider.

4.10.4 3. Step: The Cutting Process

Currently, all premium cutter have an optical sensor, so that with this devices a serial
production of label, stickers, or decals is possible. The cutter processes in doing so the
contour line - not to be confused with Outline - which was generated  in the job prepartion
around all copies. Fig. 4.10-7 shows the magenta contour lines which will be cut.

4.10.2 Jog Marks for Optical Recognition Systems
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Fig. 4.10-4: Cutting head with sensor and tangential knife

The cutter described above are able to process sheets or rolls. EuroCUT's plotter driver
support both functions. Fig. 4.10-5 and Fig. 4.10-6 show the driver parameter for the
cutting with sensor for the processing of identical job copies using rolls or sheets (Fig.
4.10-6).

Fig. 4.10-5: Parameter setting OPOS=ON using the example of Summa S-Class

Note: The parameter "OPOS" is set automatically on "ON" if the appropriate marks
are used. When processing identical copies of jobs on a roll using jog marks, the
mode "OPOS cutting with copies"  must be used (Fig. 4.10-6). Then additionally the
number of copies in X direction can be set and as well as the mark distance
between the copies in mm.

4.10.4 3. Step: The Cutting Process
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Fig. 4.10-6: Parameter setting with identical Job copies from roll (also possible with
sheets, if the parameter "Sheet=On" was set)

Fig. 4.10-7: Cut contours in the cut preview (the gray contour below left, is required
for "Flex-Cut")

The result of this process are readymade labels in individual number and size. To get the
labels carwashresistant, they must be treated with a liquid lacquer.

4.10.4 3. Step: The Cutting Process
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4.11 Cutting - Milling - Creasing - Drawing …

4.11.1 The Output Preview 

The output preview is automatically started if you press the preview button in the output
dialog. 

Closing the output preview and returning to the working surface of EuroCUT ESC

Fig. 4.11-1: Output preview with toolbars, status line and output objects

In the status line of the cutting preview the following information is shown: contour, filling,
width and height, group or combination, the max. foil consumption in square meters
and running meter (rnm) as well as selected object features. If the output menu is
activated the data are transferred to the output device.

Indication: If the job to be cut is left, underneath or above the material- or table
preview and the output -menu is activated you will automatically be reminded that
the objects to be cut are out of range of the output.

Detailed description:
please refer to 7.9: The Preview Tools Toolbar
please refer to 7.10: The Preview Object Parameters Toolbar

4.11 Cutting - Milling - Creasing - Drawing …
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4.11.1.1 Material optimization 

The material consumption can be reduced by using the module Box nesting. The Box
nesting  ensures that all objects are arranged in such a way that they take up as little
space as possible during output. Rotating or not rotating objects ensures that material
consumption can be reduced.

Fig. 4.11-2: Parameter dialog for the material optimization

Indication: Groups and combinations are each regarded as an optimization object. If
this is not desired the grouping must be interrupted and the combination cancelled.

Following options are available:

Weed border distance

In this field the desired distance between the optimization objects, the so called weed
border distance can be set.

Material width

This value determines to which maximum material width the optimization should be
applied. If the working area is to be used, just click on the From working area button to
enter the corresponding width value.

Rotation of  objects

none

With this option, no objects are rotated; they are only optimized for the weed
boarder distance.

4.11.1 The Output Preview 
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to the shortest side

All objects are rotated so that the shortest side is downwards.

as required

During the optimization all objects are rotated so that they can be arranged saving the
most space.

Only selected objects

Only the selected objects are considered. With this option you can for example optimize
according to layers (colors).

Include bitmaps

If this option is activated, bitmaps and groups that contain bitmaps are also optimized.

4.11.1.2 Weeding lines 

Weeding lines serve for the better procession of large jobs. Material length or width of
several meters are difficult to handle, therefore, you can insert weeding lines during the foil
cutting that divide the job into smaller parts that are more easy to handle.

Fig. 4.11-3: Output job with weeding frame (dashed in blue) without weeding lines

4.11.1 The Output Preview 
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Fig. 4.11-4: Example with 3 horizontal and 3 vertical weeding lines (dashed in red)

Fig. 4.11-5: Result of the output with weeding lines - objects not! cut

In the output preview there are 3 possibilities to insert horizontal and vertical weeding
lines.

Indication: Weeding lines can only be inserted if the option weeding frame has been
activated in the output dialog.

4.11.1 The Output Preview 
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1. Manually

Position the mouse cursor on the weeding frame dashed in blue around the objects. The
mouse cursor changes into a double-headed arrow. Now draw a horizontal or vertical
weeding line to the position where it should be segmented. Repeat the process until all
necessary weeding lines are inserted.

2. Via the menu options

Open the menu options and activate the menu item horizontal weeding line or vertical
weeding line.

The first weeding line is inserted in the middle of the objects to be cut. The second call up
of the function bisects the two halves in two more halves and so on.

3. Via the shortcuts h or v

An „h” or „v” directly entered via the keyboard generates the respective weeding lines - as
described in 2.

Tip: Single objects can be provided additionally with a separate weeding frame via
the right mouse menu.

4.11.1.3 Job Sectioning

Sectioning is the division of a job in so many parts (sections) that are necessary for the
complete output of the job.

If the job to be output is bigger than the set or the available output width (output dialog,
field width of material) of the output device in the information area of the output dialog
the indication „job will be sectioned“ is shown.

Indication: The terms sectioning and segmentation are used as synonyms.

The activation of the output menu then opens the following dialog before the transfer to
the device:

4.11.1 The Output Preview 
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Fig. 4.11-6: Sectioning dialog with overlapping of 3 mm

Optimize material (max. size + smallest at last)

Optimize … smallest at last) causes EuroCUT to create segments in the maximum
permitted size. The size of the last segment usually differs from the others

Optimize material (max. size + smallest at first)

Only active with flatbed cutters. If the last segment was also cut as last the plate could not
be processed until the end. Therefore, the remainder is cut as first so that the plate lies on
the table until the end.

Segment optimization (segments of equal size)

If the option segment optimization is activated always segments of the same size are
created.

Optimize segments by mark posiions

This option is activated as default with EuroCUT if video markers exist in the Job. The
above dialog is skipped and the preview of the dynamic segments is shown. The reason of
this optimization is that always at least 3 video markers are necessary. Depending on the
location of the video markers EuroCUT "searches" up to 30% next to the segment line if
there is a video marker. If yes, the respective segment is adjusted dynamically.  

Preset segmentation

The last used setting is automatically saved. When loading the job again this sectioning
can be accessed.

Reverse cutting

The option reverse cutting indicates that the objects are cut as „negative“ for example for
the use as template for the screen printing.

4.11.1 The Output Preview 
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X-overlap and Y-overlap

Segmentation with overlapping - In the fields X- and Y-Overlap you can define how much
the segments shall overlap. The vectors are enlarged accordingly at the cutting points.

Fig. 4.11-7: Foil optimization in the sectioning preview with 8 segments and information on
segment sizes

Selection and deselection of the segments

Selection and deselection of the segments is done by clicking into the segment. The red
checkmark indicates which segment is active and being output. 

Changing the suggested sectioning

You can change the sectioning by clicking on the blue section lines and move them to the
desired position with the mouse. If necessary EuroCUT inserts automatically new sections.

In the status line of the segmentation preview the size of the job to be cut in X- and
Y-direction and the number of segments are shown.

4.11.1 The Output Preview 
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4.12 The Layout View Mode

The Layout View Mode is switched on or off using the View Menu. F8

4.12.1 Definition:

On all 4 corners of the working surface, the word "Layout" will appear. The containers are
shown as dashed red line with the name "text container" or "image-container".

NOTE: The Layout View Mode is not to be confused with the contour or the full
surface mode (F9).

Fig. 4.12-1: Layout anzeigen Modus eingeschaltet

4.12.2 Definition Container

4.12.2.1 What Is A Container?

A Container can receive bitmaps or texts. There are 2 types of containers: 1. Image
containers (bitmaps) and 2. Text containers. With the Draw- or Text tool a frame is
mounted, to gather the later content. The framework determines properties and

4.12 The Layout View Mode
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dimensions of the content. The container is displayed in the so-called Show Layout mode
- as a red dotted line. The mode is switched on and off using the F8 key on the the
keyboard.

4.12.2.1.1 Benefits

A container can be filled with differents contents using a macro. The replacement contents
can be entered and edited in EuroCUT or externally imported from a *.CSV file. The
content adapts to predetermined characteristics and dimensions. It can be defined, for
example, whether in texts that are longer than the frame, the cap height is adjusted or
whether the text block is compressed. The Replace macro automatically replaces the
contents, line by line.

The benefit thus lies firstly in the fact that the layout and behavior of objects in the
container can be predetermined, and secondly that through the automatic replacement a
significant increase in productivity can be achieved - Keyword: Serial production.

4.12.2.1.2 Limits

The limits are that bitmaps and texts, but not vector objects can be imported into the
container.

4.12.2.1.3 Compatible Formats

- for Image container: *.BMP, *.PCX, *.JPG, *.TIF, *.GIF, *.PNG

- for Text container: EuroCUT own file format and using the text import function in the
textbox *.ECT, *.RTF, *.TXT

- for external data sets / databases: *.CSV

4.12.2.2 Excursus:

4.12.2.2.1 The CSV Format  (Comma Separated Values)

One character - often the comma - is used for separating records (columns). Rows are
separeted by newlines. Depending on the software involved semicolon, colon, tab, space
or other separating characters are possible.

The CSV file format is often used to transfer simple structured data between different
computer programs - here: database tables. The column names are defined in the first
record - the so-called head  record. 

4.12.2 Definition Container
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4.12.3 Overview Container Types

Image Container Text Container

Creation Draw tool of the Tools toolbar
(closed object is required), i. e.
the container's contour is drawn
using one of the Draw tools

Text tool of the Tools toolbar, i.
e. write a text or mount a frame
with the Text tool

The Container property will be
set automatically when in Show
Layout mode (F8)

The Container property will be
set automatically when in Show
Layout mode (F8)

In the Contour- or Full Surface
mode a container is created
using the Change to Container
function in the Object or Context
menu.

In the Contour- or Full Surface
mode a container is created
using the Change to Container
function in the Object or Context
menu.

Deletion Cancel Container State function
in the Design or Context menu
or
Reset Container attribute in the
Objects / Attributes tab of the
sidebar

Cancel Container State function
in the Design or Context menu
or
Reset Container Attribute in the
Objects / Attributes tab of the
sidebar

Representation
(in the F8 Show
Layout  mode)

Red dotted line with text "Image
Container"

Red dotted line with text "Text
Container"

Set
Parameter /
Boundary
Conditions

Enable Container Settings
function in the Context menu
or
Double click on "Image
Container"

Enable Textbox function in the
Text editor toolbar or via
Context menu
or
Double click on "Text container"

Change
Name

Name field in the Objects tab
or
Name field in the Setup Image
Container dialog

Name field in the Objects tab
or
Name field in the Settings tab of
the Textbox Settings Text
Container dialog

View F8 key
or
Enable Show Layout in the View
Menu

F8 key
or
Enable Show Layout in the View
Menu

4.12.4 Working With Containers

4.12.4.1 How Do I Draw A Container?

You can use the same tools as for the drawing of vectors: the Draw-Tool  and the
Text-Tool . A red-dashed frame is the mark of a container. The default names are
"Image Container" or "Text Container, depending on with which tool was drawn. With the

4.12.3 Overview Container Types
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text tool, a frame is drawn or text is entered at the cursor position. Double-clicking on the
container opens the respective settings dialog.

4.12.4.1.1 Display in the Show Layout Mode

4.12.4 Working With Containers
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Fig. 4.12-2: Display of one Image Container and four Containerns in the Show
Layout Mode (F8)

4.12.4.1.2 Display in the Contour resp. Full Surface Mode

4.12.4 Working With Containers
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Fig. 4.12-3: Standard view (Contour Mode) and standard view (Full Surface Mode) with
default fills 

4.12.4 Working With Containers

101



4.12.4.1.3 Container Settings Image

A doubleclick on an Image Container opens the following dialog, in which can be defined
how the inserted bitmap should be treated.

4.12.4.1.4 Parameter

Name

Here an individual name for the image container can be defined. Default name is: Image
Container.

Insert images proportionally Option

If the Insert images proportionally option is enabled, then the bitmap, which is to be
imported, will be enlarged or scaled-down into the frame, while maintaining the
proportions.

Fit Option

If the Fit option is enabled, then the to import bitmap will be adjusted into the frame.

Scale with objects option

If the Scale with objects option is enabled, the the content of the container will scaled
also, that means if the frame gets enlarged or reduced then the content is scaled too.

Hor.(zontal) Alignment

The Horitzontal Alignment can be left, middle or right.

4.12.4 Working With Containers
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Vert.(ical) Alignment

The Vertical Alignment can be top, middle or bottom. 

4.12.4.1.5 Preview

The Preview shows, how the contents behave in relation to the container.

4.12.4.1.6 Cancel Container Status Option

This menu item Cancel Container Status cancels the object status "Container". The
object attribute in the objects tab is disabled.

4.12.4.1.7 Context Menu - Container Relevant Entries

Hide Content

This menu intem hides the content of the image container, when in full surface mode.

Show Content

This menu intem shows the content of the image container, when in full surface mode.

Remove Content

This menu intem removes the content of the image container.

Note: Same function as: Fill: None.

Container Setup

This menu intem opens the Setup Image Container dialog..

Cancel Container State

This menu intem disables the container attribute of the selected object.

Note: This is the same function like disabling the container attribute in the objects
and attributes tab.

Change To Container

This menu item transforms a text or vector object into a container object. The container
object is only visible in the show layout mode.

Note: This menu item is only visible, when you are not in the show layout mode.

4.12.4 Working With Containers
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4.12.4.1.8 Settings Text Container

A doubleclick on a text container opens the following dialog in which is defined, how texts
will be handled.

Name

In the text field a name for a text block can be defined. By default, the name "text". The
name is shown in the object's tab list of the sidebar and in the object names tab.

Alignment

Here the alignment of text blocks is pre-defined; these options correlate with the items in
the text toolbar.

Left

If the left option is enabled, then the marked text block will be justified left.

Right

If the right option is enabled, then the marked text block will be justified right.

4.12.4 Working With Containers
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Centered

If the centered option is enabled, then the marked text block will be justified centered.

Block

If the block option is enabled, then the marked text block will be justified as block.

Forced Block

If the forced block option is enabled, then the marked text block will be justified as forced
block, which means that all lines of text - even the last one - are adjusted on the column
width or width of the work sheet.

Additions

Adjust line heights to X runlength (Reduce)

If this option is enabled, then when the X runlength is changing, the text block will be
scaled-down proportionally.

Adjust line heights to X runlength (Crush)

If this option is enabled, then when the X runlength is changing, the text block will be
compressed, which means that the character distance will be reduced.

Single line text

If this option is enabled, then is prevented, that a line break is executed at the end of the
line.

4.12.4 Working With Containers
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4.13 Printing

Fig. 4.13-1: The print button in the standard toolbar

4.13.1 Without RIP Software

The following chapters explain in detail the single functions of the EuroCUT print dialog.

Open the EuroCUT print… dialog by selecting the menu item print in the file menu, via
the keyboard hotkey CTRL+P or by pressing the  button in the toolbox.

Fig. 4.13-2: The print dialog

In the down right part of the dialog you find the option tile and the adapt button and the
1:1 button under output. Depending on which option you have activated the appearance of
the preview of the print -dialog changes.

Indication: If the print -dialog is opened the adapt button is automatically active
because we do not assume formats that exceed the maximum output-size of the
device to be accessed as standard for the printing of objects or graphics.

4.13 Printing

106



The adapt mode

The adapt-mode corresponds to the printable area. The values for the printable area are
shown in the field print area which is in the upper right part of the print dialog.

The preview window in the adapt mode

The preview window offers the possibility to check your job before printing. The edges of
the window are magnetic which means that if an object is approaching the edge of the
sheet the object stays at the edge of the window.  Thus, a faster positioning of the objects
in the corners or at the edges of the sheets is obtained.

Tip: If the magnetization of the edges shall be switched off, keep the SHIFT button
pressed while positioning your objects.

The x- and y-coordinates that are shown underneath the preview window express the
location of the left upper edge of the object on the working surface.

Mouse-functions in the preview window (adapt-mode)

Clicking once with the right mouse button or activating the preview button increases the
preview window to the maximum size of display.

Fig. 4.13-3: The print preview button

Fig. 4.13-4: Print preview in the complete picture mode

4.13.1 Without RIP Software
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Indication: The size of display depends on the set screen resolution (800*600,
1024*768, ...). Clicking again with the right mouse button resets the original status.

Indication: If the left mouse button is pressed and kept pressed, a dashed black
frame appears around the objects to be printed. This frame covers all objects that
are on the working surface and corresponds to the printing area.
Printable area and object

The fields Printable area and object are in the upper right part of the print dialog.

Fig. 4.13-5: Section field printing area and object

Printable area

In this field, the specified printing area with height and width values is shown.

Object

In this field the object/s to be printed with height and width values is/are are shown.

Indication: The fields for the percental enlargement of the objects are not active in
the adapt-mode.

One field below on the right side of the print dialog is the field printer.

Fig. 4.13-6: Printer selection and Setup

If you open the list you will get a list of all printers that are installed on your system. Select
the printer that you want to use. In order to do more settings for the printing activate the
setup button. The dialog that now opens corresponds to the menu item properties of the
respective printer file menu.

Indication: The print dialog that is opened by pressing the setup button depends on
the loaded printer driver and is therefore not further explained.

Right next to the setup-button the orientation of the sheet (portrait / landscape) can be set.

What is printed?

In the area named print mode are two combo-boxes in which you can define what shall be
printed. In the first list you can choose between the options objects, objects with
worksheet, job-info .

4.13.1 Without RIP Software
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Objects

All objects on the worksheet are printed.

Objects with worksheet

All objects and the worksheet (black frame) are printed. Underneath the black frame the
company´s name, the dimensions of the working surface and the proportion in which it
shell be output are also automatically printed.  

Job-info

If this option is activated all information that have been entered in the job-info are output
as well as all objects in the below right area of the sheet are printed downsized.

All objects

All objects that are on the working surface are printed.

Selected objects

Only objects are printed that have been marked on the working surface.

Ratio

Here, you have the possibility to enter the printing proportion as numeric or percentage
values.

Indication: Both fields are coequal which means that if a numeric value is entered
the corresponding percentage value is entered automatically in the dedicated field
and vice versa.

Fig. 4.13-7: Field for the entry of the size proportion

Examples for the indications of proportion with the corresponding percentages:

Proportion 1 : 1 corresponds to 100.00 %
Proportion 1 : 2 corresponds to 50.00 %
Proportion 1 : 3 corresponds to 33.33 %
Proportion 1 : 4 corresponds to 25.00 %

Centered

If this option is activated all objects on the working surface are centered.

4.13.1 Without RIP Software
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Tiling

If this option is chosen the print -dialog appears in the tile mode.

Number of copies

In this field the number (max. 9999) of the exemplars to be printed can be defined. The
buttons adapt and tile enable switching between the two modi with the same name.

1:1

If this button is activated all objects on the working surface are displayed in their original
size in the preview window and output.

Adapt

If this button is activated all objects on the working surface are downsized so that they can
be shown completely in the preview window.

Options

Output to file - Print to file

If this option activated, print data is redirected to a file.

Contour mode

With this option activated all objects are printed like shown in contour mode - without
filling.

Also print colored worksheet

When selecting this option the background color defined for the working surface is also
printed.

Print subsidiary lines

If the job to be printed contains subsidiary lines they are also printed.

Always print black

This option becomes automatically active if in the first list all objects and in the second list
color separated printing (after the layer order) or print single colors (after single layers)
was selected.

Indication: If you want to print the objects on the working surface in color the option
always print black must be deactivated.

4.13.1 Without RIP Software
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Register-/ Jog-Marks

This option becomes automatically active if in the first list all objects and in the second list
color separated printing (after layer order) or print single colors (after single layers)
was selected.

Indication: If you do not want to also print register and jog marks this option must
be deactivated.

4.13.1.1 The Tile Mode

If you switch from the adapt mode to the tile mode the preview window appears as
follows:

Fig. 4.13-8: The preview window in tile-mode

In the tile mode all tiles are shown. A tile is that part of the object that can be output on the
device to be accessed.

The option pause after indicates after which tile (enter amount of tile) the output shall be
interrupted. The fields overlapping (mm) serve for the entry of the desired horizontal and
vertical overlapping of the objects to be printed.

4.13.1 Without RIP Software
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When printing to roll (option Roll), whole lanes can be printed without having spaces
between the single tiles.

Indication: Only the print of a whole lane can be interrupted and not the printing of a
single tile. The entry of an overlapping in feed direction (print direction) has no
influence on the roll which can also be seen at the display of the size of the tile.

After the tiling the dialog is not closed automatically as it is an advantage to directly
compare the print and the preview. In addition, thus you can directly repeat the print of a
specific tile.

Mouse function in the preview window (tile mode)

One click with the right mouse button on the tile preview increases the tile display. This
can also be done by clicking on the -button in the upper left area of the window. Clicking
once again with the right mouse button resets the original status.

If you double click with the left mouse button on a tile this one will be deactivated which
means it will not be printed.

Double clicking with the left mouse button while pressing the SHIFT button leads to the
inversion of the tiles which means that the tiles that have been deactivated before become
now active (printed) and the tiles that have been active become deactivated (not printed).

The objects within the preview window can be shifted by means of the mouse. The window
edges are magnetic which means that when the object is approaching the edge of the
sheet the object remains clinged. When pressing the SHIFT button the magnetization is
released.

Example for the printing in the tile mode

The following example explains the single functions, shortcuts,... in the tile mode in detail.

The tile mode offers the possibility to print in any size which means each graphic,
independent of the size can be printed on the connected output device. For the print of
your graphic you do not need a printer with which DIN A2-, A1-, A0- or even large size can
be output. 

How?

The graphic to be printed is divided in so many segments (tiles) that are necessary to be
able to output the graphic on the connected output device. The amount of necessary tiles
depends on the size of the graphic to be output and the pre-defined output format (DIN A3,
A2, ...). The setting of the output format is done via the set button EuroCUT print dialog
and depends on the connected output device.

Load any graphic in EuroCUT and open the print dialog, either via the file menu by
selecting the menu item print..., via the keyboard with the key combination CTRL+P or via
the button in the standard toolbar.

4.13.1 Without RIP Software
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The EuroCUT print dialog is opened in the adapt mode. Activate the tile mode by
activating the thus named button.

The print dialog appears as follows:

Fig. 4.13-9: The print dialog in the tile mode

In the upper right corner of the dialog you find the two fields tile and object.

The field tile corresponds to the field print area in the adapt mode. The other fields in the
right part of the print dialog are the same as in the adapt mode.

Fig. 4.13-10: Preview with settings in the tile mode

4.13.1 Without RIP Software
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Activated and deactivated tiles

An active tile is a tile that is not marked with a red „X”. Deactivated tiles on the other hand
are marked with a red „X”.

Fig. 4.13-11: Bottom row: Tiles deactivated

The deactivation or activation of a tile is done by double clicking with the left mouse
button which means when double clicking on an active tile it becomes deactivated.
Another double click on the same tile activates it again.

In the previous figure you can see that the lower row of tiles is marked with a red „X”.
These tiles were deactivated and will not be printed.

In the tile mode you do not only have the possibility to activate / deactivate single tiles.

Tip: Keep the CTRL button pressed while double clicking with the left mouse button
on the desired tile and all tiles where the mouse cursor is are deactivated.

4.13.2 With Pjannto RIP software

Fig. 4.13-12: The Pjannto RIP button in the standard toolbar

Indication: Pjannto RIP is a professional PostScript-RIP that is not a part of
EuroCUT. If a license was purchased from Pjannto RIP and the software is installed
on the same computer the Pjannto RIP button is automatically embedded in the
standard toolbar of EuroCUT and the file menu enlarged with the entry Pjannto
RIP… .

4.13.2 With Pjannto RIP software
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5 Reference Part

The menu items in chronological order:

5.1 The File Menu

5.1.1 The New… Command

With the New command a new job is opened. CTRL+N

5.1.2 The New from Template Command

This command is for saving jobs as template (file extension JTP). These
templates can be loaded again via file / open or file / new. As JOB
name „untitled" is shown.

5.1.3 The Last Version Command

When loading a job a safety copy named AUTOSAVE.BAK is created in the
EuroCUT directory.
With this command the version of the job that was available before the
loading of the job can be restored.

5.1.4 The Open… Command

With this command the files that were stored on your hard drive or another
data carrier in the EuroCUT JOB file format are brought onto the current
screen / desktop. You can further edit this file. Jobs can be deleted after a
safety query.

 CTRL+L

5.1.5 The Save Command 

With this command you save the current job. If the respective job has
already been stored before, the given file name and the directory are kept.
The older version of the job is overwritten so that the old version can not be
restored any more.
If you have created a new job that has not been saved before, the program,
if you have clicked the save command in the file menu, goes automatically
to the command save as… .
First, the job info dialog is opened where you can enter more information
about the job. Then, the real dialog for saving your job is opened and you
are asked to enter the file name and select the directory.

CTRL+S
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5.1.6 The Save as… Command

With this command you save a new job under a file name chosen by you in
a directory to be selected. This command is also for changing the file name
and / or directory of already existing files. If for example you want to save a
job that is build up on an older one without losing the old version then you
select the command save as ... and you can save the new job under
another name in a new directory if you wish to.

The command save as... is also to be selected if you want to save the
current job onto another data carrier. To do so, select the appropriate disk
drive.

SHIFT+
CTRL+S

5.1.7 The Save all Command

With this command you save all open EuroCUT jobs. If among them, there is
a newly created job it can be saved under a file name chosen by you in a
directory to be selected.

5.1.8 The Send by Email… Command

This command opens the standard email client and links the current job as
attachment to the email. The job must be saved before.

5.1.9 The Import… Command

With this command files are imported into EuroCUT. Known file formats are
shown in a list.

CTRL+I

5.1.10 The Export… Command

If you want to use a job also in another program the job file must be
converted into a suitable format which means exported.

CTRL+E

5.1.11 The Send to RIP… Command

With this command the PostScript RIP is started, if it was installed and
activated (licensed) before.

Note: This menu entry is only visible, if an EUROSYSTEMS RIP had
been installed and activated (licensed) before. Then the RIP-Setup in
EuroCUT Basic 8 must be processed: please refer to 5.7.1.3:
The RIP… Setup

5.1.6 The Save as… Command
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5.1.12 The Print… Command

With this command you print the current file in any size (tiles) on the
standard printer.

CTRL+P

5.1.13 The Output… Command

With this command you call the output module (Plot Manager) for cutting,
drawing or milling.

S

5.1.14 The Scan... Command

This function activates your scanner via a so-called TWAIN interface. If your
scanner possesses such an interface (program) you can directly access it
via this menu entry.

If for your scanner this software is not available then insert the scanner
software via the menu tools / insert program into the menu structure.

CTRL+N

5.1.15 The Choose Scanner… Command

This command allows you to select a scanner.

5.1.16 The Quit Command

With this you terminate EuroCUT and return to the Windows desktop. If you
have not saved the job that is currently being edited, you will be asked if you
want to do so.

CTRL+Q

5.1.17 The Job History

The Job History function facilitates the loading of the 4 last jobs without
having to pass via the directory tree. At the end of the menu list of the file
menu the names of the 4 last edited jobs appear. Click with the mouse
button on the desired job name. Then, the selected file will be loaded on the
working surface.

5.1.12 The Print… Command
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5.2 The Edit Menu

5.2.1 The Undo Command

With this command it is possible to undo the last done operations and
functions. The default setting is 5 steps. This default value can be changed
via the settings menu, menu entry standard settings / miscellaneous and
here undo levels. The maximum value is 100 steps.

Indication: This setting can only be changed with a new file (file menu,
menu item new)!

F5

5.2.2 The Undo Stack… Command

This command opens a window with the last used commands. Most
intermediate states are previewed. By clicking on the respective command
this state is restored.

Note: This menu entry is only displayed, if restorable commands are
used.

SHIFT+F5

5.2.3 The Redo Command

This command is the reverse command to undo. It restores the status that
was there before the undoing.

F6

5.2.4 The Redo Stack… Command

This command opens a window with the last commands, which were made
undone. Most intermediate states are previewed. By clicking on the
respective command this state is restored.

Note: This menu entry is only displayed, when commands were
undone.

SHIFT+F6

5.2.5 The Cut Command

With this command objects are copied to the Windows clipboard and deleted
from the working surface. Via the clipboard objects can be inserted at
another place or in another program.

Indication: For the transport of your data you can also use the export
command. This is always necessary if your data shall be transferred to
another computer.

CTRL+X

5.2 The Edit Menu
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5.2.6 The Copy Command

With this command marked objects are copied to the clipboard without
deleting them from the working surface.

CTRL+C

5.2.7 The Paste Command

This command inserts graphics and objects from the clipboard to your job.
The mouse cursor changes to a right angle in which insert is written.

Now point the tip of the right angle to the point on your working surface
where the graphic or the object shall be inserted.

CTRL+V

5.2.8 The Paste Special... Command

Via this menu item "pictures" can be imported from the clipboard to
EuroCUT.

Indication: If in EuroCUT objects are copied this menu item is not
active.

5.2.9 The Select All Command

With this command all objects of the active job which means all objects on
the working surface and also outside the working surface are marked. The
selected objects can then be grouped, combined or moved.

CTRL+A

5.2.10 The Reverse Selection  Command

With this command all non-selected objects are selected. Already selected
objects will be unselected.

SHIFT+E

5.2.11 The Job Info… Command

With the job info you have the possibility to save additional information with
every job. You can print this information and use them for invoicing or as
accompanying working sheet.

Next to this information as for example order number and company
address the job-info also gives information about the used material.  In the
memo-field additional comments in note form can be stored.

5.2.12 The Color Layer… Command

This command starts the layer settings dialog in which objects are colored,
foil colors are defined, device tools are assigned, objects of the same color
are selected and layers can be made invisible or blocked.

L

5.2.6 The Copy Command
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5.2.13 The Prepare to Cut… Command

With this command an object with defined line weight or filling can be made
ready-to-cut.

Contour
The line weight defined before is contoured.

Color graduation
The color graduation defined before is divided into the defined number of
steps and each step is provided with an outline.

Both
The defined line weight and the defined color gradient (number of steps) are
outlined.

5.2.14 The Multi Copy… Command

This command serves the generation of any number of object copies (duplicates) on the
working sheet. Number, Offset and more can be set in a dialog.

Detailed description: please refer to 7.6: The Object Parameter Toolbar

5.2.13 The Prepare to Cut… Command
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5.3 The Design Menu

5.3.1 The Rotate Axis Command

This command rotates the marked objects at 90° counter-clockwise.
This option is always necessary if you want to adjust your objects fast to the
rolling direction of the foil without having to go via the rotate function.

A

5.3.2 The Rotate Axis With Page Command

This command rotates the marked objects with page at 90°
counter-clockwise.

SHIFT+A

5.3.3 The Horizontal Mirror Command

The selected object is mirrored at its horizontal through its center point. If
several objects are marked, the center point of the virtual checkbox whose
edge is limited by the 8 black dots with the corresponding horizontal is taken
as axis of reflection. If no objects are marked all objects are mirrored.

X

5.3.4 The Vertical Mirror Command

The selected object is mirrored at the vertical through its center point. If
several objects are selected the center point of the checkbox with its
corresponding vertical is used as axis of reflection. If no objects are marked
all objects are mirrored.

Y

5.3.5 The Delete Command

Pressing the DEL key executes the delete command. In order to delete
particular objects from your graphic they must be marked.

Del

5.3.6 The Mirror on the X Axis Command

 All selected objects will be mirrored at the visible X-coordinate axis. SHIFT+
X

5.3.7 The Mirror on the Y Axis Command

 All selected objects will be mirrored at the visible Y-coordinate axis. SHIFT+Y

5.3.8 The Duplicate Command

In order to use this command the object to be duplicated must be marked
before. Now click with your left mouse button on the duplicate command or
activate it via the hotkey. The marked objects are now doubled.

CTRL+D

5.3 The Design Menu

121



The positioning is done according to the values that you have entered in the
settings menu, menu item standard settings / miscellaneous.

Indication: You can also duplicate an object by first marking it, moving
it with the left mouse button kept pressed and then press the right
mouse button once at the position where the duplicate shall be
created. The displacing values are entered automatically with this
procedure.

5.3.9 The Clone Command

If you clone an object you create a copy linked to the object. Modifications at
the original (the initial object) are automatically done at the clone (the copy). 

If a clone is modified in its size or form, an other "original" is created.

5.3.10 The Group Command

This command allows combining several objects to a group in order to edit
them together. This can be wise if for example you want to move several
objects without changing their position to each other. To do this, first mark
all objects that you want to move together, select the group command and
then move the newly created group to the desired place. Now, it is not
possible any more to change the single objects that form the group
independently from each other. 

In order to make this possible again the grouping must be broken with the
break group command. 

CTRL+G

5.3.11 The Break Group Command

This command is used to divide a group of objects again into single object.
Each object can then be edited individually.

CTRL+B

5.3.12 The Combine Command

This command combines like the grouping several objects to one. The
difference to the group command is that the selected objects are not
regarded as single isolated objects lying next to another anymore.

Let us explain this fact with an example.

You have created two squares with different sizes, the smaller one lying
completely within the bigger one. In order to obtain that in the
full-color-mode the area of the smaller square is transparent you combine
the two squares after having marked them before. The size of the bigger
square is now interpreted as outer edge and the smaller one as inner edge.
The area between the two edges is filled with the color selected in the layer
box. In the middle, a hole with the size of the smaller square remains.

SHIFT+K

5.3.8 The Duplicate Command
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5.3.13 The Break Combination Command

With this command you cancel a combination. Now, the program treats the
combination objects as single objects again.

SHIFT+L

5.3.14 The Fill Function

With this function vector objects and text blocks can be filled.

None
All fillings respective filling bitmaps of the marked object are removed. Only
the contour of the objects remains in the previously defined layer color.

The Color graduation… command
This command opens a dialog with which the appearance of the color
gradient fillings of closed curves, text objects or combinations can be
defined. 

The Bitmap… command
Pressing this button opens a dialog with which objects can be filled with
bitmaps.
For editing the filling bitmaps several functions are available.

The Layer color… command
This command removes all fillings and shows the object in the layer color in
which it was created.

The Transparency… command
This instruction allows the setting of the transparency from 0 to 100% using
either the slider or entering an integer percent value.

5.3.15 The Contour Function

Via this function objects can be provided with pen attributes (width of pen,
color,...), hairlines can be created and pen attributes removed.

The none command
This command removes all pen attributes of the marked object and shows it
in the color in which it was created.

The hairline command
This command allocates a hairline to the marked object in the momentarily
active layer color.

The attributes… function
Via the pen attribute dialog the contour pen of curves, combinations or text
objects can be designed.  Contour pens are shown while drawing the object
contour in the full face mode.

The layer color command

5.3.13 The Break Combination Command
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This command assigns selected layer color to object contour.

Indication: The pen attributes have no influence on the display of the
objects in the contour mode (F9). Here, the contours of the objects are
drawn with a simple contour line in the layer color.

5.3.16 The Draw Command

In this menu the tools with which you can create graphic objects are
summarized. All tools can be activated via the toolbox or the menu item
draw in the object menu.

5.3.16.1 Rectangle

You have switched to the rectangle-mode and move the mouse cursor on
the desktop to any corner of the desired rectangle.
Press the left mouse button and keep it pressed while moving the mouse
cursor to the diagonally opposite corner. If you let got the mouse button the
rectangle appears.

Indication: If you keep pressed the SHIFT key while drawing a
rectangle the first selected point is the center point of the rectangle. If
you keep pressed the CTRL key while drawing the rectangle the
movement of the mouse automatically draws a square. Pressing
simultaneously the SHIFT and CTRL kex draws a centered square. For
drawing the object the status of the keys (pressed or not pressed) is
important when letting go the mouse button.

5.3.16.2 Circle

With this command you activate the mode for drawing the ellipses and
circles. In this mode you open up a box in which the ellipse is adapted. So,
first select a corner point of the box to be opened up with the mouse.

Indication: The first drawn point is no point of the ellipse. Only if you
press the SHIFT key the starting point becomes the center point of the
ellipse.
Pressing the CTRL key only allows the drawing of a circle. Pressing
simultaneously both keys results in the drawing of a centered circle.

5.3.16.3 Line - 4 Modes

5.3.16.3.1 The Line Mode

This command activates the mode for the drawing of lines. The mouse
cursor has now the shape of a cross with a line shown on the down right.

For the drawing of lines two modes are available:

5.3.15 The Contour Function
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1. "Closed" Lines
You can create closed lines by keeping pressed the left mouse button when
drawing the line. You terminate a line by letting go the left mouse button.
If the mouse cursor is beyond an ending point of a line it will be highlighted
and the mouse cursor changes its form. If you click now once with the left
mouse button on this point, this point will be initialized.
Now you can continue to draw with one of the following four modi: draw,
curve, digi mode, freehand.

2. "Open" Lines
You can create open lines by clicking once with the left mouse button before
drawing. Then, you create the line according to your wishes. If you now click
once again with the left mouse button the subline is finished and a new one
can be attached. This mode is terminated by double-clicking with the left
mouse button.

Indication: If you keep pressed the SHIFT key while moving the mouse
cursor the drawing of the straight line is limited horizontally and
vertically. If while drawing you keep pressed the CTRL key the angle of
the drawn straight line is limited to 15° steps. The straight line now
moves at 15°, 30°, 45°, ... to the edges of your working surface.

5.3.16.3.2 The Circular Arc Mode

You activate the circular arc mode by pressing the right mouse button in the
line mode and select there the respective menu item.
When drawing in the circular measure after placing the second curve
point the curve calculated from the first, second and current cursor point is
drawn. One click with the left mouse button places the curve.
If the mouse cursor is above an endpoint of a circular arc it will be
highlighted and the mouse cursor changes its form. If you click now once
with the left mouse button on this point, this point will be initialized. 
Now you can continue to draw with one of the following four modi: draw,
curve, digi-mode, freehand.

5.3.16.3.3 The Digitize Mode

With this command you activate the mode for post-digitizing bitmap
templates.  
Switching between the modi line, curves, digi-mode or freehand via the
right mouse menu, the arrow keys of your keyboard or the toolbox facilitates
the post-processing enormously.

Assignment of the arrow keys:

Left -->Line mode
Right -->Circular Arc

mode
Up -->Freehand mode
Down-->Digitize mode

5.3.16 The Draw Command
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If open objects have been drawn they can be closed via the right mouse
menu and there the menu item close. Indication: with this option all
marked objects can be closed independent of the distance between the
starting point of the first drawn and the endpoint of the last drawn
object.

Another possibility to close open objects that have been drawn is the
following:

Draw an open object. Move the endpoint of the last drawn object with the
mouse near the starting point of the first drawn object. You can see that the
mouse cursor changed its appearance. If you let got the mouse at that point
the object will be closed. 
If the mouse cursor is above an endpoint of a digi-curve/line it will be
highlighted and the mouse cursor changes its form. If you click now once
with the left mouse button on this point, this point will be initialized. 
Now you can continue to draw with one of the following four modi: draw,
curve, digi mode, freehand.

5.3.16.3.4 The Freehand Mode

With this command you activate the mode for the drawing of arbitrary lines,
curves or objects. Keep pressed the left mouse button and create the object
of your choice. Let go the left mouse button to terminate the object. If the
mouse cursor is above an endpoint of a digi-curve/line it will be highlighted
and the mouse cursor changes its form. If you click now once with the left
mouse button on this point, this point will be initialized. 
Now you can continue to draw with one of the following four modi: draw,
curve, digi-mode, freehand.

5.3.16.4 Register Mark

With this option you can place register marks as administer help in your
graphic. This function enables the accurate mounting of the color separated
cutting job. To do so, activate this command and click the register marks to
the desired positions. Register marks are cut along layer neutral (color
neutral).

If open objects where drawn, they can be closed via right mouse button with
menu item Close.

5.3.17 The Align… Command

With this function marked objects are aligned. You can align the objects
horizontally or vertically. The objects are arranged in that way that they are
either centered or aligned at the desired side.
In addition, the objects can be aligned with the same distance so that a
steady appearance is obtained.  It is also possible to center all objects
horizontally or vertically on the working surface.

R
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Indication: This option can only be activated if you have marked at
least 2 objects.

5.3.18 The Sort With Simulation… Command

This command opens the object sort function with which the output order
and direction of rotation of the objects can be defined. The sort can be
done dependent or independent of layers. Also, the preferential direction
of the sort can be defined.
In a preview the output of the object is simulated graphically; here, the
traverse path of the tool head can be sketched. The simulation can be
repeated unlimited without changing the original objects.

CTRL+F10

5.3.19 The Sort Manually… Command

This command enables a manual object sortation. For every single output
object the order and direction of rotation can be defined. This can be done
for every layer. In the preview window the objects are clicked to the
desired order with the mouse cursor. Alternatively, the objects can also be
sorted by clicking in the object list. The sorted objects are shown dashed
in blue. 

CTRL+F11

5.3.20 The Clockwise Command

This command sets the direction of rotation of the marked objects to
clockwise.

Indication: This function is only relevant in connection with a
connected milling or engraving device.

>

5.3.21 The Counterclockwise Command

This command sets the direction of rotation of the marked objects to
counter-clockwise.

Indication: This command is like the previous only relevant in
combination with milling applications.

<

5.3.22 The Close Contour Command

With this command open objects can be closed. You can see in the status
line if an object represents an open track or not. To close it you mark the
object and use that command.

SHIFT+S

5.3.17 The Align… Command
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5.3.23 The Open Contour Command

With this command closed objects can be opened.

Indication: The menu item open contour corresponds to the separate
function in the node tool.

SHIFT+O

5.3.24 The Round Corners… Command

The round corners command rounds down nodal points with a freely
defined radius. 
The rounding can be done inwards or outwards. The rounding can also
affect the whole object or just single nodes.

Indication: This function can also be used for the rounding of font
characters.

SHIFT+
CTRL+R

5.3.25 The Reduce Nodes Command

This command eliminates nodes of an object that are unnecessary or lying
on top of each other. With straight lines, nodes that lie on the straight line
and between the endpoints of the straight line are removed automatically.
The reduction of nodes decreases the complexity of objects.

5.3.26 The Insert Bridge Command

Bridges are intended to prevent milled parts from falling out. Parts of the milling contour
remain, the length and number of which can be specified individually. The position of the
manual bridges can also be changed. Bridges are inserted for all selected objects.

Note: In the node mode, bridges can be added precisely to a point. 

5.3.27 The Add to Clipart Group Command

The command inserts a marked object in the momentarily active clipart
group of the clipart tab. 

5.3.28 The Change to Container… Command

This instruction transforms a text object or a bitmap in a so-called container.
According to the container type the appropriate setup dialog is displayed.

Note: After the transformation the design menu entry switches to the
following command: Cancel container state.

5.3.23 The Open Contour Command
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Detailed decription container: please refer to 4.12.2: Definition Container

5.3.29 The Cancel Container State Command

This instruction transforms a container back into a text object or a bitmap.

Note: After the transformation the design menu entry switches to the
following command: Change to container….

Detailed description container: please refer to 4.12.2: Definition Container

5.3.30 The Container Setup… Command

This instruction opens the setup dialog for image containers or the textbox
with the setup tab for text containers.

Note: The settings for text containers can also be set using the textbox
entry in the context menu.

Detailed description container: please refer to 4.12.2: Definition Container

5.3.31 The Weeding Border Command

This command generates a so-called weeding border or frame around one
or more selected objects. A weeding border facilitates weeding of the vinyl
from the carrier.

5.3.32 The Object Properties… Command

A click on the Object Properties… menu opens the Object Properties dialog. This
dialog informs about the Object Type and gives the Coordinates of the bounding box of all
selected objects. Restrictions can be set for the selected objects, such as No output to
device, Hidden, etc. In addition, a name can be assigned. This can be used to customize
objects and apply macros to them. For example, object groups with a certain name can be
switched to Hidden. Attributes that are assigned to the objects are displayed and can be
switched off if required, e. g. the attribute Video mark. In summary, it can be said that all
object-relevant information is accessible at this point.

Note: This command corresponds to the Object Manager in the sidebar.

5.3.28 The Change to Container… Command
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5.4 The View Menu

5.4.1 The Zoom In Command

If you select this function the mouse cursor changes into a lens with a plus
inside. You can now select an area that shall be zoomed by keeping
pressed the left mouse button. The selected area will then be shown
increased to the maximum in the program window.

Indication: A beep of the computer loudspeaker informs you that the
maximum zoom is reached.

+(NUM)
or  F2

5.4.2 The Zoom Out Command 

This function decreases the working surface gradually. If it had been
zoomed repeatedly before, the single zoom steps are carried out backwards.

-(NUM)
or  F3

5.4.3 The Full Page Command

Select the function so that the whole available working surface is shown. B

5.4.4 The Show All Command

This function changes the display of the vector drawing in this way that all
objects can be seen in the program window. The section is chosen in that
way that it is the biggest possible display of the graphic showing all objects.

Indication: If you keep pressed the SHIFT key while doing this
command only the marked objects are zoomed to maximum.

F4

5.4.5 The Show Selected Objects Command

If this command is activated only the objects marked on the working
surface are displayed as big as possible.

SHIFT+F4

5.4.6 The To Front Command

If you have arranged several objects on top of each other the following
commands enable you to modify the location of the objects to each other.
With the to front command the marked object is set on the top place above
the others.

CTRL+O

5.4 The View Menu
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5.4.7 The To Back Command

With this command you set the marked object underneath respective behind
all other objects.

CTRL+U

5.4.8 The Forward One Command

This command sets the marked objects further front in the display. PgUp

5.4.9 The Back One Command

With this command you set the marked object further down and thus further
back in the display.

PgDn

5.4.10 The Reverse Order Command

The order of the objects in the stack is reversed. What was lying on top then
lies at the bottom and vice versa. This also applies for all objects
in-between.

U

5.4.11 The Change Order Command

With this command you can change the order of the objects in the display
interactively by clicking the object contours one after another in the desired
order.

Note: If all contours are to be taken into account, the grouping of the
objects must be broken or the combination of the objects must be
broken as well.

SHIFT+R

5.4.12 The Show Layout Command

If this command is activated the text is replaced by a rectangle with a cross
in the middle. Pressing once again the menu item shows the text again.

Indication: This option proves of value especially when processing
many text objects. The refreshment of the screen goes much faster
thereby.

F8

please refer to 4.12: The Layout View Mode

5.4.13 The Contour View Command

This command switches the display of the working surface to the contour
mode which means that only the contours of the objects are shown.

F9

5.4.7 The To Back Command
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5.4.14 The Enhanced View Command

With this command you can obtain the best possible display of the objects
(smoothened contours).

Indication: It slows down the speed of processing and should
therefore only be used for the last check or presentation.

SHIFT+F9

5.4.15 The Always on top Command

The EuroCUT window remains always in the foreground.

Indication: This menu item is only active if the EuroCUT window is in
the window mode.

CTRL+Y

5.4.16 The Refresh Screen Command

With this function the content of the visible window is build up again without
changing the size or the selected section.

Indication: Use this command if objects on the screen are visible that
cannot be accessed by the arrow tool or if display errors of another
kind occur.

CTRL+W

5.4.14 The Enhanced View Command
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5.5 The Tools Menu

5.5.1 The Vectorizing… Function

If this function is activated you arrive at the vectorization program integrated
in EuroCUT with which you can convert scanned bitmaps into vectors.

Indication: Bitmaps cannot be cut as they consist only of single pixels
that have been recognized by the optic of the scanner. For cutting,
milling, grooving ... such pixel graphics must first be converted to
vector graphics.

Detailed: please refer to 8.12: The Tracing Tool (Vectorization)

V

5.5.2 The Revectorizing Function

This option can accelerate the vectorization process enormously. It is
always wise if you want to find out the best parameters for the
vectorization. The different results should be laid in different color layers to
make it easier to remove the unsuitable results later on. When repeating,
the interne bitmap created for the vectorization process is used and not the
original bitmap that lies on the working surface.

Indication: If the original bitmap was modified in the meantime the
vectorization command has to be used.

SHIFT+V

5.5.3 The Contour Line… Function

With the contour line function the outer edge of arbitrary many objects is
calculated and provided with a contour. Contrary to the outline with this tool
also bitmaps can be contoured. In addition, not every single object is
contoured but it is tried to find only one contour that comprises all selected
objects. Therefore, this function is especially suitable for the creation of
intersection lines around labels. The objects of the label can be arranged
arbitrarily. Afterwards, with the tool described here the contour of the label in
the desired distance is calculated. The thus created contour can be used
later for cutting the printed label.

Detailed: please refer to 4.8: Excursion: Contour vs Outline vs
Contour Line

K

5.5.4 The PhotoCut… Function

The function creates vectors from bitmaps. PhotoCut calculates from
Windows Bitmap files (*.BMP, *.PCX, *.TIF) grids or patterns that can be
output with a cutting plotter or a similar device. The picture is divided into

5.5 The Tools Menu
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logical pixels and the average gray value calculated for each of these logical
pixels. So, a picture is created that has less pixels than the original. Out of
this picture horizontal or vertical stripes, circles, squares, ... are created
whose width is proportional to the gray value at the respective position.

please refer to 8.16: The PhotoCUT Function

5.5.5 The Insert Program… Command

With this command you can insert an external program - external meaning
no EUROSYSTEMS program - in the menu structure of EuroCUT. The
advantage of this possibility is that you do not have to leave the surface for
starting other programs.

5.5.6 The Edit Program List… Command

With this command existing program entries can be modified or deleted.

Indication: The menu command only refers to the programs inserted
additionally to the menu structure.

5.5.7 The Set Jog Marks Command

This command automatically sets jog marks around the selected objects.
Type, size and position relative to the selected objects are pre-set in
settings / standard settings / register / jog marks menu.

Indication: The markers do not lie in a layer, are always displayed in
black, keep their scaling and size and are grouped when being created.

SHIFT+J

please refer to 5.7.1.4: The Register / Crop Marks… Setup

5.5.8 The Search / Replace Video Marks Command

With this command circle objects in an import file - with an in the
Register-/Jog Marks menu entry defined size - are searched and replaced
by video marks.

Note: This option can also be set as a standard via the Settings /
Standard Settings / Import menu entry.

5.5.9 The Measure Command

With the function measure an arbitrary track can be measured, scaled,
rotated and dimensioned. If you have activated this command the mouse
cursor changes into a reticle. It is then set at the starting point of the track to
be measured and the mouse button pressed and kept pressed. Then, the
mouse cursor is moved to the end of the track to be measured and the left

M

5.5.4 The PhotoCut… Function
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mouse button let go. With the SHIFT key pressed you only measure
horizontal and vertical distances. Now, the result of the measurement is
shown in a dialog field and can be modified.

Indication: The modification of the size is applied proportionally to all
selected objects. When rotating bitmaps the area of the bitmap
increases but not the objects displayed in the bitmap.

5.5.10 The Box Nesting… Function

This optimization takes care that all objects are arranged in a way that they
take the least space on the output. By rotation or no rotation of objects it is
taken care of that the waste of material can be reduced.

please refer to 4.11.1.1: Material optimization

5.5.11 The Outline… Function

This function creates a contour with a distance around a vector object to be
freely selected and is mostly used for contouring text objects. The color of
the target layer can be pre-selected. Inline, the reverse function creates a
contour lying inwards. „Outline & Inline” combined creates a closed
contour in the pre-selected strength. 

Indication: Contrary to the contour with combined objects
simultaneously an inner contour is created. This function is not to be
confused with a contour pen that only is a drawing attribute and no
vector object.

O

5.5.12 The Welding Command

The merge functions manually, automatically, trimming, open trimming,
fill, by color, full area and screen printing take care that overlaying object
parts what would cut the foil are eliminated and connected.

W

please refer to 8.8: The Welding Tool

5.5.9 The Measure Command
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5.6 The Text Menu

5.6.1 The Add Text Command

If this command is activated the mouse cursor changes into a capital "T" and
the text entry can be done.
The same can be obtained by positioning the mouse cursor at that point of
the working surface where later the text shall appear and once press the left
mouse button.

T

5.6.2 The Edit Text Command

With this command the text cursor is set at the beginning of a selected text
block. The text block can now be changed.

Note: This function can also be enabled using the text tool. The text
cursor appears at the position that was clicked on with the tip of the
text cursor arrow.

CTRL+T

5.6.3 The Textbox… Command

This command opens the EuroCUT textbox.
please refer to 8.2: The Textbox Dialog

SHIFT+
CTRL+T

5.6.4 The Convert Text to Curves Command

EuroCUT uses so-called vector or outline fonts (not to be mistaken with the
outline function). These writings can be increased and rotated continuously.
The sinlge letters are thereby defined as sequence of vectors.

Indication: If this menu command is carried out, the text converts to a
graphic object causing that the writing attributes of the text
editor cannot be used anymore.

CTRL+K

5.6.5 The Convert Text to Lines Command

If you have composed a text with more than one line in the text editor then
you can, after having placed the text on the working surface, split the text
block into single text lines. The single text lines then can be edited
individually, provided with new writing attributes or displaced on the working
surface.

SHIFT+Z

5.6.6 The Fontmanager Command

Fontmanager for URW BE, TrueType, OpenType and Adobe Type 1
Fonts

5.6 The Text Menu
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If this menu item is activated, the Fontmanager is started.

please refer to 10.2: Fontmanager

5.6.6 The Fontmanager Command
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5.7 The Settings Menu

5.7.1 The Standard Settings Menu

Fig. 5.7-1: Default Settings dialog - here: Miscellaneous tab is active

5.7.1.1 The Miscellaneous… Setup

5.7.1.1.1 Duplicate values

- X offset

Indicates the value that remains between the original and the duplicate (in
X-orientation) after the creation of a duplicate.

- Y offset

Indicates the value that remains between the original and the duplicate (in
Y-orientation) after the creation of a duplicate.

- Dynamic adaptation Option

This option takes care of the switching on or off of a function that
automatically enters and uses the duplication values as X- or Y- orientation
when duplicating with the right mouse button.

5.7.1.1.2 Move objects

CTRL+J

5.7 The Settings Menu
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- X increment

Indicates the value how much the marked objects are moved or displaced
when pressing the arrow keys on the keyboard.

- Y increment

Indicates the value in Y-orientation how much the marked objects are moved
or displaced when pressing the arrow keys on the keyboard.

Indication: If you keep pressed the SHIFT key during the movement,
the value of the displacement is reduced to a tenth part. If you keep
pressed the SHIFT + CTRL key the displacement is a hundredth of the
set step size.

5.7.1.1.3 Undo function

- Max. undo levels

Refers to the undo function in the edit menu.

Indication: This option can only be set if no job is loaded.

- No undo / redo for bitmaps larger than ... MB

For bitmaps that are bigger than the value set in this field the
undo/redo-function is automatically switched off which means that the
operations on this bitmap cannot be made undone.

Advantage: saving of time.

Reason: The expenditure of time (computational expenditure) for bitmaps
from a specific size onwards becomes too big as for every undo / redo step
a copy of the original (initial state) must be created.
The value that is entered in this field should be between 5-10% of the RAM
available in the computer.

5.7.1.1.4 Program start

- Info window

When the program is started, an information window is displayed in front of
the workspace, which informs about news, updates, etc., if there is a
connection to the Internet.

The 3 options are: Display always, Do not show again, Only display
when new.

Recommendation: With „Only display when new” you do not miss any
important information regarding EuroCUT.

5.7.1 The Standard Settings Menu
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5.7.1.2 The Mouse… Setup

5.7.1.2.1 Mouse action

- <Ctrl> + right mouse button assigned with:

Here, you can define the assignment of the right mouse button. To do this,
open the selection list and select the command that shall be carried out
when clicking once with the right mouse button.

- Click Delay

This option increases the accuracy when selecting objects. The default
value is 100; the unit is millisecond. The higher this selected value the
longer it takes until the object follows the mouse cursor. An accidental
displacement of the objects is thus decreased.

Note: Users that are not so sure with the handling of the mouse should
increase this value.

- Scroll window automatically Option

This option is switched on by default and takes care that whenever an object
is moved above the edge of the working surface with the mouse, the working
surface automatically is moved, scrolled.

5.7.1.2.2 Mouse Wheel

These options ease the navigation on the EuroCUT desktop with computer
mice, which are equipped with a mid-wheel button. 

- <Shift> toggles these modes

Two modes are possible: Zoom or Vert. Scroll.

Zoom

This option - starting from the cursor position - increases or decreases the
working area when turning the mouse wheel: according to the direction of
rotation.

Scroll vert.(ical)

This option - starting from the cursor position - moves the working area
horizontally (Wheel + CTRL key) or vertically when turning the mouse wheel.
According to the direction of rotation the movement is done to the left, top or
bottom or to the right, top or bottom.

5.7.1 The Standard Settings Menu
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- Resolution

The sensitivity of the wheel can be adapted to individual requirements. The
range is from 1 (coarse) to 10 (fine).

5.7.1.3 The RIP… Setup

Standard RIP

As an extension to EuroCUT Basic 8, 1 RIP is provided by default:
EuroVPM

EuroVPM

This option must be enabled from the EuroVPM licensee. Using the ...
button, goes to the folder containing the EuroVPM.exe.

5.7.1.4 The Register / Crop Marks… Setup

Fig. 5.7-2: Default Settings dialog: here: Register / Crop marks tab active

5.7.1.4.1 Registration marks (Print & Cut)

Fig. 5.7-3: Different register marks depending on the manufacturer

5.7.1 The Standard Settings Menu
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- Type

The Type list field is used to select for which manufacturer or for which
device register marks are to be generated.

Note: Only the options supported by the selected device are active!

- Alignment

Align to selection

If the Align to selection option is activated, the register marks are aligned
relative to the selected objects.

Align to page margin

If the Align to page margin option is activated, the register marks are
aligned relative to the border(working surface).

- Target layer

The Target layer determines in which layers the register marks are placed.

Note: This also indirectly determines with which tool the register
marks are edited, if a tool assignment has been made via the layer.

- Outside corners

The Outside corners option determines whether or not the outside lying
corners are taken from the object to calculate the distance.

- Emit marks (or by pressing <Ctrl>)

The Emit marks option determines whether the register marks should be
taken into account when outputting the data, that is, print, cut or mill.

If, in the output dialog, the CTRL key is pressed before clicking the preview
key or the output key, the register marks will be given out as well.

- Size

This option determines the size of the register marks.

Note: Maximum and minimum size are dependent on the device
manufacturer.

- Offset to object

The Distance to object option determines how close the register marks are
to be positioned in relation to the objects.
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- Distance to page border

The Distance to page border option determines how close the register
marks should be positioned to the edge of the page.

- Line thickness

The Line thickness option specifies the width of the lines of the register
marks.

Note: Maximum and minimum line thickness which can be used
depends on the cutting system.

- Max X distance

The Max X distance option determines how far the maximum distance
of the register marks in the X axis should be related to the objects.

- Max Y distance

The Max Y distance option determines how far the maximum distance of
the register marks in the y axis should be related to the objects.

5.7.1.4.2 Alignment marks

With this function you can place alignment marks as a weeding help in your
graphics. This function makes it easy to accurately fit color-cut cutting jobs.

Practice

Click on the Alignment mark icon in the drawing toolbar and set the
marks on the desired positions.

By default, the EuroCUT alignment mark consists of a square with two
diagonally extending lines inside the square, which resemble a cross. The
result is 4 triangles, which can be used to precisely apply two films of
different colors.

Note: Alignment marks are cut-layer-neutrally, provided there are cut
objects in the layer.

- Size

In the Size field the desired size of the alignment mark is defined.

- Cut without cross Option

If this option is activated, only the square is used as an alignment mark. The
diagonal lines inside the square are suppressed. This option is used when
only 2-colored signs are to be processed.

5.7.1 The Standard Settings Menu
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5.7.1.4.3 Crop marks

Crop marks are markers used when printing. They are located outside the
print space. They show where exactly the sheet has to be cut. The crop
marks are located at the corners of the sheet.

- Size

Here is set the size of the crop marks.

- Offset to object

Here, the distance between the crop marks and the objects is determined.

- Line thickness

Here, the thickness of the crop lines is determined.

5.7.1.5 The Weed Border Setup

This command creates a frame around one or more selected objects. An
additional frame facilitates the release of the cut objects from the carrier
material (Weeding).

5.7.1.5.1 Manual Weed Border

Manual, because by selection is determined, around which which objects a
frame is placed.

- Uniformly Page Distance

Here, a uniform distance from all 4 object sides to the weed border is
established. 

- Different Page Distance

Here, a non-uniform distance from all 4 object sides to the weed border is
established.

- One Frame For Each Used Layer

In each layer in which objects are located, a weed border around all objects
therein is placed.

5.7.1.6 The Output Devices… Setup

This category of the basic settings allows the definition of important
parameters for the output on the output device. The default settings
correlate with the information in the output dialog before the output of the job
data to the connected device.

5.7.1 The Standard Settings Menu
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Current output device

All currently connected output devices can be selected in this window. The
driver name, file name, and the port interface are displayed. Mode and
material from the material database can be determined.

The … button enables the creation, modification and deletion of the settings.

Port

Indicates with which computer interface the output device is connected.

Default Settings

Keep reference point

This option takes care that no new origin is set after the output of a job. The
next output is done at the same coordinates as the previous.

Stack processing

This option enables an uninterruptible output without an interaction of the
Plot Manager.

Wait after segment

Waiting after segment indicates if the cutter shall remain at this position after
the output of a cut segment. This option is typically needed with flatbed
devices without integrated automatic foil transportation.

Segment thus indicates the maximum addressable area that can be
processed in one piece.

After the segment the foil is forwarded by hand to the correct position.

Sort before output

Sort means that all inner objects are processed before the outer objects and
that a sortation is done in x-axis-orientation. This switch takes care that the
foil is moved as little as possible in order to maintain the repeat accuracy as
high as possible. This option is especially necessary with cutters with friction
roll drive or when milling.
The output speed is slightly reduced with this setting.

Plot to file

This option does not lead the output of the data to the connected device but
opens a dialog in which the path and the name of an output file can be given
that will be saved to the hard disk.
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Read out automatically

This option can be activated if a device is connected and "online" and a read
out command for this device exists in the driver.

Output only tool-assigned layers

This option takes care that only objects are output where a tool assignment
to a layer was done.

please refer to 4.4: Tool Assignment Via Layer

Weeding border

This option defines if and with which distance a weeding frame is cut around
the output objects. This option facilitates the weeding of foil.

Overlap

It defines the overlapping of two segments. This value takes for example
care of the compensation for the shrinking that occurs with foils.

Copy spacing

Copy distance defines the distance of copies on the output medium.

Segment spacing

Segment distance defines the distance between single segments of a job.

Stack spacing

Stack distance defines if copies shall be stacked vertically. Requirement for
the activation of this option is that the selected object can be output more
than once on top of each other.

Indication: In the output-preview the first object is shown "normally".
Each further object of the stack is shown with a black square filled with
an X.

No tooltips

This option takes care that no tooltips that were entered in the device driver
are shown in the output dialog.

Enable output for objects larger than page size

This option causes objects to be passed to the output module that are larger
than the dimensions of the working area.
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5.7.1.7 The Import Setup

The setup import dialog is used to preset all import filters implemented in EuroCUT. The
settings are divided into 4 categories for the sake of clarity. Settings made in the General
tab apply to all import filter file formats listed in the left column. Default settings are
already activated. Settings other than the standard can be activated by clicking on the
respective file format tab. The filter-specific settings can be activated or deactivated as
required.

Fig. 5.7-4: Import dialog with closed category structure and import filter file formats

Fig. 5.7-5: Plus sign control

Fig. 5.7-6: Minus sign control

Fig. 5.7-7: Check control

A click on the plus sign control opens the desired category. A click on the minus sign
control closes the desired category. Clicking on the check control activates or
deactivates the corresponding option.
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Fig. 5.7-8: Import dialog with opened category structure - here: General tab active

5.7.1.7.1 The Settings

5.7.1.7.1.1 Job preparation

- Assume file name as job name

This option takes the name of the import file for the job file. This makes it easier to assign
source file to job file.

- Create new job

(Default: set) - When importing foreign data, the data is imported into a job without a name
(untitled.job).

and

- close active job

The active job is closed during import. This prevents the job history becoming very large
and confusing when importing many files.

5.7.1 The Standard Settings Menu
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- Load following palette:

Enabling this option allows you to load a color palette with the *.PAL file extension.

- Load following job template:

Enabling this option allows you to load a template with the file extension *.JTP.

5.7.1.7.1.2 Conversions

- Separate layers by name

When importing external data, it may happen that several layers have an identical color
value. If they are assigned different names, EuroCUT can separate them during import
and place the corresponding objects in separate layers.

- Insert objects at position

If this option is activated, it is possible to determine the position in X and Y in which the
data is stored on the work surface.

- Combine objects in the same layers

If this option is activated, all closed objects that are in the same layer are combined during
the import.

- Break Combinations

If this option is activated, all object combinations are exploded during the import, with the
result that only individual objects are available.

- Group all objects

If this option is activated, all objects are grouped during import. Advantage: The position of
the objects remains unchanged when the objects are moved because only one group
object is moved.

- Ungroup

If this option is activated, all object groups are broken during import.

- Rotate objects by the following angle:

The value specifies the angle at which the objects are rotated when they are imported.
Negative values are allowed.

- Drag'n Drop objects rotate at the following angle:

If objects are dragged to the EuroCUT work surface, they are rotated by the entered value
when released.
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- Scale objects by the following factor:

The value specifies the extent to which the objects are scaled, i.e. enlarged or reduced,
during import. Negative values are allowed.

- Mirror objects as follows:

This option allows the objects to be mirrored when they are imported: Possible settings
are: horizontal axis, vertical axis, both axes.

- Search / replace alignment marks in the following layers:

This option searches in the selected layer for vector objects that have the size of the
alignment marks (see Standard Settings / Register / Crop Marks / Size) and convert them
into alignment mark objects, that is, these objects get the object attribute: alignment
mark.

- Insert weeding frame:

This option adds a weeding frame around the imported objects. The distance is based on
the settings for the weeding frame.

5.7.1.7.1.3 Object properties

- Assign "Fixed object size"

If this option is activated, all imported objects are marked with the object attribute "fixed
object size"; Thus size change is deactivated

- Assign "Fixed object size at the output"

If this option is activated, all imported objects are marked with the object attribute "fixed
object size at the output". If this option is active, then no size compensation takes place
during output. The objects are placed and rotated only after the marks have been
imported.

- Assign "Do not move"

If this option is activated, all imported objects are marked with the object attribute "Do not
move". The Do not move option prevents the selected object from being moved. The
position is locked.

-  Keep object sorting

If this option is active, the object sorting is not changed during the import. The sequence of
objects will remain.

5.7.1.7.1.4 Edit objects
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- Reduce nodes

Enabling this option removes all superfluous nodes. The vector object is reduced by those
nodes whose removal does not influence the curve trajectory.

- Remove duplicate lines with the following tolerance automatically:

If this option is activated, all identical, overlapping lines are automatically removed.

- Automatically close objects with the following tolerance:

If this option is activated, all vector objects are automatically closed or connected during
import, whose distance from the start and end point is within the closing tolerance.

5.7.1.8 The Profile... Setup

The Profile... setup serves the customization of the desktop. The user or administrator
can adapt the EuroCUT interface to fit his needs or restrict it to its necessary amount. The
so defined user profile can be exported or be transferred - provided with a password
protection - onto other licensed client computers.

5.7.1 The Standard Settings Menu
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5.7.1.8.1 View

Design

The following options are possible: Black, Silver, Blue and Dark. Changes
are previewed directly in the dialog.

Menu Icons

Possible sizes are: Small, Medium and Large.

Toolbar Icons

Possible sizes are: Small, Medium and Large.

Password

Lock dialog with password Option

If this option is activated, this password will be requested when activating the profile
menu. This prevents unwanted or unintended changes to the view.

Note: Changing the view is now only possible with a known password.

5.7.1 The Standard Settings Menu
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5.7.1.8.2 Profile Management

Export Profile Button

Fig. 5.7-9: Save profile dialog with default path

Enabling of the Export Profile button allows saving of customize EuroCUT profiles. The
used file extension is *.EC7. As default *.EC7 files are saved in the folder, where the
program data are located.

Load Profile button

A click on this button opens the Windows Open dialog.

Note: If all menus or the settings menu were accidentally disabled, then access on
the profile resp. profile file is possible using the sytem menu. The system menu is
enabled with a click on the program logo, which you'll find left from the program
name in the program bar.

5.7.1.8.3 System Menu

A click on the icon in the upper left corner of the program window opens the following
dialog.

5.7.1 The Standard Settings Menu
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Fig. 5.7-10: System menu with Profile… sub menu

5.7.2 The Color Palette Command

With this command new color palettes can be created, loaded or saved.

Layer Numbers

If this option is active layer numbers are shown in the layer-toolbar.

Layer Info…

Opens the dialog for the setup of the layer toolbar. Here, you can define
which information is shown if the mouse cursor is positioned above a layer
color.

Possible information is: color-number, RGB values, CMYK values, material
name, mode/tool, material and amount objects. In addition, the amount of
visible layers and the width of the window can be set.

An „I”-button opens a window with shortcuts of the layer toolbar.

Layer Order…

This option opens a dialog for the modification of the layer order respective
the output order.

Only Sel. Layer Visible

If this option is activated only the objects lying in the selected layer are
shown on the working surface.

Delete Sel. Layer

Deletes the selected layer from the layer list.

Delete Unused Layers

This option removes all unused layers, all layers without objects and without
device connection.

5.7.2 The Color Palette Command
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New Palette

All color layers that have layer numbers bigger than 6 are removed. You use
this command if you want to define a new color palette individually. The
selection of the layer color is done by just selecting the desired color with
your mouse cursor and then activating the OK button.

Load Palette…

The previously defined palettes can be loaded.

Save Palette

With this command you save a newly defined or a modified standard palette
on your hard disk. If this new or modified palette is saved as default palette it
will be used at every new start of EuroCUT.

Save Palette As…

This command allows the new allocation of a palette name.

Default

This command loads the color palette that is delivered as standard with
EuroCUT. It is a Mactac foil color chart that was defined as default palette by
means of the color fan.

Palette History

This function facilitates the loading of the last 4 color palettes without the
detour via the file directory tree. At the end of the menu list of the color
palette menu the names of the last 4 edited color palettes appear. Click with
the mouse cursor on the desired palette name and thus open the selected
palette. 

5.7.3 The Control Panel… Command

This command activates the Windows control panel in order to make
possibly necessary modifications to the system parameters of Windows.
This especially refers to the installation of printers, drivers and the
configuration of serial interfaces (COM).

5.7.4 The Working Area… Command

5.7.3 The Control Panel… Command
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Fig. 5.7-11: Working area with shadows and rulers

Here, you can newly define the size and color of your working area. The
working area is displayed as a paper frame with a gray shade on the right
and bottom next to the frame (see figure above). The color of the working
area is freely definable; this guarantees an optimal layout control on the
screen.
Pre-defined are for example DIN-A-sizes. Besides the fix defined measures
you can define any number of user-defined working area. One can be
defined as standard. It will then be pre-set at every "file new".
This option is a very helpful function for everybody who has e. g. a milling or
an engraving machine as the new entry in each case of the usable area can
be omitted.

Indication: A double click on the shade right next and below the
working area also opens this dialog.

5.7.5 The Rulers… Function

With this function you define the positions where the rulers shall be
placed. Due to lack of space the display of the rulers can be
abandoned. With diametric display each 5th step is drawn longer and with
non-diametric each 2nd and each 4th once again.

SHIFT+I

5.7.4 The Working Area… Command
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5.7.6 The Unit of Measurement Function

This instruction switches the measuring unit to the preferred unit (mm, cm or
inch).

Indication: The metric can also be changed directly via a button that is
in the angle of both rulers.

5.7.7 The Grid… Function

This option shows either the grid itself or only the cross points of the
gridlines (raster) on the working surface. This function facilitates the
orientation and positioning of objects on the working surface.
The distance of the gridlines and the offset in X-/Y-orientation can be freely
defined. Reference point thereby is the left down corner of the working
surface. This point represents the 0/0-position to which the offset is added
up. A positioning assistance with "magnetic" influence takes care of the
accurate justification of the objects.

5.7.7.1 Distance and Start Position

- Spacing X

This value defines the distance of the grid from the edge of the working
surface related to the X axis.

- Spacing Y

This value defines the distance of the grid from the edge of the working
surface related to the Y axis.

- Offset X

This value determines the distance of the grid from the zero point of the
working surface in relation to the X axis.

- Offset Y

This value determines the distance of the grid from the zero point of the
working surface in relation to the Y axis.

Note: Negative values are allowed.

5.7.7.2 Settings

- Snap to grid Option

This option turns the magnetic function of the grid lines on / off.

CTRL+R

5.7.6 The Unit of Measurement Function
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- Grid on / off Option

This option makes the grid visible or invisible.

- Grid lines or Grid

This option switches between grid and grid lines view.

- Select color

This option allows you to specify the color of the grid. It is used to optically
separate the grid from the objects.

5.7.8 The Origin Function

This function shows a zero point (origin) in the lower left corner or the lower right corner of
the working area. It is used for orientation on the working area. Which view is preferred
depends mostly on the zero point of the connected machine. The view on the working area
then corresponds to the real conditions.

Fig. 5.7-12: Here: Origin bottom left

5.7.8.1 The Settings Origin Menu

Fig. 5.7-13: The Origin Options

5.7.7 The Grid… Function
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5.7.8.1.1 Setup...

Fig. 5.7-14: The origin dialog box

New Position (X / Y)

This option allows you to set the zero point using specific values.

X Field + Measuring Unit

In the X field, the absolute coordinate of the zero point on the X-axis can be specified.

Note: The unit depends on the setting of the ruler.

Y Field + Measuring Unit

In the Y field, the absolute coordinate of the zero point on the Y-axis can be specified.

Note: The unit depends on the setting of the ruler.

Display as Cross Option

If this option is activated, the origin point is represented by a dashed coordinate cross. If
the option is deactivated, the position of the zero point is only taken into account in the
rulers.

Bottom Left Option

This option places the zero point in the lower left corner of the working area. 

5.7.8 The Origin Function
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Bottom Right Option

This option places the zero point in the lower right corner of the working area.

5.7.8.1.2 Move

This command serves to move the ruler origin. The Move option activates a crosshair as
a mouse cursor. With the help of this, the zero point can be moved to any individual
position.

5.7.8.1.3 Reset

The Reset option returns the zero point to the original position (lower left or lower right).

5.7.8.1.4 Center to page

This command serves to move the origin point to the center of the working area (center of
page).

5.7.8.1.5 Center to selection

The Center to selection option sets the zero point to the position of the middle handle
located at the center of a selected object.

Note: This command is selectable only, if one or more objects are selected on the
desktop.

5.7.8.1.6 To selected node

The To selected node option sets the zero point to the position of a marked (selected)
node.

Note: This command is selectable only, if one or more objects are selected on the
desktop.

5.7.8.1.7 Display

This option displays the zero point or makes it invisible.

Note: Only visible, if the Display as Cross-Option is active.

5.7.8.1.8 Fix

This option makes the zero point moveable or fixes it at the current position. 

5.7.8 The Origin Function
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5.7.9 The Undo / Redo Command

With this instruction the undo / redo function can be switched on or off.

Advantages when undo / redo switched off:

With big or many objects the node processing is faster. The testing phase
(initial state -> edition -> temporary final state) with several processing
steps can be made undone as follows:
1. Switch off undo/redo, 2. edit objects and 3. switch on undo / redo

The selection of the undo function in the edit menu reestablishes the state
before point 1.

SHIFT+F7

5.7.10 The Cross-Hair Command

If you activate this option the cursor becomes a cross that reaches across
the whole width and length of the EuroCUT desktop. As soon as you move
the mouse cursor beyond the desktop (for example in order to select a
tool), it becomes an arrow again.

CTRL+F

5.7.11 The Guidelines… Function

Guidelines (subsidiary lines) are blue dashed orientation lines that you can
use as support for the construction. In addition, they facilitate the positioning
of graphic objects and text blocks on the working surface. Red dashed lines
are activated guidelines; They can be moved or rotated. Double-clicking on
a help line opens the guidelines dialog. The current working area width and
height are displayed for orientation and calculation.

Indication: If the positioning support is activated the help lines have a
"magnetic" effect on the objects coming close-by and allow the most
accurate positioning.

Type Area

In this area, 3 types of guide lines can be selected: horizontal, vertical and
diagonal.

Note: The guideline can be rotated using one of the nodes located at
the ends of the help line. The mouse cursor changes to a round arrow.
The rotation center can be moved as desired by mouse. The <CTRL>
key restricts the rotation to 15 ° increments.

Depending on the selected type, the Distance to lower edge of page, the
Distance to left edge of page and / or the Pivot position is additionally
queried. Negative values are allowed

H

5.7.9 The Undo / Redo Command
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The List Box

The Coordinates and Angles of all defined help lines are displayed in a list
box.

Copy Sel. Guideline

This option is used to quickly create a grid pattern. A guideline is selected
in the list box. The desired value is then entered in the Distance field. The
Copy button creates a new help line and adds it to the list.

Inserting Guidelines

Clicking on the Insert button adds a guide line at the X, Y value and / or
Angle. The coordinates and the degrees are added to the list box. The
dialog remains open until the OK button is clicked.

Modifying Guidelines

Clicking on the Change button changes the values of the selected guide
line to the value entered into the X, Y and / or Angle field.

Deleting Guidelines

A click on the Delete button deletes the selected guideline. Clicking the
Delete all button deletes all the guidelines that appear in the list box.

Note: Guidelines can also be deleted directly on the desktop by
selecting them and removing them with the <DEL> key. They can also
be pushed back into the ruler using the mouse.

5.7.12 The Snap Mode Function

The snap mode facilitates the creation of objects at the subsidiary lines. This
option activates the "magnetic" effect on graphic objects and text blocks.

P

5.7.13 The Lock Guidelines Command

With this option you can block all subsidiary lines so that they cannot be
marked or displaced anymore. Only by clicking once again on this menu
instruction the subsidiary lines are unlocked and can be displaced again.

CTRL+H

5.7.14 The Guidelines Visible Command

With this option you can make all subsidiary lines invisible. Only by clicking
once again on this menu instruction the subsidiary lines become visible
again.

SHIFT+H

5.7.11 The Guidelines… Function
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5.7.15 The Choose Language… Command

This option sets the language for user interface and help file.

5.7.15.1 Program Language

The user interface language is set here.

5.7.15.2 Language for the Help File

The language for the help is determined here.

5.7.15 The Choose Language… Command
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5.8 The Window Menu

5.8.1 The New Window Command

Activating this instruction opens a new EuroCUT window.

5.8.2 The Tile Horizontally Command

The activation of this instruction places all open windows diminished - one
above the other - horizontally.

5.8.3 The Tile Vertically Command

The activation of this instruction positions all opened windows diminished  -
side by side - vertically.

5.8.4 The Cascade Command

The confirmation of this instruction displays all windows diminished and
cascaded (diagonally displaced).

5.8.5 The Close Command

Clicking this instruction closes the momentarily active window after prior
safety query.

5.8.6 The Close All Command

Clicking this instruction closes all open windows after prior safety query.

5.8.7 The Standard Command

This command switches the tool-toolbar on the desktop or makes it
disappear.

CTRL+1

5.8.8 The Sidebar Command

This instruction switches the so-called Sidebar on or off. The Sidebar
contains several tabs (e. g. layer) and is normally displayed at the right
border.

CTRL+2

5.8 The Window Menu
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5.8.9 The Setup Command

This instruction switches the setup toolbar on the desktop or makes it
disappear.

CTRL+3

5.8.10 The Common Tools Command

This instruction switches the common tools toolbar on the desktop or
makes it disappear.

CTRL+4

5.8.11 The Text Command

This instruction switches the Text toolbar on the desktop or makes it
disappear.

CTRL+5

5.8.12 The Object Tools Command

This instruction switches the object tools toolbar on the desktop or makes it
disappear.

CTRL+6

5.8.13 The Object Parameters Command

This instruction switches the object parameters toolbar on the desktop or
makes it disappear.

CTRL+7

5.8.14 The Status Bar Object Info Command

This instruction switches the status bar object info toolbar on the desktop
or makes it disappear.

CTRL+8

5.8.15 The Status Bar Element Info Command

This instruction switches the status bar element info on the desktop or
makes it disappear.

CTRL+9

5.8.16 The Active Windows List

At the below part of the window menu instruction list all active jobs are
listed.

Indication: If more than 9 jobs are active it will be indicated by the
menu item: further windows.

5.8.9 The Setup Command

165



5.8.17 The Further Windows… Command

This instruction is only visible if more than 9 windows are active. A window
with a list of all active windows is opened. A click switches to the wanted
window.

5.8.17 The Further Windows… Command
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5.9 The Help Menu

5.9.1 The About … Command

The selection of this menu entry opens an info window in which various
information is shown. On the left part of the dialog among others the serial
number, version number, free disk space, co-processor, or type of processor
are shown. On the right down part of the dialog is a scroll window in which
all the application files of the respective application version are listed. This
file list can be printed via the print button.

Indication: If there should be problems with your EuroCUT version you
can fix them the fastest, if this list is made available to our support
staff.

5.9.2 The Help… Command

This option starts the EuroCUT help. F1

5.9.3 The Object Info… Command

The activation of this instruction opens an info window that contains
information about the objects on the desktop. These are among others the
number of objects, number of selections, vector objects, text blocks, all
groups and combinations or all bitmaps.

The selection button opens the object manager.

F10

5.9.4 The Install Autoimport Plug-Ins… Command

Enabling this command opens the Corun Installer window, that lists for
which programs plug-ins are available. Programs which were automatically
found are marked already. Select the target program for the intended data
exchange in the Eurosystems Software list field.

Pressing the Install button starts the installation.

please refer to 3.3.1: Corun Installer

5.9.5 The Online Support Command

The activation of this menu item establishes a direct internet connection to
the support page of the EUROSYSTEMS S.à.r.l. - www.eurosystems.lu.

5.9 The Help Menu
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5.9.6 The Remote Support… Command

Via remote control the content of the screen of a computer can be
transferred in realtime to another computer. Thus it is possible that two
users who are at different places look at the same desktop. While you are on
the telephone with our consultant (support) you can show each other
documents or applications even if you are far apart from each other in
reality. The direction of transmission respective line of vision can be
changed with a mouse click. Thus you can choose if you want to look
together at your screen or at the screen of your consultant.
In order to be able to use the remote support you need an active internet
connection.

5.9.7 The Live Update Command

This instruction activates a software update via internet.

Indication: Requirement is an active internet connection on the
computer where the software is installed.

5.9.6 The Remote Support… Command
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5.10 Context Menu Left Mouse Button

5.10.1 Context Menu Ruler

5.10.1.1 The Unit Button

A click on the Unit button activates one of the following context menus:

Note: Which of the two is enabled, depends on whether objects are selected on the
working area and what zero point setting is active.

 or 

5.10.1.1.1 Origin…

please refer to 5.7.8: The Origin Function

5.10.1.1.2 Move Origin

This command serves to move the ruler origin to any position on the desktop.

5.10.1.1.3 Reset Origin

This command serves to move the origin point into the lower left corner of the working
area.

5.10.1.1.4 Set Origin to Center of Page

This command serves to move the origin point to the center of the working area (center of
page).

5.10.1.1.5 Set Origin to Center of Selection

This command serves to mirror or place objects at the coordinate axis.

Note: This command is only visible, if one or more objects are selected on the
working area.

5.10 Context Menu Left Mouse Button

169



5.10.1.1.6 Hide Origin

This command serves to switch the ruler zero point to invisible.

5.10.1.1.7 Release Origin

This command serves to release the fixation of the ruler origin in order to move it with the
mouse.

5.10.1.1.8 Show Origin

This command serves to switch the ruler zero point to visible.

5.10.1.1.9 Fix Origin

This command serves to anchor the ruler zero point at a definite point.

5.10.1 Context Menu Ruler
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5.11 Context Menus Right Mouse Button

5.11.1 Reference List of All Context Menu Commands

Context menus are called context menus as its structure adapts and changes depending
on number and type of the selected objects (context). Context menus are always activated
via the right mouse button. They serve for the fast access to important functions and tools,
also to those that cannot be activated via the main menus.

Following menu entries displayed bold can appear in a context menu by clicking with the
right mouse button.

Draw modes "line, curve, digitize mode, freehand”

- in the mode “line”: arc, digi mode, freehand

- in the mode “curve”: line, digi mode, freehand

- in the mode “freehand drawing”: line, arc, digi mode

- in the mode „digitize“: line, arc, freehand

In addition, if the object has more than 3 nodes: - close

Clones

- Select clone original

- Select clone objects

In the output preview:

- Material optimization (if no demo and more than 1 object)

- Change axis, - hor. mirror, - vert. mirror, - recalculate (when segmenting), - segment
size (when segmenting), - horizontal weeding lines (if weeding frame), - vertical
weeding lines (if weeding frame), - weed border (if no copies)

If objects are not locked: - ungroup (if selection contains group), - group (if more than 1
object selected and no clone is selected)

Node editing if no locked objects are selected:

- Insert (if node selected), - delete (if node selected) - break (if 1 node selected and
another one is behind), - join (if 2 nodes selected (start/start or start/end or end/end)) -
line (if curve node selected), curve (if line node selected), - new starting point (if 1 node
selected and object closed)

If more than 1 node selected: - sharpen edge, - round, - join with line, - join with curve

5.11 Context Menus Right Mouse Button
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If 2 nodes are selected within an object or a combination: - hor. object alignment, - vert.
object alignment, - reduce nodes

If less than 2 nodes selected: - reduce nodes, - round..., - set origin to sel. node

Hatch module is installed:

If it was clicked within a closed object on selected or between 2 selected nodes: - start
tool path inside, - start tool path outside

Il 1 node selected & another is behind: - insert bridge (xy mm)

If more than 1 node selected: - create regmark at sel. nodes

If properties exist (job not protected by password):- properties

If plugin-version: - contour line

At application versions with text editor:

If not clicked on object, PhraseWriter exists and no node editing mode: - text
components

If text object selected or text in selected group or combination: and if sel. text can be
edited (no attribute „not edible“):- edit text, - textbox, - circular text...

If sel. text not locked: - cancel circular text (if text with circle set), - text to curves, -
text to lines (if text has several lines), - remove text attributes (if existing)

If ONE not locked bitmap is selected: - reduce colors, - posterize, - vectorize, -
revectorize (if possible), - contour

If ONE not locked closed vector-, combination- or text-object with bitmap-filling is selected:
- remove mask

or one of these object types lies above a bitmap: - mask bitmap, - cut region

If clone-original selected: - select clone objects otherwise if ONE clone selected: - select
clone original

If no rulers, not clicked on an object and not in the output-preview: - guidelines...

If guidelines are fixed: - release guidelines otherwise - fix guidelines

If guidelines are hidden: - show guidelines otherwise - hide guidelines, - delete all
guidelines, - insert guidelines to center of page, - origin..., - move origin, - reset
origin, - set origin to center of page

If origin is displayed: - origin otherwise - show origin

If origin is fixed: - release origin otherwise - fix origin

5.11.1 Reference List of All Context Menu Commands
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If not clicked on object: - refresh screen, - import, - insert, - job-info, - job-calculation, -
dimensions on selection, - hor. dimension, - vert. dimension, - hor. and vert.
dimensions, - left border distance, - bottom border distance, - left and bottom
border distance

If undo-buffer not empty: - Undo: <last action>

If redo-buffer not empty: - Redo: <last action>

If objects exist: - copy, - cut, - reverse selection

If export filter and exportable objects exist: - export

If Pjannto RIP is installed: - Pjannto RIP...

If PosterPrint is installed: - Posterprint-RIP...

If Posterjet is installed: - Posterjet...

If not locked objects exist: - add print marks

If nesting-DLL exists and sel. objects nested: - Nesting…

If group(s) selected: - ungroup

If more than one object and no clone-original selected: - group

If combination(s) were selected: - break combination

If combination has interior elements: - delete inner parts of combination

If more than one object and no bitmap or clone-original selected: - combine

If regmarks exist and if ONE mark and another object were selected: - center regmark
onto object

If several objects were selected: - search and replace regmarks

If only ONE object was selected: - search and replace regmarks due to sel. size

If objects selected but no group and no locked and not only ONE bitmap: - fill, - none, -
color graduation..., - bitmap..., - layer color

If Ini-entry „defaults“ / „transparency" on 1: - transparency...

If more than one object or an object with filling was selected:  - outline, - none, -
hairline, - attributes..., - layer color

If more than one object or an object with wire frame was selected: - layer color or at least
one not blocked object selected and Ini-entry „defaults“ / „transparency“ on 1:-
transparency...

5.11.1 Reference List of All Context Menu Commands
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If exportable objects are selected and the clipart window is opened: - add to clipart
category

5.11.2 Context Menu on Empty Working Area

Fig. 5.11-1: This menu appears if no objects lie on the desktop

Job Properties…

This command opens the following Job properties dialog:

Fig. 5.11-2: Job properties dialog with job infos

Do not sort during output

This option prevents, if activated, the objects being sorted before or during output. In other
words, the original object sorting is retained.

Note: If this option is activated, the "Do not sort during output" option located in the
output dialog is automatically deactivated.

Refresh screen

This instruction refreshes the active window.

5.11.2 Context Menu on Empty Working Area
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Import…

This menu entry opens the import dialog for the import of external file formats.

Insert

This menu entry inserts contents from the Windows clipboard to the EuroCUT working
area.

Working area

This menu entry opens the dialog for the pre-setting of the parameters of the working area.

Fit Page to Objects

This option scales the working area proportionally in relation to the object size.

5.11.3 Context Menu Text Block

Via the context menu of the right mouse button you have a fast access to the most
important text edition functions.

Fig. 5.11-3: The right mouse button context menu with text blocks

Textbox

The so called textbox comprises all text functions.

Detailed description: please refer to 8.2: The Textbox Dialog.

5.11.3 Context Menu Text Block
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Align

The option align opens a menu with the following sub-functions.

Fig. 5.11-4: Text alignment-submenu of the context menu

Via the alignment-function you determine how your text shall be aligned. Each text line
can be aligned differently. Mark your text line and select the wanted line alignment from
the list.

Attention: only possible in the textbox!

Detailed description: please refer to 7.3: The Text Editor Toolbar.

Case sensitive

Fig. 5.11-5: Uppercase / lowercase submenu of the context menu

Uppercase / lowercase

Mark the letter(s) that shall be written in "CAPITAL" or "small" letters by keeping pressed
the left mouse button and draw it above the wanted area. Now open the right mouse menu
by clicking once the right mouse button and select the function that shall be used on the
marked text.

You can reverse the operation by activating the menu item reverse uppercase /
lowercase.

Small capitals

Small capitals in the typography are capital letters in x height. X-height means the height
of the lowercases, especially the height of the small x. Open the right mouse menu by
once pressing the right mouse button and select the menu item Capital. The marked text
will be changed to small capitals.

5.11.3 Context Menu Text Block
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Load text block

Fig. 5.11-6: Load text block dialog window with import format list

Save text block as

Fig. 5.11-7: Save text block as dialog window with export format list

Text database

This menu entry is without function.

Line spacing

5.11.3 Context Menu Text Block
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Fig. 5.11-8: Dialog for the setting of the line spacing

The line spacing indicates the distance between the two base lines. It can be given in
millimeters, centimeters, inch, dots or percent. 

Indication: The %-setting is the indication referring to the cap height. The value
always refers from the current (where the text cursor is) to the previous line and
there from the base line to the base line.

If more than 2 lines are marked the set line spacing is applied to all marked lines. If the
distance between line 1 and 2 shall be different to the one between line 2 and 3, first line 1
and 2 must be marked and the respective line spacing must be set. Then, line 2 and line 3
must be marked and again the wanted line spacing must be entered. 

Fig. 5.11-9: Example for line spacings - here same line spacings

Word spacing

Fig. 5.11-10: Dialog for the setting of the word spacing

With this value you define the distance between two adjacent words in millimeters,
centimeters, inch, dots or percent from the normal-space. If the distance between word 1
and 2 shall be different to the one between 2 and 3, word 1 and 2 must first be marked

5.11.3 Context Menu Text Block
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and the respective spacing entered. Then word 2 and 3 must be marked and again the
wanted word spacing must be set.

Indication: If more than 2 words are marked, the set word spacing is applied to all
marked words.

Fig. 5.11-11: Example for word spacings

Character spacing

Fig. 5.11-12: Dialog for the setting of character spacing

The character spacing determines how far the single characters of your text are from
each other.

Indication: 100% corresponds to the defined Kerning-values.

Values below 100% compress the text and decrease the tracking of the text. Values above
100% stretch the text and increase the tracking of the text. In addition to the %-indication
the indication can also be done in millimeter, centimeter, inch or dots.

Fig. 5.11-13: Example for the character spacing

Angle of rotation

Fig. 5.11-14: Dialog for the setting of rotation angles of text characters

The angle of rotation determines how much the marked text shall be rotated. Values
between 0° and 360° can be entered.

Indication: If the text cursor is within the range of the rotated letters, words or
characters, it will be continued to be written with this rotation angle.

Fig. 5.11-15: Example for rotated letters

5.11.3 Context Menu Text Block

179



If letters are rotated, depending on the Kerning of the font type, unaesthetic transitions can
occur which then can be adjusted via the function character spacing.

In the previous illustration you can see that after the rotation the rotated text collides with
the "o". Mark the „o” and the rotated text and change the character spacing of the marked
text in that way that the overlappings are eliminated.

Moving character

Fig. 5.11-16: Dialog for the setting of the movement parameters with text characters

In this dialog the incrementation of the character movement, horizontal and vertical, can
be set.

How are characters, words or whole lines within a text block moved interactively?

If the text cursor is in a line and the CTRL-button is pressed and kept pressed, the line can
be moved upwards or downwards by pressing the respective arrow keys.

If the text cursor is before the first letter in a line and the CTRL-button is pressed and kept
pressed, the line can be moved to the left or right by pressing the respective arrow keys.

If the text cursor is in a line and the CTRL-button is pressed and kept pressed, the part of
the line which is behind the cursor can be moved to the left or right by pressing the
respective arrow keys.

If the text is marked, the CTRL-button is pressed and kept pressed, the marked text can
be moved to the direction in which the arrow is pointing by pressing the arrow keys.

Delete text attributes

5.11.3 Context Menu Text Block
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Fig. 5.11-17: Setup dialog for deleting text attributes

With this dialog font attributes that were inserted via the text tools can be deleted again.

Indication: This dialog can be called up for any text block.

5.11.4 Context Menus Node Editing

Systematics of the menu structure:

If no locked objects are selected: - insert (if node selected), - delete (if node selected) -
break (if 1 node selected and another one is behind), - join (if 2 nodes selected (start/start
or start/end or end/end)) - line (if curves-node selected),- curve (if line-node selected), -
new starting point (if 1 node selected and object closed)

If more than 1 node was selected: - sharpen edges, - round edges, - join with line, -
join with curve

If 2 nodes within an object or a combination are selected: - hor. object alignment, - vert.
object alignment, - reduce nodes

If less than 2 nodes are selected: - reduce nodes, - round..., set origin to sel. node

5.11.4 Context Menus Node Editing
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The menus in the graphical display

Fig. 5.11-18: 1 node selected

Start tool path inside or start tool path outside

A start tool path is used in the milling, graving and laser processing. The immersion point
of the tool is moved from the original starting point from inwards or outwards. The
advantage is that at the later output object no "immersion traces" are visible. Depending
on the turning direction and arrangement of the object the start tool path is set inwards or
outwards. The parameters for the start tool paths are set in the tools-menu.

Create regmark at sel. nodes

This option takes care that a regmark is created at the selected node.

Fig. 5.11-19: 2 nodes selected

5.11.4 Context Menus Node Editing
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Sharpen edge CTRL+S

This function combines two nodes with two „smooth“ lines. Nodes that lie between the two
marked nodes are deleted!

Fig. 5.11-20: Example for sharpen edge - filled with black the marked nodes

Indication: If one of the selected nodes lies at an edge the original angle is kept.

Round edge CTRL+R

Fig. 5.11-21: Example for round edge - filled in black the marked nodes

In the above illustration you can see that the „G” in the outer left area must be revised. To
do this, the nodes above and below the "error" are marked. If now the round
edge-function is activated the nodes that lie between the marked nodes are deleted and
the two dots are connected with a curve.

5.11.4 Context Menus Node Editing
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Join with line CTRL+G

The two selected nodes are connected with a line. Nodes that lie between the marked
nodes are deleted.

Fig. 5.11-22: Example Connect with line

Join with curve CTRL+K

The two selected nodes are connected with a curve. Nodes that lie between the marked
nodes are deleted.

Fig. 5.11-23: Example connect with curve

Hor. and vert. object alignment CTRL+H
or CTRL+V

The object in which the nodes are selected are aligned at the horizontal respective
vertical.

Fig. 5.11-24: Example for aligning object horizontally relative to the selected (filled with
black) nodes

5.11.4 Context Menus Node Editing
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Fig. 5.11-25: Example for aligning object vertically relative to the selected (filled with black)
nodes

Reduce nodes … R

The parameter reduce nodes dialog appears in which following settings can be done:

Fig. 5.11-26: Dialog for the settings of the accuracy of the node reduction

Precision

This value influences the conversion of lines to Bezier-curves. The higher the discrepancy
the less curve instructions are needed in order to clone the initial line of curves.

Create curves when angle greater than … °

If at a node the angle of the lines is smaller than this limiting value the line of curves is
interrupted at this node.

Create line if difference smaller than … °

If a curve is created who"s bending lies within the tolerance value it is converted to a line.

5.11.4 Context Menus Node Editing
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Node selection

Select next node TAB

Select next node additionally SHIFT+TAB

Select previous node Back

Deselect last selected node SHIFT+Back

Interactively round edges respectively sharpen edges

If you click with the mouse on a line of curves with the CTRL-button pressed on one, the
node will be inserted at this position. This node serves for marking the rounding position. If
the second node is selected you can sharpen, round or any other node edition function
can be carried out.

5.11.4 Context Menus Node Editing
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6 Reference Part Output Preview

6.1 The Output Menu

6.1.1 The Output Command

Starts the output on the connected device with the settings of the output to device
dialog.

6.2 The Options Menu

6.2.1 The Save As… Command

The save as… command in the output preview ... saves the job
with all changes that were done in the preview. When returning to
the working surface all these settings would be lost, therefore, the
job can here be saved under another name.

please refer to 5.1.6: The Save as… Command

SHIFT+CTRL+S

6.2.2 The Rotate Axis Command

This command rotates the marked objects at 90° counter-clockwise.

please refer to 5.3.1: The Rotate Axis Command A

6.2.3 The Horizontal Mirror Command

The selected object is mirrored at the horizontal through its center-point.

please refer to 5.3.3: The Horizontal Mirror Command X

6.2.4 The Vertical Mirror Command

The selected object is mirrored at the vertical through its center-point.

please refer to 5.3.4: The Vertical Mirror Command Y

6.2.5 The Optimization… Command

The foil optimization takes care that all objects are arranged in a way that they take the
least space on the foil. By rotation or no rotation of objects it is taken care of, that the
material waste can be decreased.
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please refer to 5.5.10: The Box Nesting… Function
please refer to 4.11.1.1: Material optimization

6.2.6 The Sort With Simulation… Command

This command opens the sort objects function with which the output
order and the direction of rotation can be defined. The sortation can de
done dependent or independent on layer. Also, the preferred direction of
the sortation can be defined.
In a preview window the output of the objects is simulated graphically;
here, the traverse paths of the tool head can also be drafted. The
simulation can be done unlimited without changing the original objects.  

CTRL+F10

please refer to 5.3.18: The Sort With Simulation… Command

In detail: please refer to 8.6: The Sort with Simulation… Tool

6.2.7 The Recalculate Command

The recalculate command enables the modification of the
output-parameters or of the driver settings without leaving the output routine.

This command switches back from the output preview to the output dialog.

N

6.2.8 The Initial View Command

Puts back the output preview to the status before having pressed the
preview button in the output dialog. All changes are made undone. 

SHIFT+N

6.2.9 The Horizontal Weeding Lines Command

Weeding lines serve for the better processing of big jobs. Material lengths of
several meters in length or width are difficult to handle, therefore you can
insert weeding lines during the foil cutting that divide the job into smaller
parts that are easier to handle.

The horizontal weeding lines are set with the hotkey "h" or drawn with the
arrow from the weeding frame dashed in blue.

please refer to 4.11.1.2: Weeding lines

H

6.2.10 The Vertical Weeding Lines Command

Weeding lines serve for the better processing of big jobs. Material lengths of
several meters in length or width are difficult to handle, therefore you can
insert weeding lines during the foil cutting that divide the job into smaller

V

6.2.5 The Optimization… Command
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parts that are easier to handle.

The vertical weeding lines are set with the hot key "v" or drawn with the
arrow from the weeding frame dashed in blue.

please refer to 4.11.1.2: Weeding lines

6.2.11 The Test Drive Command

If the test drive command is activated the connected device goes with lifted tool head
along the weeding frame. This also happens if the option "weeding frame" was not
activated.

Compare test drive button in the output dialog please refer to 4.5.3: Start Output
from the EuroCUT Working Surface

6.3 The View Menu

6.3.1 The Material Width Command

When activating this command the section is adjusted to the values for the
material width defined in the driver or set in the output dialog.

B

6.3.2 The All Objects Command

This function changes the display in that way that all objects can be seen on
the screen. The section is selected so that it is the biggest possible display
showing all objects.

If the SHIFT key is pressed while activating this command, only the selected
objects are zoomed to maximum.

F4
and

SHIFT+F4

6.3.3 The Selected Objects Command

If this command is activated only the selected objects from the output
preview are displayed as large as possible.  

SHIFT+F4

6.3.4 The Total Area Command

If this menu item is activated the preview of the whole material surface is
shown.
The size of the shown surface depends on the so called frame size (foil
height x foil width) of the output device to be accessed.
If in the output dialog a driver for a friction feed cutter was selected, in the
preview always a material length of 30m (32,81 yd) is shown. 
If in the cutting dialog a driver for a flatbed cutter was selected, the
maximum width of the flatbed cutter is shown as material length.

SHIFT+B

6.2.10 The Vertical Weeding Lines Command
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6.4 The Window Menu

6.4.1 The New Window Command

Activating this instruction opens a new EuroCUT window.

6.4.2 The Tile Horizontally Command

The activation of this instruction places all open windows diminished - one
above the other - horizontally.

6.4.3 The Tile Vertically Command

The activation of this instruction positions all opened windows diminished  -
side by side - vertically.

6.4.4 The Cascade Command

The confirmation of this instruction displays all windows diminished and
cascaded (diagonally displaced).

6.4.5 The Close Command

Clicking this instruction closes the momentarily active window after prior
safety query.

6.4.6 The Close All Command

Clicking this instruction closes all open windows after prior safety query.

6.4.7 The Common Tools Command

This instruction swithes the Common Tools toolbar on or off. CTRL+4

6.4.8 The Object Parameters Command

This instruction switches the object parameters toolbar on the desktop or
makes it disappear.

STRG+7

6.4.9 The Status Bar Object Info Command

This instruction switches the status bar object info toolbar on the desktop
or makes it disappear.

CTRL+8

6.4 The Window Menu
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6.4.10 The Status Bar Element Info Command

This instruction switches the status bar element-info on the desktop or
makes it disappear.

CTRL+9

6.4.11 The Active Windows List

At the below part of the window menu instruction list all active jobs are
listed.

Indication: If more than 9 jobs are active it will be indicated by the
menu item: further windows.

6.4.12 The Further Windows… Command

This instruction is only visible if more than 9 windows are active. A window
with a list of all active windows is opened. A click switches to the wanted
window.

6.5 The Help Menu

6.5.1 The About … Command

The selection of this menu entry opens an info window in which various
information is shown. On the left part of the dialog among others the serial
number, version number, free disk space, co-processor, or type of processor
are shown. On the right down part of the dialog is a scroll window in which
all the application files of the respective application version are listed. This
file list can be printed via the print button.

Indication: If there should be problems with your EuroCUT version you
can fix them the fastest, if this list is made available to our support
staff.

6.5.2 The Help… Command

This option starts the EuroCUT help. F1

6.5.3 The Install Autoimport Plug-Ins… Command

Enabling this command opens the Corun Installer window, that lists for
which programs plug-ins are available. Programs which were automatically
found are marked already. Select the target program for the intended data
exchange in the Eurosystems Software list field.

Pressing the Install button starts the installation.

6.4.10 The Status Bar Element Info Command
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please refer to 3.3.1: Corun Installer

6.5.4 The Online Support Command

The activation of this menu item establishes a direct internet connection to
the support page of the EUROSYSTEMS S.à.r.l. - www.eurosystems.lu.

6.5.5 The Remote Support… Command

Via remote control the content of the screen of a computer can be
transferred in realtime to another computer. Thus it is possible that two
users who are at different places look at the same desktop. While you are on
the telephone with our consultant (support) you can show each other
documents or applications even if you are far apart from each other in
reality. The direction of transmission respective line of vision can be
changed with a mouse click. Thus you can choose if you want to look
together at your screen or at the screen of your consultant.
In order to be able to use the remote support you need an active internet
connection.

6.5.6 The Live Update Command

This instruction activates the update of the software via the internet.

Indication: Requirement is an active internet connection on the
computer where the software is installed.

6.6 Context Menu of The Right Mouse Button

6.6.1 Context Menu Output Preview

Fig. 6.6-1: Context menu of the output preview with weeding frame function

Weed border

This function creates a weeding frame around the selected objects in the output preview
unlike the weed border option.

All other menu entries can be activated via the main menu.

6.5.3 The Install Autoimport Plug-Ins… Command
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7 Toolbars

7.1 The Standard Toolbar

The standard toolbar is switched on or off via the window menu. CTRL+1

Fig. 7.1-1: Freely placeable toolbar - Collection of standard tools

Fig. 7.1-2: Fixed standard toolbar

BUTTONS FROM 1 TO 15

1. Create New window 9.  Print objects
2. Open job 10. Import file
3. Save job 11. Export objects
4. Save all 12. Scan image
5. Edit job info 13. Undo
6. Cut to Clipboard 14. Redo
7. Copy to Clipboard 15. Help
8. Paste from Clipboard

7.2 The Setup Toolbar

The setup toolbar is switched on or off via the window-menu. CTRL+3

Fig. 7.2-1: Freely placeable setup toolbar

Fig. 7.2-2: Fixed setup toolbar

BUTTONS FROM 1 TO 5

1. Cross-hair on / off
2. Rulers on / off
3. Contour view on / off
4. Grid on / off
5. Setup working area

Indication: Alternatively the working area also can be defined by double clicking on
shades of the working area!
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7.3 The Text Editor Toolbar

Fig. 7.3-1: The text toolbar

Font Type

Here, you select the font by means of the name. You first mark the text by sweeping
above the wanted part of the text with the left mouse button kept pressed or by moving the
text cursor above the wanted part of the text with the arrow keys with the SHIFT key
pressed. If the whole text shall be marked simply press the shortcut CTRL+A.

Indication: A double click in the text input line (cursor field) marks the whole text
block.

Change Font Database

Fig. 7.3-2: Font database usage with 4 activated font formats

All in the Fontmanager activated font databases are listed here. The following 4 font
formats are implemented:

Windows TrueType fonts - That are all TrueType fonts, which are activated in
Windows.

1. 

Windows Adobe Type 1 fonts - That are all Type 1 fonts, which are activated
in Windows.

2. 

Standard (Adobe Type 1) - That are all Type 1 fonts, which are activated in
Fontmanager's standard database.

3. 

URW / BE Font database - That are all Ikarus BE fonts, which are activated in
Fontmanager's BE database.

4. 

7.3 The Text Editor Toolbar

194



Indication: All font formats, which are activated here (check = yes) are displayed in
the EuroCUT Basic 8 font selection list and can be used.

Font Size

In the input box font size you enter the height of capital letters (cap height). Directly next
to it you determine the measuring unit to be used.  Here, following units are available:
millimeter, centimeter, inch and points.

Space (1/1, 1/2, 1/4, 1/8)

Key  –  CTRL  SHIFT  SHIFT+CTRL
SPACE  1/1

em
 1/2 em  1/4 em  1/8 em

Font Weight

The font weight of a font is selected via one of the four buttons. You can select between
normal, bold, italic or bold-italic.

Indication: There are font types that have less than 4 weights. The buttons then are
displayed in gray and cannot be activated.

Subscript

A subscript text is a text that is displayed a little bit lower than the rest of the text in a row.
Subscript characters are often used in scientific formulas.

Example: y2, the 2 shall be subscript: Result: y2

Superscript

A superscript text is a text that is displayed a little bit higher than the rest of the text in a
row. Also superscript characters are often used in scientific formulas.

Example: x to the 2, the 2 shall be superscript: Result: x2

Alignment

Via the alignment-function you determine how your text shall be aligned. Each row can be
aligned differently. Mark your text row and select from the list the wanted row alignment.

Indication: When forcing justification each row is to be terminated with the ENTER
key. The character spacing will be increased so that the maximum length of each
row is reached. 
Attention: With the option justification the single rows must not be terminated with
the ENTER key. Here, the word spacing is adjusted in that way that the text
alignment will be justified left and right.

7.3 The Text Editor Toolbar
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Adjust Height of Caps

The adjust height of caps option takes the maximum length and increases or decreases
the font size accordingly. The cap height is not shown numerically after the modification
any more. But it can be checked with the measure-tool.

After the activation of the T button in the tool toolbar, via the text menu and here the menu
item enter text or the shortcut T a mouse pointer appears in the form of a capital „T” on
the screen. If now the ENTER key is pressed the text input can be made. The exact
position of the text is determined by you by positioning the tip of the mouse cursor on the
spot where the text shall be inserted.

No Line Feed - Reduce Line Height

If this option is activated no line feed is initiated that results from the maximum length but
when excessing the maximum length the row height is decreased. This is especially useful
with the serial number-function.

No Line Feed - Fit All Line Heights

If this option is activated no line feed is initiated the results from the maximum length but
when excessing the maximum length the row height of all text blocks is decreased. This is
especially useful with the serial number function.

Max. Width

The value in the field max. width indicates when the new line in a text row occurs.

Textbox

Klicking the T button opens the so called textbox. The textbox allows editing texts,
defining tabulators, parameterizing of circular text and selecting special characters from a
character table.

7.4 The Node Toolbar

Fig. 7.4-1: Freely placeable node toolbar - collection of node editing tools

Indication: The object parameters toolbar (shown below) is switched over to the
node toolbar while activating node mode. This happens either by double clicking a
node or by clicking node editing button in the common tools toolbar.

Fig. 7.4-2: Freely placeable toolbar - collection of all object parameters

7.4 The Node Toolbar
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Tip: The functions of the node edition that are used the most can be called up via
the right mouse button. The allocation of the right mouse button changes,
depending if one or several nodes are marked. In detail: please refer to 5.11.4:
Context Menus Node Editing

Indication: You select several nodes by keeping pressed the SHIFT key and by
clicking with the left mouse button on the nodes that you want to mark one after
another.

Round button U

Fig. 7.4-3: Round dialog of nodes

The following setting possibilities are available in the round dialog:

Rounding Inside

If this button is activated only the selected nodes or the whole object are rounded inside
at the given radius depending on the option selected in the dialog.

Rounding Outside

If this button is activated only the selected nodes or the whole object are rounded
outside at the given radius depending on the option selected in the dialog.

Reduce nodes button R

Reduce nodes

If this button is activated in the node edition all redundant nodes are removed which
means the object is reduced of those nodes whose removal does not influence the course
of the curve.

Attention: The node reduction always refers to the whole object.

7.4 The Node Toolbar
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Fig. 7.4-4: Settings dialog for the node reduction

Symmetric node button Y

With the instruction symmetric node the tangents are created symmetrically which means
that both tangents form a line and the check points on both ends have the same distance
to the node dot.

Sharp node button P

With the instruction sharp node the symmetry and smoothing of a node is removed again.
After that, each tangent can be modified. The display of the curve does not change at first.

Smooth curve button Ä

With this option the tangents of a curve are modified in that way that they form a line.
Always the minimum possible modification of the tangents is selected for this. At the
position where a line passes into a curve this instruction adapts the tangent exactly to the
line.

The advantage of the smooth curve instruction is that the transition from curves to lines
and the course of the curve is done smoothly. When cutting later unaesthetic offsets are
thus avoided.

Indication: If on both sides of the dot to be edited there are lines this instruction is
not available. When moving tangents both tangents of a curve node loose their
symmetric alignment to one another. With the smooth curve-instruction they are
turned into a line again.

New origin button S

If you want to mill it is important for you to know where the milling cutter starts respectively
where the tool first dips into the material to be edited. The origin nodes are marked by a
square with an additional contour. This option moves the origin to the previously
marked node dot.

7.4 The Node Toolbar
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Open node button T

This option creates open objects. Mark the node dot to be separated and then activate the
open node button.

Join nodes button N

With this function you can combine open objects with each other. Click with the node
cursor on the first node dot. Press the SHIFT keyand mark now the second node dot.
Marked node dots are / will be filled with black and the status row indicates how many
objects are marked respective selected. At the end, activate the join nodes button and the
object will be closed.

Tip: A second possibility for marking node dots is using the marking function. For
marking, draw a frame around the wanted dots with the left mouse button pressed.

Indication: The connection is only possible if two nodes are marked that are both
end points of an open object.

Delete nodes button Del

This option deletes the node dot that was previously marked.

If it is an end point of an open object the two adjoining node dots are connected with a line
if on one or both sides of the deleted node dots were curves. The node dots are connected
to a line if on both sides of the deleted node were lines.

Indication: You delete a marked node dot the fastest with the DEL key on your
keyboard.

Insert node button I/Ins

To insert node dots you move the node cursor to the spot on the wire frame of the object
where the new node shall be inserted. Then you activate the insert node button.

Indication:  CTRL - click inserts a node directly at the desired position.

Connect with curve button K

This option changes lines to curves with tangents.

Connect with line button G

This option changes curves to lines.

Indication: All information of the curve is lost.

Start Tool Path inside button

This option inserts a so called start tool path inside at the selected node. (Special
function for routers and lasers).

7.4 The Node Toolbar
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Start Tool Path outside button

This option inserts a so called start tool path outside at the selected node. (Special
function for routers and lasers).

Align nodes horizontal button H

This option aligns the selected nodes in the horizontal. With a doubleclick on a node - gets
red - can be determined by which node is to be aligned.

Align nodes vertical button V

This option aligns the selected nodes in the vertikal. With a doubleclick on a node - gets
red - can be determined by which node is to be aligned.

Alignment buttons

This function aligns the node dots horizontally or vertically accurately.

Mark at least two node dots that shall be aligned accurately and double click on the
reference dot. The reference dot is the dot to which shall be aligned. 

Arrange horizontally button
H

This function aligns node dots horizontally.

Arrange vertically button
V

This function aligns the node dots vertically.

Orthogonalize button
E

A further possibility to align nodes is to align corners. This function balances nodes that
are almost vertical or horizontal to their predecessor or successor nodes. Orthogonalize
is a combination of align horizontally and vertically. This way, right angles can be fast
created.

Fig. 7.4-5: Align corners - before / after

The previous illustration shows the method of operation of the ortthogonalization. In the
left illustration you can see the square in the original state. The down left corner is
selected, the node toolbar is opened by a double click on this corner. The marked node
will be aligned horizontally and vertically to its adjoining nodes. This way, a right angle is
created. The result can be seen in the right illustration.

7.4 The Node Toolbar
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7.4.1 Direct Input of Coordinates of Node Positions

Position (mm) - horiz.(ontal) and vert.(ical)

In the node toolbar section position node dots can be positioned through the input of their
X or Y-coordinates. With this positioning you differentiate between absolute and relative
values.

Absolute values

With the input of absolute values the entered values are allocated to the selected node.

Relative values SHIFT

With the input of relative values the selected node is moved at the given coordinate value
in horizontal and vertical direction relative to the selected node which means the entered
and original coordinates are added.

Method of operation:

You first enter the wanted coordinates and keep pressed the SHIFT key while activating
the move button.

Horizontal / vertical restriction when drawing lines and curves CTRL

With the CTRL key pressed lines can be restricted vertically or horizontally which means
that the movement of the line is only possible in one direction.

Fig. 7.4-6: Restricted drawing of nodes resp. lines

When drawing curves the curve is deformed. The deformation depends on the selected
contact point as you can see in the following illustration.

Fig. 7.4-7: Restricted drawing of curves

Indication: The node attribute smooth is automatically saved if the selected and

7.4.1 Direct Input of Coordinates of Node Positions
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following nodes are a curve.

Tip: The zoom functions are also active in the node editing mode.
Radius

In the window right next to the buttons mentioned above the radius with which the node or
nodes shall be rounded can be set.

Narrow objects

Here, you can select between two options:

If the option use smaller radius is selected EuroCUT calculates the radius that still is
applicable for the rounding of this narrow object.

When selecting the do not round -option it is not rounded with narrow objects.

7.4.1 Direct Input of Coordinates of Node Positions
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7.5 The Object Tools Toolbar

The Object Tools toolbar is switched on or off via the WIndow menu. CTRL+6

Indication: Depending on the used EUROSYSTEMS software some of the listed
tools can be missing (n. a.).

Fig. 7.5-1: Freely placeable toolbar - collection of objcet tools

Fig. 7.5-2: Anchored toolbar

BUTTONS FROM 1 TO 21

1. Delete Objects 12. Open Objects
2. Do Axis Change with Objects 13. Round Objects
3. Horizontal Mirror of Selected Objects 14. Delete Redundant Nodes
4. Vertical Mirror of Selected Objects 15. Vectorize Objects
5. Group Objects 16. Generate Contour Line
6. Ungroup Objects 17. Start Foil Optimization
7. Combine Objects 18. n. a.
8. Release Combination of Objects 19. n. a.
9. n. a. 20. Generate Out- or Inlines
10. Align Objects 21. Weld Objects
11. Close Objects

7.5 The Object Tools Toolbar
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7.6 The Object Parameter Toolbar

Fig. 7.6-1: Freely placeable toolbar - collection of object parameters

Fig. 7.6-2: Object parameters toolbar with explanations

7.6.1 The Multi Copy Command

Definition: Multi Copy = Multiple copies of selected objects (Duplicates)

7.6.1.1 The Multi Copy Button

Pressing the button opens the following dialog:

7.6.1.2 Copies X:

Using the  or  button the number of duplicates can be increased or decreased in
increments of one. The alignment is done in the Main Direction. Alternatively, any integer
value may be entered in the field.

7.6 The Object Parameter Toolbar
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7.6.1.3 Copies Y:

Using the  or -button the number of duplicates can be increased or decreased in
increments of one. The alignment is done in the Main Direction. Alternatively, any integer
value may be entered in the field.

7.6.1.4 Offset X:

This value determines the distance between the duplicates in X-Axis direction.

7.6.1.5 Offset Y:

This value determines the distance between the duplicates in Y-Axis direction.

7.6.1.6 The Select Objects Option

If this option is enabled, all duplicates will be selected finally. 

7.6.1.7 The Fill Working Area Option

If this option is enabled, then the working sheet only and not the desktop is filled with
duplicates.

Note: Enabling this option, de-activates the Copies X and Copies Y fields.

7.6.1.8 The Create Clones Option

If this option is enabled, then the selected object is uses as control object for cloning. All
duplicates are generated as clone objects.

7.6.1.9 The Group Result Option

Enabling this option groups all duplicates finally.

7.6.1.10 The Optimize Traverse Path Option

If this option is enabled, duplicates are generated in meanders. This reduces the head
movement of the output device and shortens the output process.

Note: The main direction option defines additionally, if meandering is done in X-Axis
or Y-Axis direction.

7.6.1.11 The Main Direction Option

The  button sorts the duplicates in Y-Axis direction - "column by column". The
-button sorts the duplicates in Y-Axis direction - "line by line".

7.6.1 The Multi Copy Command
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7.7 The Status Line Object Info

This status line informs about the properties and attributes of objects on the EuroCUT
desktop. This information comprises number, type of object, color model, color value and
many other data important for the evaluation. 

Fig. 7.7-1: Status line for the display of object properties, color spaces , etc. - free floating

Fig. 7.7-2: Status line for the display of object properties, color spaces, etc. - fixed

7.8 The Status Line Element Info

This status line indicates the current mouse cursor position in x/y-coordinates. In addition,
in the left part next to the cursor coordinates subsidiary texts and additional texts from the
layer info for example from the field material name are displayed. It is also possible to
show driver information as for example the set tool depth for a particular layer.

Fig. 7.8-1: Status line element with subsidiary texts and element information, here
coordinates

7.9 The Preview Tools Toolbar

The Arrow Tool

This mode allows you to mark, move, group temporarily (marking function)
and modify the size of objects in the output preview.

SPACE

The Magnifying Glass+

The button with the (+) plus sign increases parts of the output preview. Draw
with the marking function a frame around the area that shall be increased.
This function can be carried out successively several times until a beep
reminds acoustically of the last possible step.

F2
or

+(Num)

The Magnifying Glass–

The button with the (-) minus sign decreases gradually parts of the desktop
or of the working area.

F3
or 

-(Num) 

The Sheet  B

7.7 The Status Line Object Info
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The button with the symbolic sheet of paper shows the material area
increased to the maximum

The Screen

The button that symbolizes a screen displays all objects on the material area
as big as possible. The section is thus selected that is it the biggest possible
display with all objects visible.

 F4

The Magnifying Glass for Selected Objects

The „dotted loupe” button displays all selected objects as big as possible.

SHIFT +
F4

The Measure Tool

This tool serves for the determination and the percental modification of
object dimensions.

 M

The Output Command

The activation of this button gives the data to the Plot-Manager for the
output to the connected device.

 S

7.9 The Preview Tools Toolbar
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7.10 The Preview Object Parameters Toolbar

The preview object parameters toolbar is activated with the following
shortcut.

CTRL+7

Indication: It is identical with not variable part of the object parameters toolbar in
previous EuroCUT versions.

Fig. 7.10-1: Object parameter toolbar with position, size, angle, multi copy, …

Note: The display of the object parameters toolbar varies depending on how the
object properties are set!

7.10 The Preview Object Parameters Toolbar
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8 Tools

8.1 The Desktop

After starting EuroCUT the desktop with the working area appears as follows:

Fig. 8.1-1: EuroCUT Desktop with working area and shown tool-toolbar, rulers, Object
Manager and status lines

The working area is marked by a black frame that has on the right and below a gray
shade. The working area serves for the orientation and dimensioning.

The rulers can be freely positioned or completely switched off. The layer toolbar is
integrated into the Sidebar. The metric (cm, mm, inch) can be directly changed via a
button that is within the angle of the two rulers. Also ruler's origin can be changed.
Following options are available: Set Origin to Absolute Coordinates, Move Origin, Reset
Origin, Set Origin to Center of Page, Show Origin and Release Origin.

In the status line you find much information about the objects on the working area. For
example the wire frame, filling, object dimensions, -number, combination or grouping
are displayed.
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8.1.1 Cursor forms on the working area and their meaning

Cursor form Meaning
no object marked or selected

Indication: You mark objects by positioning the mouse cursor above the object and
pressing the left mouse button.

Cursor form Meaning
Move objects

Indication: This cursor is only active if the cursor is within the range of the inner
part of the object or in the range between the 8 black squares on the wire frame
line. The object must be marked.

Cursor form Meaning
Increase object vertically
Increase object horizontally
Increase object diagonally

Indication: The cursors for the modification of the object size are only active if the
cursor is within the range of the 8 black squares on the wire frame line of the
object. You switch to the skewing-/rotation-mode by clicking with the left mouse
button with active cross cursor (see above move objects).

Cursor form Meaning
Object in the skew/rotate-mode
Rotate object
Skew object (set tilted horizontally/vertically)

8.1.1 Cursor forms on the working area and their meaning
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8.2 The Textbox Dialog

The EuroCUT textbox contains four dialogs which are explained in detail on the following
pages.

The Textbox Edit dialog

Fig. 8.2-1: Edit dialog of the textbox

The most functions in this dialog correspond to those in the text editor-toolbar. please
refer to 7.3: The Text Editor Toolbar.

In addition, the font color can be selected.

In the left part of the dialog is the text input field. Underneath, the selected font type is
displayed heightened. If the text is marked, the marked text is shown here. If no text is
marked, the name of the used font type is indicated.

Space (1/1, 1/2, 1/4, 1/8)

Key  –  CTRL  SHIFT  SHIFT+CTRL

SPACE
Key

 1/1 em
quad

 1/2 em
quad

 em
quad

 em quad

Underneath the text preview is the status line that provides following data:

Z.: line in which is the cursor - Sp.: Column in which is the cursor
X: X-position of the cursor on the working area - Y: Y-position of the cursor on the working

8.2 The Textbox Dialog
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area
Angle: Rotation used for the objects - (object angle of rotation)

Right next to the preview field are the clipboard functions (Windows Clipboard).

Fig. 8.2-2: Windows clipboard buttons with function's explanations

Pressing the save button takes over the previously set values. When opening the textbox
the next time the last saved values are used for the new text.

Max. Width

With the maximum width you determine the carriage return in the text input field. The
value that is entered here corresponds to the length of your working area. A smaller value
that is entered here carries out the line feed earlier.

Indication: This value can be determined for the whole text block or only for the
marked line in the text input field.

Adjust run length while scaling

This option effects that when increasing or decreasing text blocks the width of the text is
adjusted automatically.

The textbox tabulators dialog

8.2 The Textbox Dialog
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Fig. 8.2-3: The tabulators dialog of the textbox

Tabulators guarantee the accurate alignment of characters at a numeric determinable spot
in a text line or in a text block.

Indication: The tabulator list in the left part of the dialog is empty after the first start
of the tabulators dialog.

Under no. all set tabulators are shown ascending numerically. The position indicates the
distance of the tabulator from the left border of the text. Alignment determines how the
text shall be aligned to this tabulator, left, right, centered or decimal. When using
decimal tabulators which are listed under dec., in addition the separator can be freely
chosen. Mostly, as separator a comma or the dot is used. But any arbitrary text characters
can be used.

The buttons underneath the tabulator display window serve for the loading of existing
tabulator templates, for saving new templates or deleting single or all tabulators.

Edit tabulators

Under position &amp; alignment: here, the position as well as the alignment of a
tabulator can be determined. A new tabulator is defined by entering a new value into the
position field and then activating the add-button. Right next to it the measuring unit of the
tabulators can be selected. You can select between millimeter, centimeter and inch.

The activation of the modify-button allows determining the position of the tabulator at a
new value. After pressing the button the input field appears highlighted in blue and the
wanted values can be entered. You can have the same result by positioning the mouse
cursor in the field, marking the existing value and entering a new one. All defined

8.2 The Textbox Dialog
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tabulators are shown in the left preview window.

Generate automatical

The generate automatical of tabulators is a useful tool for the creation of for example
price lists, menus or something similar.

Just enter the step width and the count and press the generate-button. If the save
-button right next to it is pressed, the here done settings are saved as standard settings
and are available again when next opening the textbox.

The pressing of the load button opens the dialog for loading a previously saved template.

The textbox arc dialog

Fig. 8.2-4: The textbox circular text dialog

Radius

This value defines the half diameter of the circle to which the text block shall be aligned.
The preview window in the dialog shows below right the position of the text in the circle.

Position

You can modify the position of your font at the circle. It can be right, top, left or bottom. If
you select the option manually you can enter in the field angle the angle at which your
texts starts.

8.2 The Textbox Dialog
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Anchor line

These buttons determine how your text shall be set at the circle line. You can select
between:

block height down
descender
base line
x-height
ascender
block height up

Justification

Here you enter how your text shall be justified as measured by the dot of the circle that
you have defined by position. If you enter for example centered, the application sets the
exact middle of your writing at the position dot. The preview window shows you the
justification, the position and the length of the text.

With adjust caps height the font size of the letters of your text changes proportionally to
the size of the circle. The bigger the circle that you selected the bigger the letters will be
and vice versa.

Adjust spacing unifies the distance of the letters. The opening angle allows an individual
correction of the character spacing if the option adjust spacing was activated.

Direction

This option modifies the direction of the text either clockwise (from right to left) or
counter-clockwise (from left to right).

Indication: With this option the text can also be put inside the circle. The angle
thereby is 180°.

Options

Retain skew means that the letters of your text keep their skewing in the circle set if they
had been skewed before.

If you have selected the option retain rotation of baseline the letters are not rotated at
the circle line. The letters are always the "right way around" as if they were orientating at a
horizontal line.

If you have selected the set baseline on circle the circle line is rotated to the base line
which means that the letters of your text are spinned round.

Draw circle draws the circle defined by radius also on the working area. This option
serves for the control of the selected options.

Fill circle draws the circle defined by radius filled and in the selected color of circle on
the working area.

8.2 The Textbox Dialog
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With the option activate arc and the OK-button you confirm the parameters of the circle
set and let it draw on the working area.

With the -button you save the settings for later usage.

The following interactive dialog appears if the circle set on the working area is active and
the T-button or the circle set-submenu of the context menu is activated.

The possible interactive settings correspond to the above mentioned. The apply-button
carries out the modification directly on the working area.

The textbox character table dialog

Fig. 8.2-5: The character table dialog of the textbox

8.2 The Textbox Dialog
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The button for the character table offers the possibility to select such characters from the
symbol set that cannot be entered directly via the keyboard. These characters can only be
selected via an ALT number-combination (ASCII-Code-No.).

In the upper part of the dialog all characters of the selected font type are shown. Below,
the ASCII-Code, the name of the character and which font type (here: Americana) in
which type styles (here: bold) is currently shown is displayed.

Indication: Only the characters that are contained in the respective font are
shown. A filled type style is also a measure for the quality of a font.

Right next to it the selected characters are entered. You select signs by positioning the
mouse cursor on the wanted character and pressing once the left mouse button. Pressing
the right mouse button only selects one character but does not transfer it to the code-field.

Pressing the  button applies the inputs and changes to the edit textbox dialog.
Pressing the  button increases the currently active character.
Pressing the  button opens the settings dialog:

In this dialog you have the possibility to create the colors of the character table according
to your wishes. 

The Textbox Settings Dialog

8.2 The Textbox Dialog
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Name

In the text field a name for a text block can be defined. By default, the name "text". The
name is shown in the object's tab list of the sidebar and in the object names tab.

Alignment

Here the alignment of text blocks is pre-defined; these options correlate with the items in
the text toolbar.

Left

If the left option is enabled, then the marked text block will be justified left.

Right

If the right option is enabled, then the marked text block will be justified right.

Centered

If the centered option is enabled, then the marked text block will be justified centered.

8.2 The Textbox Dialog
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Block

If the block option is enabled, then the marked text block will be justified as block.

Forced Block

If the forced block option is enabled, then the marked text block will be justified as forced
block, which means that all lines of text - even the last one - are adjusted on the column
width or width of the work sheet.

Additions

Adjust line heights to X runlength (Reduce)

If this option is enabled, then when the X runlength is changing, the text block will be
scaled-down proportionally.

Adjust line heights to X runlength (Crush)

If this option is enabled, then when the X runlength is changing, the text block will be
compressed, which means that the character distance will be reduced.

Single line text

If this option is enabled, then is prevented, that a line break is executed at the end of the
line.

8.2 The Textbox Dialog
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8.2.1 Edit Text

8.2.1.1 Keyboard Allocation On Top Text Tool

Cursor Navigation

Key Meaning

To the right One sign to the right. When reaching the right end of the row
the cursor will be positioned at the beginning of the next row.
An existing selection will be cancelled.

To the left One sign to the left. When reaching the left beginning of the
row the cursor will be positioned at the end of the previous row.
An existing selection will be cancelled. 

Downwards One row down. When reaching the last row no further
positioning is done. An existing selection will be cancelled. 

Upwards One row up. When reaching the first row no further positioning
is done. An existing selection will be cancelled.  

POS 1 Positions the cursor at the beginning of the row. An existing
selection will be cancelled.   

END Positions the cursor at the end of the row. An existing selection
will be cancelled.   

CTRL+right Shifting of the signs! - Shifts all signs from the current position
to the right. If a text is selected only the selected signs
are shifted.                                                             

CTRL+left Shifting of the signs! - Shifts all signs from the current position
to the left. If a text is selected only the selected signs are
shifted.   

CTRL+downwards Shifting of the signs! - Shifts all signs from the current position
downwards. If a text is selected only the selected signs are
shifted.  

CTRL+upwards Shifting of the signs! - Shifts all signs from the current position
upwards. If a text is selected only the selected signs are
shifted.   

CTRL+POS 1 Positions the cursor at the beginning of the text. An existing
selection will be cancelled.    

CTRL+END Positions the cursor at the end of the text. An existing selection
will be cancelled.    

8.2.1 Edit Text
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Selections

SHIFT+right Selects the current sign to the right or increases / decreases an
existing selection. 

SHIFT+left Selects the current sign to the left or increases / decreases an
existing selection.

SHIFT+downwards Selects from the current position onwards one row downwards
or increases / decreases an existing selection.

SHIFT+upwards Selects from the current position onwards one row upwards or
increases / decreases an existing selection.

SHIFT+POS 1 Selects from the current position onwards all signs left until the
beginning of the row or increases / decreases an existing
selection. 

SHIFT+END Selects from the current position onwards all signs right to the
end of the row or increases / decreases an existing selection. 

SHIFT+PgDn Selects from the current position onwards all signs downwards
to the end of the text or increases / decreases an existing
selection.  

SHIFT+PgUp Selects from the current position onwards all signs upwards to
the beginning of the text or increases / decreases an existing
selection. 

CTRL+A Selects the whole text and positions the cursor at the beginning
of the text.

During existing
selection

CTRL+right Shifts the selected signs to the right. 

CTRL+left Shifts the selected signs to the left. 

CTRL+downwards Shifts the selected signs downwards. 

CTRL+upwards Shifts the selected signs upwards. 

Deleting

Delete Deletes the sign right of the cursor. If the cursor is at the end of
the row the next row is connected with the current row. 

Indication: If a text is selected the whole selection is deleted! 

BACKSPACE

8.2.1 Edit Text
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Deletes the sign left of the cursor. If the cursor is at the
beginning of a row the current row is connected with the
previous row. 

Indication: If a text is selected the whole selection is deleted!  

Inserting

SHIFT+SPACE Inserts 1/2 space character. 

CTRL+SPACE Inserts 1/4 space character. 

CTRL+SHIFT+SPACE Inserts 1/8 space character. 

Enter

At the end of the current
row

Inserts a new row and positions the cursor at the beginning of
this row. 

In the middle of the
current row

Breaks the current line and positions the cursor at the
beginning of the next row. 

At the beginning of the
current row

Inserts a new row in front of the current row and leaves the
cursor at this row. At the beginning of the first row (position 0/0)
no new row can be inserted. If a text is selected the whole
selection is deleted before.

Clipboard

CTRL+X / SHIFT+delete Cut the selected text and copy to clipboard.

CTRL+C / CTRL+insert Copy the selected text to clipboard.

CTRL+V / SHIFT+insert Insert text from the clipboard at the current cursor position.

Undo / Redo

F5 / CTRL+Z Undo last action

F6 / CTRL+Y Redo

Miscellaneous

CTRL+T opens format text dialog

CTRL+SHIFT+T opens textbox

Insert switches between insert and overwrite mode

F9 switches between contour and whole face mode
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CTRL+W Refreshes the text

CTRL+SHIFT+U Upper -changes all selected signs to capital letters 

CTRL+SHIFT+L Lower - changes all selected signs to small letters 

CTRL+SHIFT+R Switch - inversion of all selected signs from small to capital
letters and vice versa 

CTRL+SHIFT+X Revert - inversion of all selected signs from front to back and
vice versa.

Indication: only wise if the selection is in one single row.

CTRL+SHIFT+K Small capitals for all selected signs

CTRL+K Save Kerning-value between 2 selected letters permanently in
the global font structure.

Indication: Requirement for this is an existing sign shifting
in X-direction so that the new Kerning value can be
recalculated. At the moment, this is only possible with the
EUROSYSTEMS database scripts.

8.2.1.2 Mouse Manipulation On Top Text Tool

Left Positions the cursor at the desired position and clears an
existing selection.

SHIFT+left Selects the text from the current position onwards up to the
new position respectively increases / decreases an already
existing selection.

Left+mouse movement Selects the text into the desired movement-direction until
letting go the left mouse key.

Left double click Selects the whole row.

Right Opens a context sensitive menu in which the text relevant
commands appear.

CTRL+downwards Sign shifting! - Shifts all signs of the whole row downwards. If a
text is selected only the selected signs are shifted.

CTRL+upwards Sign shifting! - Shifts all signs of the whole row upwards. If a
text is selected only the selected signs are shifted.

CTRL+to the right Sign shifting! - Shifts all signs from the current position to the
right. If a text is selected only the selected signs are shifted.

8.2.1 Edit Text
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CTRL+to the left Sign shifting! - Shifts all signs from the current position to the
left. If a text is selected only the selected signs are shifted.

Page down OnTop-Editor: Scrolls the text 5 rows downwards. An existing
selection is cleared.
Textbox: The amount of rows to be scrolled results from the
size of the window.

Page up OnTop-Editor: Scrolls the text 5 rows upwards. An existing
selection is cleared.
Textbox: The amount of rows to be scrolled results from the
size of the window.

CTRL+page down Sign shifting Y-direction (negative).
No selection: Shifts from the current row until the end of the
text all rows downwards.
With selection: Only the selected signs are shifted downwards.

CTRL+page up Sign shifting Y-direction (positive).
No selection: Shifts from the current row until the end of the
text all rows upwards.
With selection: Only the selected signs are shifted upwards

8.2.1 Edit Text
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8.3 The Outline Function

This function is activated via the  button in the variable part of the object
tool toolbar or via the tools menu, menu entry Outline…

O

The outline function creates contours in a freely definable distance around graphical and
text objects.

Fig. 8.3-1: Outline parameter window

Type Area

Outline

The option Outline creates a contour line to the outside around the selected objects.

Note: If there are objects within other objects, then an inline from the inner object is
created.

Inline

The option Inline creates a contour line inside the selected objects.

8.3 The Outline Function
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In-/Outline

The In / Outline option creates a contour line outwards and inwards around the selected
objects.

Corners Area

The corner treatment can be influenced by three additional options. The preview shows
how the selected option affects the contours.

Do not change

The option do not modify corners creates the mathematical accurate dot on the outline
to each corner dot. This leads to the fact that in pointed corners the outline is extended
endlessly which often leads to unaesthetic results. Therefore the option cut corners is
pre-defined as default. This option shortens the extension up to the value that is entered in
the field tolerance.

Cut off

This option truncates the extension up to the value entered in the Tolerance field.

Round

Rounding corners converts the corner point into a rounded curve. The field Tolerance
indicates, in which distance of the corner point is rounded off.

Spacing

The desired value for the distance of the inner or outer contour from the original object is
entered in the Spacing field.

Number of copies

The Number of copies option specifies how many Inlines or Outlines are to be created
simultaneously during a function call.

Min. Object size

This value defines from which object size a contour is generated. It prevents the creation
of small parts that can not be weeded.

Tolerance

The field Tolerance indicates how much is cut off or rounded off. The value 1 equates
approximately the spacing value.

Options

8.3 The Outline Function
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Automatic welding

Automatic welding means that all overlappings of the generated contour lines will be
removed.

Delete original

If the button Delete original is activated, the original object is deleted after creating the
contours.

Do not create interior elements

This option suppresses the automatic generation of an inner contour.

Node reduction

If this option is activated, the number of nodes required for the contour line will be reduced
as much as possible without losing accuracy.

Create parallel at open objects

If this option is activated, parallel lines will be created next to the selected open object
instead of a closed outline.

Target layer

The target layer option allows the preselection of the layer into which the contour lines are
laid.

Note: It is possible to pre-select the tool since the layers can be preconfigured with
a tool.
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8.4 The Undo Redo Stack

The undo redo stack is activated via following key combination: SHIFT+F5
or SHIFT+F6

These functions can undo or redo all object-related actions.

Indication: Actions that refer for example to the working area, the desktop or the
layer-toolbar are not taken into the stack.

The pre-settings in the settings menu, submenu miscellaneous

The Undo Redo stack related settings as for example the number of stack actions is
carried out in the following setup dialog.

Indication: The maximum number of the undo steps can only be modified with no
objects on the working area.

Fig. 8.4-1: The parameter of the undo stack (here: marked in red)

The area undo function comprises the settings that effect the undo stack.

8.4 The Undo Redo Stack
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Fig. 8.4-2: Undo stack with preview window and working area

In the left stack the action can be selected up to which you want to go back. The preview
window shows the status of the working area and of the objects on the working area at the
moment of the action.

The redo stack operates in the same way.

8.4 The Undo Redo Stack
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8.5 The Alignment Function

Fig. 8.5-1: The alignment button

This function aligns two or more marked objects to each other or to the working area.

Fig. 8.5-2: The alignment dialog

Objects can be aligned horizontally or vertically. A centered alignment is also possible as
the selection of the same distance between the marked objects. The type of alignment is
illustrated by icons. Setting can be stored by pressing the Save settings button.

Indication: The last marked or drawn object serves for alignment as reference
object, that means that all others are aligned in the same way. If alignment is not
'Align to Page', then alignment will refer to the last selection.

8.5 The Alignment Function
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8.6 The Sort with Simulation… Tool

This tool serves for the sortation of objects and the determination of sequences before
the output at the connected device. A simulation with or without complete path of the
device tools facilitates the estimation of the results.

Fig. 8.6-1: Object sortation with preview window and simulation option

8.6.1 Zone A1 - Object Position, Color Bar, …

Object Position and Rotation

The object position column indicates the object number and the coordinates of the
objects on the work surface in the X / Y direction. The rotation column indicates
whether the object contour is rotated clockwise ">" or counterclockwise "<".

Color Bar

A click on the wanted color bar selects the respective color layer.

8.6 The Sort with Simulation… Tool
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The Select All Button

Clicking on this button selects all objects in the list.

The Deselect all Button

Clicking on this button deselects all objects of the list.

The Toggle rotation Button

This option modifies the orientation from clockwise (right) to counterclockwise (left) and
vice versa.

Connect / close objects with "OK" Option

This option ensures that open objects are automatically closed when the dialog is closed
with the "OK" button.

View selection Option

Shows the selected objects in the preview window

Single selection Option

In the list only one object can be selected; the multi-selection (standard) is deactivated.

View complete path Option

A blue dashed line shows the track that the tool head covers.

Don't sort at output Option

This option prevents object sorting at output.

8.6.1.1 Layer-dependent Sorting

All Layer Option

This option will include all layers in the sort if layer-dependent sorting is enabled.

Note: This option is disabled in the output preview, depending on the driver setting.

Selected Layer Option

This option only applies the selected layer to the sort, if layer-dependent sorting has
been activated.

8.6.1 Zone A1 - Object Position, Color Bar, …
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8.6.2 Zone A2 - The Simulator

The simulator is used to test and evaluate all settings before output. The operation of the
simulator is similar to a DVD-player.

Lo (low) up to Hi (high) regulates the speed of the simulation display.

Indication: Before simulation, in addition to orientation, you have to do sorting by
clicking on the sort button.

Fig. 8.6-2: Option View complete path activated (blue dashed lines)

8.6.3 Zone A3

8.6.3.1 Options

By Main Direction

If this option is activated, the main direction (area) is visible.

By Nearest Object

If this option is activated, the nearest object (area) becomes visible.

8.6.2 Zone A2 - The Simulator
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Reposition origins to

In this option the start point is set: Possible settings are: unchanged, lower left, upper
left, lower right, upper right.

8.6.3.2 Zone A3.1 - Main Direction (Area)

Main Direction

16 methods can be activated as main direction for the sortation. The icon shows with a red
arrow where sortation begins.

Max. deviation in … mm

In the input field can be entered the value for the maximum deviation of the imaginary
vertical respective horizontal line that an object may have in order to be sorted.

8.6.3.3 Zone A3.2 - Nearest Object (Area)

Fig. 8.6-3: Cutout from the main window (see above)

Optimize origin of objects Option

The aim of this option is to minimize empty runs. Enabling this option checks, which node
of the following object is closest to the first start point. The first is established; Then it is
examined which node of the following object is closest to the start point.

The simulator can be used to check whether the desired optimization is achieved. Usually
the variant, which has the shortest travel distance, is to be regarded as optimal. In

8.6.3 Zone A3
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individual cases, however, other criteria can also be decisive.

Note: If this option is active, the "Reposition origins to" option in the Options (area)
is disabled.

Begin with object at Option

This option determines which start object is taken into account during sorting. Possible
choices: lower left, upper left, upper right, lower right.

Focus: Simulation with start point optimization

In addition to the other traverse path optimizations, the starting point of the objects can be
moved automatically so that the tool head shifts as little as possible. The figure on the right
shows the starting points of the contour objects, represented by an arrow, before and after
the optimization. The direction of the arrow shows the orientation - clockwise or
counterclockwise.

Fig. 8.6-4: Before
origin optimization

Fig. 8.6-5:
After origin optimization

8.6.4 Zone A4 - Sorting, Settings, …

Path length Field

This field displays the realistic traverse path length of the tool measured during the
simulation.

The Sort Button

Only the Sort button activates the object sorting. You can then check in the simulation
whether the sorting meets your requirements.

The Reset Button

Resets the objects in the sort-list to the initial values

8.6.4 Zone A4 - Sorting, Settings, …
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The Apply settings for output Button

This option saves the changes made in the Sorting with simulation dialog.

The Settings for output Button

Clicking on the Settings for output button opens the following dialog:

Note: The settings made here are job-spanning and are the default settings for
output.

please refer to 4.5.3: Start Output from the EuroCUT Working Surface

8.6.4.1 The Sort Settings Tab

Fig. 8.6-6: Sort settings tab with main direction (Area) active

8.6.4.2 Options (Area)

Main direction Option

If this option is activated, the main direction (area) is visible. The desired main direction
is selected via mouse click. (See figure above)

Next object Option

If this option is activated, the nearest object (area) becomes visible.

8.6.4 Zone A4 - Sorting, Settings, …

236



Nearest object (Area)

Start point optimization Option

See above: Focus: Simulation with start point optimization

Start object Option

In this option the start point is defined: Possible settings are: unchanged, lower left,
upper left, upper right, lower right.

Note: The selection of the starting point has an effect on the traverse path length. In
the simulator, the shortest path can be evaluated.

8.6.4.3 Main direction (Area)

In this area, all possible preferential directions are displayed graphically. The desired
preferential direction is selected by mouse click. The icon shows a red arrow where the
sorting is started.

Max. deviation in … mm

In the input field can be entered the value for the maximum deviation of the imaginary
vertical respective horizontal line that an object may have in order to be sorted.

8.6.4 Zone A4 - Sorting, Settings, …
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8.7 The Pen Attributes Tool

With this tool, objects can be provided with wire frame and diverse pen attributes. A pen
attribute is color wire frame thickness, corner and end treatment, etc.

generates hairline (0.001 mm)
removes pen attributes
opens the pen attribute settings dialog
allocates the layer color of the object to the wire frame

Fig. 8.7-1: Pen attributes tool with sub functions and description

Create hairline

Fig. 8.7-2: The hairline button

The activation of this button creates a hairline around marked objects.

Indication: The thickness of this hairline is not variable and is 0,01 mm.

Remove pen attributes

Fig. 8.7-3: The remove pen attributes button

The activation of the remove pen attributes button removes all pen attributes.

The pen attributes dialog

Fig. 8.7-4: The pen attributes-button

Via the pen attributes dialog the wire frame pen of curves, combinations or text objects
can be designed. Wire frame pens are used among other things for drawing the object
outlines in the full surface mode or preview mode and for printing.

Indication: The pen attributes have no influence on the display of the objects in the
wire frame mode (F9). Here, the outlines of the objects are drawn with a simple wire
frame line in the layer color. 

8.7 The Pen Attributes Tool
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Fig. 8.7-5: The set pen attributes dialog

No wireframe

If you select the option no wireframe the object will not have a wire frame. In the full
surface and preview mode closed curves are drawn as area without outline with this
setting. Open curves are, as in the wire frame mode, drawn as outline in the color of the
layer.

Hairline

If the option hairline is activated the object is encircled with a very thin pen of constant
thickness.

Color

In the field color you can determine the color of the wire frame.

Indication: This can be different from the layer color. Thus it is possible to highlight
the outline of the objects from the filling also in the full surface mode.

Line thickness

Select the option line thickness to determine an arbitrary pen thickness in the input field.

Scale with object

Scale with object means that the line thickness is adjusted proportionally when distorting
respective scaling the object. If this field is not activated the wire frame pen keeps the set
thickness.

8.7 The Pen Attributes Tool
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Wireframe behind fill

With the option wireframe behind fill you can prevent that the pen "runs" into the filling of
the object. The outline is then drawn by the filling so that only the part of the outline lying
outside of the filling is visible.

Corners

You have also the possibility to determine the appearance of the corners. You can select
between cut, rounded and sharp corners. The appearance of the respective corner form is
given to the icons and also displayed in the preview field.

Ends

Also you can select the form of the ends of open objects. Ends can appear cut, rounded
or extended.

Color field

The current color of the pen is shown in the color field left of the palette and in the
preview field.

There are two possibilities to modify the pen color.

1. To mix the pen color anew you double click on the color field left of the palette. Then
following color selection dialog appears with the currently set values of the pen color:

Fig. 8.7-6: The pen attributes color selection

After you have determined the pen color, it appears in the pen attribute dialog in the
color field left of the color palette. The pen color is also shown in the preview field.

2. In the palette you can freely choose the color values. These are selected by simply
clicking with the mouse on the wanted color field. With the scroll bar on the right edge of
the color palette you set the color intensity.

8.7 The Pen Attributes Tool
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Assign layer color to object contour

Fig. 8.7-7: The assign layer color button

The activation of this button allocates the layer color to the contour of a marked object.  

8.7 The Pen Attributes Tool
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8.8 The Welding Tool

This function is activated via the  button in the variable part of the object
parameter toolbar or via the tools menu, menu entry welding…

W

This function welds two or more vector objects with each other to a combination.
Depending on the number and the form of the selected objects you can choose between
the following options: manually, automatically, trim (cuts objects with lines or curves),
open trimming, by color, full area or screen printing.

Fig. 8.8-1: Tools menu - welding submenu

Dialog…

The activation of this submenu opens the following dialog

Fig. 8.8-2: Welding dialog

8.8 The Welding Tool
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Manually

Manually separates all intersections that occur because of the overlapping of outlines and
creates object parts. With the arrow-function you mark the object parts that you want to
remove. With the DEL-button the selected object parts are deleted. Overlapping-free
object parts are kept and can later be further edited. The original color of the object parts
are kept with the manual welding.

Automatically

Automatically calculates the common areas of the objects. All overlapping parts are
combined, transparent interior elements are considered.

Indication: With this option, objects of different colors are welded to a combination
object.

If the object colors shall be considered please select the options by color, full area or
screen printing.

The option automatically is especially suitable for the welding of serifs with scripts. The
serif of the previous letter overlaps often with the successive character. The material
would be slit at these positions without welding. The automatic welding eliminates this
overlapping and takes care of a cuttable transition in the serifs.

Tip: If single parts are missing after the automatic welding, then reduce the
character spacing in the text editor from 100% to 99%. This causes that identical
node dots that lie on top of each other are misplaced so that they are recognized
also as single nodes and the welding routine is carried out properly.

Trimming

Trimming means that you cut through closed objects with lines or curve objects and that
the object parts that are thus being created are automatically closed afterwards.
Depending on your request you can lay one or more objects over the objects to be slit like
a "knife". If you want to work with several "knives" these objects must be allocated to the
same layer or be combined. Then, by means of the trimming-option, the objects lying
underneath are cut alongside the "knifes". Also cutting in several "tilings" is possible
without problems as the knifes can overlap at discretion. The parts having thus being
created are then sorted according to their position and combined to single groups.

Open trimming

The open trimming works like the trimming with the difference that cut-off points of the
cut objects are not closed automatically but kept as open objects.

By color

By color removes all areas that are hidden by colors lying above. It does not matter how
many objects and colors you select. If open objects are also selected they can be closed
or provided with a line weight.

8.8 The Welding Tool
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Full area

The option full area underfills objects of one color whose areas hide those of another. To
do this, the partially hidden objects are modified so that they underlay completely the ones
lying above. Here, you can also proceed with the open objects as described under
automatically.

Tip: The mostly used field of application is the showcase labeling where the by
color-option is often too laborious to be pasted over. With 2 maximum 3 foil colors
you take the full surface option where the single foil colors are pasted above the
other.

Screen printing

The welding option screen printing is an especially efficient tool for the screen printer. At
first, the overlappings of the single coatings are removed. Then, the colors are layered
according to the sequence in the field color sequence. At the end, a small bar is inserted
at the seams between the single color layers as overlapping.

The color stack with the screen printing-welding

Modification of the color stack: With the screen printing, the printing sequence is from
bright to dark. Brighter colors are printed before the darker colors. By mouse click a
coating is grabbed and drawn to the wanted position.  The color stack reflects the position
of the layers above the medium. The output sequence considers the modifications of the
color stack.

Delete original

With the checkbox delete original you set if the initial objects shall be deleted after the
welding process or not.

8.8.1 Mask

Topmost object

If this option is activated the topmost object can be defined as welding object with the
welding functions trim, open trim and fill.

Topmost color

If this option is activated all objects of the above lying color can be defined as welding
object with the welding functions trim, open trim and fill.

Provide open objects with contour … mm

If open objects are amongst the selected you can indicate with the option provide open
objects with contour …  which thickness the created closed object shall have.

8.8.1 Mask
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Do not correct appearance of combinations

With this option combinations are treated that they are welded as displayed in the full
surface mode. Overlays in combinations remain transparent.

Join same colors

It can happen that the same color reappears in different group- or combination objects.
Then, select the option join same colors so that those merge to one color layer.

Indication: This is especially important with the creation of screen printing
templates as with the screen printing process the darkest color is always spread at
last in order to prevent possible white gap that might occur while mounting the
single colors.

Remove identical lines

With this option all vectors that are identical are removed but one.

8.8.2 Seams

Underlap - Offset

These options can only be activated with by color. In the field overlay you can enter the
value for the underlap or the offset.

Overlay … mm

If the option screen printing is activated you can enter here the value for the overlay of
the colors in mm.

Complete overlay up to:

Here, you can additionally enter the limit up to which width it shall be completely overlaid.  

8.8.2 Seams
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8.9 The Color Bucket Tool

With this function you can fill objects with color graduations or bitmaps. The user has here
four available buttons.

generates color graduations
inserts filling bitmaps
removes all fillings
allocates layer color as filling if the object has a color gradient
or a bitmap filling
adjusts transparency

Fig. 8.9-1: The color bucket tool with sub functions

Create color graduations

Fig. 8.9-2: The color graduation button

Pressing this button opens the color graduation dialog in which the appearance of the
gradient fill of closed curves, text objects or combinations is determined.

Fig. 8.9-3: The color graduation dialog with settings options

Determination of the color graduation

In the field type select the type of color graduation. You can choose between linear,
radial, conical and square. In the preview window up right in the dialog the appearance
of the respective type is displayed.

8.9 The Color Bucket Tool
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Options

In the field steps screen you determine the number of color graduation streaks at the
display on the screen.

Steps print means the respective number at the output on a printer.

With the fields hor.(izontal) center and vert.(ical) center you determine the center point
of the color graduation.

Indication: These two fields are not active with the type linear.

With the input of 0% the center point is above the filled object. It can be moved in relation
to it at 100% of the object width to the left or right respective at 100% of the object height
up or down. As well, the origin can be determined with the mouse. To do this, move the
mouse cursor in the preview window and click with the left mouse button on the spot
where you want to have the origin.

The field angle describes the position of the color graduation streak with linear, conical
and square filling.
If linear is set you can set the angle of the graduation also by means of the preview field.
To do this, click on any spot of the field. Keep the mouse button pressed and move the
mouse. A line, that is tied to the origin appears and follows the movements of the mouse.
After letting go the left mouse button the angle that was determined with the line is taken
over for the graduation.

Distance from margin

The set value that lies herewith between 0% and 45% indicates the position of the first and
last color relative to the center of the graduation.

Indication: The distance from the margin can only be modified with linear and
quadratic filling.

Determination of the original color

Under graduation the start and end color as well as the position and color of possible
intermediate steps is selected. The bar between the two triangles, the color graduation bar
indicates the course of the colors.

Click into the left triangle to determine the original color. For the modification of the color
value you have two possibilities. A double click into the field color left of the color palette
opens the color selection dialog.

Selection of the target color and further color stations

In order to set the target color of the graduation you first activate the triangle at the right
margin of the color graduation bar. Further color stations can be inserted with a double
click on the bar above the graduation bar. A small triangle that indicates the position of
the color in the graduation is shown at the selected position. The exact position is entered
as percent value in the field position. The position can be modified by moving the triangle

8.9 The Color Bucket Tool

247



or through input of the wanted value in the field position. In order to select the color at the
wanted position you first select the triangle that points to the position. Then you can
determine a new color in the ways described above. To remove a graduation step click on
the triangle that has its position. Then press the DEL key. The triangle disappears from the
bar and the color is not considered anymore at the graduation.

Indication: The original and the target color cannot be deleted.

Fig. 8.9-4: The color selection dialog

Here you can modify the current original color. A click into the left color field selects a
color, the vertical ruler determines the intensity and the preview-field shows the selected
color.

Color

The color value can also be defined numerically. The following color models are available:
CMYK (cyan, magenta, yellow, black), RGB (red, green, blue) and HSB (hue, saturation,
brightness).

Insert fill bitmaps

Fig. 8.9-5: The bitmap fill button

Pressing this button opens the bitmap fill dialog via which you can fill the vector objects
with bitmaps.

8.9 The Color Bucket Tool
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Fig. 8.9-6: The bitmap fill dialog

Selecting a fill bitmap

You first have to determine with which bitmap the selected object shall be filled. You have
three possibilities:

1. Scanning a new fill bitmap

Scan your template that you want to use as fill bitmap via the EuroCUT Twain Interface
(file menu, menu item scan). Open the fill bitmap dialog. The selected bitmap is now
shown in the preview and also appears in the field named available bitmaps. Now do
your settings and confirm the dialog with OK. If the result does not correspond with your
demands you have the possibility to "loosen" the bitmap again which means that you can
restore the original status of your scanned bitmap. To do this, select the option remove
mask in the context menu.

2. Import new fill bitmap

Click on import fill bitmap in order to select a new bitmap as fill. A file selection dialog
appears. There, you can search for and select the wanted bitmap.
The selected bitmap is then shown in the preview and also appears in the bar with the
available bitmaps down left in the dialog.
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Fig. 8.9-7: The file selection dialog for the bitmap import

Available import formats are: jpg, pcd, pcx, tif and bmp.

3. Insert used fill bitmap

If you want to use an already used fill bitmap, select it from the bar with the available
bitmaps. Via mouse click one of the bitmaps shown there is selected. To search for
bitmaps not shown, please use the scroll bar.

Fill mode

In the field fill mode you select the mode of the fill bitmap. Possible modi are a) tile, b)
seamless tiling, c) fit and d) object size.

a) Tile

Tile fills the object with tiles drawn side by side and below each other from the select fill
bitmap. The width and height of a single tile are determined in the fields with the same
name in the group measurements. Tick the field proportional to guarantee that in case
of a modification of height or width the other corresponding value is adapted proportionally
and the bitmap is not distorted.

If you activate the option scale with object the measurements of the tiling in case of
distortion of the object are automatically adjusted. As default the first tile is placed in the
upper left corner of the object outline. By means of the fields X-center and Y-center you
have the possibility the freely select the starting position. Enter here a negative value
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between 0% and -100% to move the tile to the left respective upwards. With positive
values between 0% and 100% the center point of the first tile is moved accordingly to the
right respective downwards.

By selecting the option move you can create an offset within the tiling rows. With to X
resp. to Y you determine if the offset shall be done in horizontal or vertical orientation. The
% field on the right serves for the input of the size of the offset of the tiling width respective
the tiling height in percent.

b) Seamless tiling

Seamless tiling corresponds mainly to the option tiling. The difference is in the display of
the tiling. With seamless tiling all rectangles with exactly the same measurements are
drawn. This way, especially with patterns, a smoother picture is created.

Indication: The disadvantage of this method is that the position of the single tilings
can vary depending on the size of the view.

c) Fit

In the mode fit the bitmap is only drawn once into the object. The preview shows the exact
proportions of bitmap and object. With the input fields width and height you determine
how big the bitmap to be filled shall be.

The positions of the bitmap within the object can be modified in two ways.

1. In the fields X-center and Y-center the deviation of the center point of the bitmap to the
center point of the object can be given in percent.

2. But you also can determine the position by means of the preview field. Click on the
bitmap in the preview field and keep the mouse button pressed.
Now, the picture can be positioned by moving the mouse. A cross hair is shown for the
exact positioning. After letting go the mouse button the wanted position is taken over.

d) Object size

The last mode object size fits the bitmap optimal in the object. Its width and height are
calculated so that the whole area of the object is completely filled.

No filling

Fig. 8.9-8: The no filling button

If this button is pressed, fillings and fill bitmaps of all marked objects are removed. Only
the outline of the objects remains in the previously allocated layer color.
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Fill with layer color

Fig. 8.9-9: The fill with layer color button

If this button is activated the marked layer color is allocated as filling if the object has a
color graduation or a fill bitmap.

Adjust transparency

Fig. 8.9-10: The adjust transparency button

If this button is activated, transparency of a color filling can be adjusted linearly from 0 to
100 %.
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8.10 The Measure / Measurement Tool

Fig. 8.10-1: The measure button

Activate the measure button in the toolbox with the mouse pointer. Return to the working
area; the mouse pointer appears as circular sight. Move the center point of the sight to the
starting point of the track to be measured. Keep pressed the left mouse button while
moving to the end point of the track and let go the mouse button when you have reached
the end point. A subsidiary line marks the measured track.

Indication: Keep pressed the SHIFT key during the measurement. Then the
measurement is limited horizontally or vertically. This facilitates the exact
measurement of straight lines.

Fig. 8.10-2: The measure dialog

In the text field name length the result of your measurement appears. In order to modify
this value, first mark the text field and then enter the new value. In the text field
underneath you can percental increase or decrease the objects.

In addition, you get information about the angle of the measure lines, the width of the
measured object at the starting point of the measurement and the difference in height
between the starting and the end point that is resulted from the measure angle.
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8.11 The Stop Watch

The stop watch is integrated in the menu bar of EuroCUT. A click on the 00:00:00 menu
(format: hh:mm:ss) opens the submenus for steering the watch.

Fig. 8.11-1: The stop watch integrated in the EuroCUT menu bar

Start

The activation of the start menu starts the stop watch. To stop intervals the start menu
can be activated several times. The total time continues until the reset menu is activated.

Stop

The activation of the stop menu stops the stop watch and enters the value into
the duration field of the Job Info.

Fig. 8.11-2: Duration field of the Job-Info

Reset

The reset menu resets the watch to 00:00:00.
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8.12 The Tracing Tool (Vectorization)

Tracing means the generating a cutting contour (vectors) out of a pixel image (bitmap).

8.12.1

8.12.2 Color assignment

Colors sel.: (Number)

Via mouse click in this column the colors are selected, which should be mapped to one
color in the right column. The preview shows the bitmap after merging this colors. You can
use this function for manual color reduction with control of results.

Indication: By default 16 colors are selected.

Sel. colors map onto

After, for example, all green tones were selected in the left column, one can select with
one click the color on which the green tones should be mapped. The 1st preview shows
the bitmap after mapping.

Deselect colors

Undoes last selection in left column.

Undo last color mapping

If this option is activated, the last assignment in both columns is undone.

Reset to original values

Sets both color columns back to the initial state when the the dialog was opened.

Max. number of colors

Reduces number of colors in the bitmap to the selected value. A minimum of 16 colors and
a maximum of 256 colors is selectable.

Indication: A higher number of colors seem appropriate, since no sensible color
mapping is possible.

Preview 1

Reduced to X colors

In the preview 1 the color reduced original bitmap is shown. The number of shown colors
is geared to the value of the Max number of colors option.
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Indication: The content of the preview can be moved via mouse. If additionally the
checkbox move is activated, the contents of both previews are moved and scaled
simultaneously.

Preview 2

After vectorization: (Number) nodes

Preview 2 shows the result of the vectorization using the chosen parameters. Additionally
the number of resulting nodes is shown. The number of nodes gives information about
complexity of the result and is so an indication for the reworking effort.

Indication: The content of the preview can be moved via mouse. If additionally the
checkbox move is activated, the contents of both previews are moved and scaled
simultaneously.

Outlined checkbox

If the Outlined checkbox is activated, the result (the vectors) is shown in contours.

Checkbox Move

The checkbox between the two previews links both previews while moving them.

Plus / Minus

The Plus / Minus buttons besides the two previews enlarge or reduce the according
preview.

Preview button

Activating the Preview button starts vectorization and shows the result in the right preview
(preview 2). Thereby you can choose between full surface and contour mode.

8.12.3 Parameters 

Create bitmap outline

The option Create bitmap outline means that an identical image without filling is created
from the original bitmap contour. On the working area, the bitmap outline appears as
jagged line in a group with the vector contour. The bitmap outline is put in a gray layer that
was added at the end of the color layer list.

Tip: In order to color it differently for better differentiation select the gray layer (R
128, G 128, B 128) and assign this color to the bitmap outline.

The bitmap outline facilitates and quickens that rework of the vector contour as it is drawn
only as jagged line on the working area. The quality of the results remains uninfluenced.
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Vectorize background

With the option Vectorize background a vector object can also be created for the area in
the background of the bitmap objects.

Optimize for text objects

By activating the option Optimize for ext objects better results at the tracing of texts can
be obtained.

Allow contour size &lt; 5 pixel

If the option Allow contour size &lt; 5 pixel is activated, then also closed objects are
created by objects that are smaller than 5 pixels.

Indication: bar 1 is without function when selection this option.

Avoid overlap

The option Avoid overlap serves to automatically remove possible overlapping of the
vector contours.

8.12.4 Sliders

The tracing has four bars to influence the accuracy of the result.

Bar 1: Filter contours

Filter contours: ~ filters the result of bigger dirt particles in which contours that were
created by objects smaller than 5 pixels are not delivered back.

Bar 2: Reduce number of nodes

Reduce number of nodes: ~ reduces the number of nodes that lie on a curve. The
course of the curve differs the more from the original course the higher the value of the
setting was chosen.

Tip: A small amount of tangential points shortens the rework time enormously so
that a middle setting is often a reasonable compromise.

Bar 3: Adjust curves

Adjust curves: ~ regards the course of lines and curves and eliminates outliers in
horizontal and vertical orientation that do not influence the course of the curve or line. This
way, tangential points that lie within the selected range of tolerance are not considered
with the tracing.
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Bar 4: Smooth curves

Smooth curves: ~ influences the position of the tangents with curves. The higher you set
the value the more smoothened dots are created. Smoothened curves are characterized
that the tangents lie on a line at that at the output on the cutter smooth transitions are cut.

Indication: A too high value influences also the accuracy of the result so that here
also a middle value is a good compromise between cutting result tracing of the
original.
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8.13 The Contour (Line) Function

With the contour line function the outer edge of arbitrary many objects is calculated and
provided with a wire frame line. Contrary to the outline you can contour also bitmaps with
this tool. In addition, not every single object is outlined. Instead, it is tried to possibly find
one contour that comprises all selected objects. This function is therefore especially suited
for the creation of cutting lines around labels. The objects of the label can be arranged
arbitrarily.

Then the wire frame of the object is calculated in the wanted distance with the tool
described here. The contour line thus created can be used later for cutting out the printed
label.

First select the objects that you want to contour / outline. Then select contour… in the
tool menu.

The following dialog for the creation of the parameters appears:

Fig. 8.13-1: Parameter dialog for the creation of contour lines

Find contour

With the fields in the dialog group find contour you can influence the calculation of the
wire frame line. Generally, all objects that are not white are considered with the contour
finding. Ideally, the background of the graphic to be contoured should therefore be white.
But especially bitmaps contain often light gray spots that can occur when scanning.

Maximum gray scale

With the option maximum gray scale you can determine that gray spots above the
selected intensity are not contoured. You can enter values between 50 and 99% or set
them with the roll bar. 50% correspond to a relatively dark gray and 99% to an almost
white color.
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Accuracy

In the field accuracy you can select between three options. The low accuracy works the
fastest. If the result is not satisfying with this setting, select the middle or a higher
accuracy. The calculation of the contour line then takes a little bit longer.

Indication: The field accuracy is not activated if only a single bitmap was selected.

Keep interior elements

If the option keep interior elements is activated, possibly created interior elements are
not deleted. This way you have the possibility to cut out parts of the graphic by applying a
brighter "plaster".

Look at the following illustration for this:

Fig. 8.13-2: Option: keep interior elements

On the left side you see the two initial objects. A smaller white circle is put onto the black
circle. On the right, the calculated contour line is displayed. The option keep interior
elements was active, also the inner circle was considered at the contour finding. With the
dialog field switched off, only the outer contour would have been created.

Indication: As default, keep interior elements should be switched off.

Distance and line guidance

In the second dialog group distance and line guidance you can influence the
appearance of the contour line.

Contour offset

With contour offset you determine how far away the wire frame line shall be from the
graphic. If you enter here the value "0" a contour line is created that directly is attached to
the edge of the selected objects. With values smaller than 0 the contour line goes into the
contoured objects.

Corner shape

The option corner shape determines how the contour line acts at salient corners.

Normal creates the mathematical exact dot on the contour to every corner dot. The
contour line can thus be lengthened very far at sharp corners, which often leads to
unaesthetic results. The options cut off and round lead to more satisfying results in such
cases.
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Cut off

Cut off shortens the contour at the indicated distance and cuts off the corner by a section.

Round

Round leads the corner dot to a rounded curve.

Color

On the right side of the dialog you can see a color selection field. A click on the change
button opens the color selection dialog. With this dialog you can allocate colors to
contours.

Destination Layer

This Field determines in which color layer - in doing so indirectly, with which tool - the
contour line is processed.

Note: The contour line color can be different in the full surface mode (print) and the
contour mode (output).
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8.14 The Job Info

The job info can be opened in three ways:

1. Via the edit menu / menu item job info…
2. Automatically when saving a new job
3. Via the so named menu item in the context sensitive menu (right mouse button)

Fig. 8.14-1: Job info main window

With the job info you have the possibility to save additional information to each job. This
information can be printed and used for the invoicing or as accompanying ticket to jobs. If
the job info is printed, also the complete path in which the job was saved is printed.

Besides information as for example order number and company address the job info
gives information about the used materials, duration of the production, number of cut /
printed jobs as well as the intended or calculated price. In the memo field keyword
comments can be saved.

In the settings menu / menu item standard settings / menu item job info… the job info
can be extended by arbitrary many fields.

Indication: The information under the field media are only inserted automatically, if
you have given these information to the respective color layer in the layer settings
dialog and selected the adequate palettes at the design. Further information about
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this can be found here: please refer to 9.3.6: II. Layer Settings Color Setup

Tip: The switch between the single fields is done the fastest way with the
TABULATOR key.

Fig. 8.14-2: Job restrictions

To each job following restrictions can be added:

No output

This job cannot be output.

No export

This job cannot be exported and thus cannot be converted to another format.

No printing

This job cannot be printed.

No saving

This job cannot be saved.

Password protection

In addition to the restrictions described above, a password can be given to each EuroCUT
job. This way, the unauthorized access to these job data is not possible.
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Fig. 8.14-3: Dialog for the determination of a job password
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When outputting to a connected device, the safety instructions of the
machine manufacturer must always be observed strictly.
No liability is assumed for infringement.

8.15 The Plot Manager

The Plot Manager has the following tasks:

8.15.1 Creation And Modification of Device Configurations

With the Plot Manager it is possible to create a device configuration or short, to create an
output device. In a device all information necessary for the output of the data as for
example driver and ports are summarized.

In EuroCUT, these devices then can be used for the output of the graphics. It is possible,
to output simultaneously at several devices.

8.15.2 Monitoring the Output Processes of the Jobs

The outputs to the respective devices can be monitored with the Plot Manager, for
example the output can be broken or aborted and the sequence of the jobs can be
changed retroactively.

8.15.3 Output of Data to Local Ports

The serial and parallel ports of the computer are identified and can be used for the file
output.

8.15.4 Administration of Hotfolders

A function independent of EuroCUT is the administration of Hotfolder. A Hotfolder is a
directory monitored by the Plot Manager. If a file is copied to this directory the Plot
Manager carries out automatically certain configurable functions.

8.15.5 Plot Server Function

The Plot Manager can enable devices so that other Plot Managers can use these enabled
devices. This allows separating design and output working places.

Important note:You start the Plot Manager with a double click on the  icon that is
down right of the screen in the task bar.

8.15 The Plot Manager
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Fig. 8.15-1: Plot Manager main window with job preview down left

8.15.6 Devices Folder

Each device possesses three device folders in which the jobs are shown:

Indication: with jobs, also those output actions are meant that are carried out by
Hotfolders or on local ports.

Devices Folder 1

Active Jobs
All jobs that shall be output as soon as the device is ready are collected in this folder. If a
job has been output completely, the next job is output. If the option „show message
window before output of a job” is active, a notification dialog is shown before each output.

Devices Folder 2

Passive Jobs
If the output device is broken, all jobs to be output are moved to this folder.

Devices Folder 3

 Saved Jobs
Here, all jobs that have been output are saved. The number of the saved jobs can be
indicated in the options dialog of the device. If the number of the saved jobs is reached the
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next one to be saved replaces the oldest existing job.

Job Functions

The functions differ according to device folder, device type and job status.

Indication: The functions can be carried out via a context menu.

8.15.6.1 Jobs at local devices

Active Jobs
If the job is being output:

Pause
The output of the data is paused. The job is marked with the symbol.

Paused Jobs

Continue
The output is continued.

Set Job to passive
The job is removed from the list of the active jobs and added to the folder of the passive
jobs.

Delete Job
The job is deleted.

Passive Jobs

Activate Job
The job is removed from the list of the passive jobs and added to the folder of the active
jobs.

Delete Job
The job is deleted.

User message: to this job, a notification text can be entered. This information is shown if
the job shall be output respective if it is selected.

Saved Jobs

Activate Job
The job is removed from the list of the output jobs and added to the folders of the passive
or active jobs depending on the setup device.

Delete Job
The job is deleted.

Plot to File
Here you can determine if the job shall be output to a file.

8.15.6 Devices Folder
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Save as
Save job data into file before cut data processing.

8.15.6.2 Jobs at Plot Servers

Active Jobs
No functions

Passive Jobs

Activate Job
The job is removed from the list of the passive jobs and added to the folder of the active
jobs.

Delete Job
The job is deleted.

User message: to this job, a notification text can be entered. This information is shown if
the job shall be output respective if it is selected.

Saved Jobs

Activate Job
The job is removed from the list of the output jobs and added to the folder of the passive or
active jobs depending to the setup device.

Delete job
The job is deleted.

Save as
Save job data into file before cut data processing.

8.15.6.3 Jobs at Hotfolders

Active Jobs
No functions

Passive Jobs

Activate Job
The job is removed from the list of the passive jobs and added to the folder of the active
jobs.

Delete Job
The job is deleted.

User message: To this job, a notification text can be entered. This information is shown if
the job shall be output respective if it is selected.
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Saved Jobs

Activate Job
The job is removed from the list of the output jobs and added to the folder of the passive or
active jobs depending to the setup device.

Delete Job
The job is deleted.

Save as
Save job data into file before cut data processing.

8.15.6.4 Jobs at local ports

Active Jobs
If the job is being output:

Pause

The output of the data is broken. The job is marked with the  symbol.

Paused Jobs

Continue
The output is continued.

Set Job to passive
The job is removed from the list of the active jobs and added to the folder of the passive
jobs.

Delete Job
The job is deleted.

Passive Jobs

Activate Job
The job is removed from the list of the passive jobs and added to the folder of the active
jobs.

Delete Job
The job is deleted.

Notification: To this job, a notification text can be entered. This information is shown if the
job shall be output respective if it is selected.

Saved Jobs

Activate Job
The job is removed from the list of the output jobs and added to the folder of the passive or
active jobs depending to the setup device.
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Delete Job
The job is deleted.

Plot to File
Here you can determine if the job shall be output to a file.

Save as
Save job data into file before cut data processing.

8.15.7 Settings of the Plot Manager

Fig. 8.15-2: Optional parameters for the Plot-Manager

If the option is activated Plot Manager always on top, the Plot Manager window remains
always in the foreground.

If the option tooltips is activated, a short description to a dialog element is shown if the
mouse pointer remains above the dialog element.

If the option view job preview is activated a preview of the output data is shown.

Command line parameters

If the Plot-Manager is started without parameters it checks all devices if there are jobs for
processing.
If a job was found it is carried out. It stops if no jobs were found or if all jobs have been
processed.

If, when calling up the parameter !SPOOL! is given, the Plot Manager remains active. It
then has to be terminated manually with a right mouse click onto the symbol in the
taskbar.

Hotfolder

With a Hotfolder a directory can be monitored. If a file is copied to the directory to be
monitored one of the following actions is carried out automatically depending on the
settings:

8.15.7 Settings of the Plot Manager
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Fig. 8.15-3: Example for setup devices of a Hotfolder

Settings

Hotfolder name: here you have to enter the name of the Hotfolder

File mask: here, the file name ending are given, that shall be considered, for example *.plt.

Hotfolder directory: here, it is determined which directory the Hotfolder shall monitor.

Output

COM/LPT: the file is output to a local serial respective parallel port.

USB: the file is output to a USB device. A USB device is only shown if it is connected with
the computer.

TCP/IP: the file is send to a TCP/IP address. With some addresses, you additionally have
to enter the right port number.

Spooler: the file is output via a printer driver.

File: the file is copied to the output directory. An existing file with the same name is
overwritten.
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After having carried out the action, the input file is deleted.

Indication: if "file" is set as output, the application is started after the copy. In all other
cases, the application is started before the output.

Extended Settings

Start application if Hotfolder becomes active: in addition, another application can be
started that shall further process the input file to be processed. The file name is marked
with %s.

RIP: only necessary if Pjannto RIP uses this Hotfolder as RIP Hotfolder.

Mask: formatting of the output file name: %File file name; date/time: %Y -
%d_%H-%M-%S year/month/day: hour/second/minute

Change defaults: prevents that the user modifies the output parameters accidentally.

8.15.7.1 Device Options

In the Device Options window you can set - for each device which is listed in the Plot
Manager - the following device options.

Note: This window will be enabled by clicking with the right mouse button on a
device item and selecting the Options menu item.

Fig. 8.15-4: Additional options for each device

Maximal number of saved output files

The registered value of this option limits the number of saved output jobs for this device in
the history of stored files.

Number of outputs (of a Job)

The registered value of this option defines how often active Jobs will be given out.
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Inform user before output

If this option is enabled, then a message window will be shown, before the outputting of
each Job. This gives the user the opportunity to prepare the machine before the data
output.

Plot to File

If this option is enabled, then the output is redirected to a file. Before writing the file to the
Job Save As dialog is enabled.

Activate Sound Signal

If this option is enabled, then an individual sound signal will be given out before each
output of a Job, in order to draw attention to the user.
A sound file in the WAV file format can be selected using the  button.

The Movement... Button

Fig. 8.15-5: Distances of the used tools

This feature tracks the distance (tool motion), from every tool of the activated output
device in meters. In addition to the distance, date and time of each output are given.
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8.16 The PhotoCUT Function

PhotoCUT creates vectors out of bitmaps. PhotoCUT calculates from Windows bitmap
files (*.BMP, *.PCX, *.TIF) raster strips or patterns that can be output with a cutting plotter.
The picture is divided in logical pixel and the average gray value detected for each of
these logical pixel. A picture is created that has fewer pixels than the original. Then,
horizontal or vertical strips, circles, squares, ... are created from this picture whose width is
proportional to the gray value at the respective position.

8.16.1 The PhotoCUT Dialog

Open the PhotoCUT dialog by selecting the so named menu item in the tools menu.

Fig. 8.16-1: Dialog with parameter-setup

General settings

Pixel in X-direction

In this field, enter the number of pixel that shall be combined to a logical pixel in
X-direction. The smaller the value in this field, the better the output quality of the "picture".

8.16 The PhotoCUT Function

274



Pixel in Y-direction

In this field, enter the number of pixel that shall be combined to a logical pixel in
Y-orientation. The smaller the value in this field, the better the output quality of the
"picture".

Remaining width

This value determines the remaining width of a strip (only with strips) in mm of the line
respective column size.

Excursion: contrast (adjust via image menu contrast)

Because of the division of the bitmaps into logical pixel the line respective column size is
determined. The width of a strip depends on the set gray value and the contrast. The
maximum width is line respective column size minus the value of the remaining width.

Corresponding to the contrast value the width of the strip is identified by the average
shade of gray. The contrast is the proportion between white and black in %, which means
with 100% contrast the 100% black is mapped on the maximum and 100% white on the
minimum width of the stripe. If the contrast is reduced, the 100% black is only calculated
with for example 50% of the maximum width of the stripe.

Minimum gray value

The Minimum gray value is a limit for the shade of gray. You can for example remove a
constant gray bitmap background.

Indication: This value is only relevant if a graphic is darker than its background.

For all examples the following picture serves as template: (Standard path: C:\Program
Files\EUROSYSTEMS\EuroCUT Basic 8\Bitmaps\photo.bmp)

Fig. 8.16-2: Template for all following result examples
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Negative

The range of value of the shades of gray is reversed which means that 100% black
become 0% white and vice versa.

Positive Negative

Fig. 8.16-3: Example for the reversion of the range of value

Reverse direction (only with stripes)

If this option is activated, the width of the stripe is aligned downwards.

Width of stripe upwards Width of stripe downwards

Fig. 8.16-4: Example for the reversion of the width of stripe
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Cut out

Width of stripe upwards Width of stripe downwards

Double (only with stripes)

If this option is activated, the width of stripe is created up and down.

Width of stripe up and down

Fig. 8.16-5: Example for „double”

Horizontal or vertical

With the options horizontal or vertical the direction of the stripe is determined.

Bitmap

In the area named bitmap the file data of the template (of the picture) are shown. In the
upper area the width and height of the picture in pixel are indicated and the resolution in
dpi. Underneath, the width and height of the picture are shown in millimeters.

Depending on the functions in the area general settings different effects are created.

Example 1

Following values have been set:

Pixel in X-direction = 1
Pixel in Y-direction = 10
Remaining width = 0
Contrast = 80
Minimum gray value = 0
Orientation = horizontal
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Negative = not active
Reverse direction = no active
Double = not active

Result

Fig. 8.16-6: Result from the value of example 1

Example 2

Following values have been set:

Pixel in X-direction = 3
Pixel in Y-direction = 15
Remaining width = 5
Contrast = 60
Minimum gray value = 0
Orientation = horizontal
Negative = not active
Reverse direction = not active
Double = not active
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Result

Fig. 8.16-7: Result from the value of example 2

With the 2 examples you can see that already small modifications of the values lead to big
discrepancies with the result.

Weeding aid

Create weeding aid

The stripes at the ends are automatically thickened so that the result can be wed faster.

Stripes per strap

In this field the number of stripes that shall contain a strap can be set.

Width of strap

In this field you define the width of a strap.

For information, underneath these fields the estimated number of objects is shown. This
is important to decide beforehand if the expenditure of time for the weeding is in a
responsible relation to the complexity. 
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Fig. 8.16-8: Example for stripes per strap, width of strap and stripes

The different modi

In the PhotoCUT dialog you can select between following modi: stripes, rhombuses,
circles, rectangles, single rhombuses, single circles, single rectangles.

With which mode you obtain the best and most attractive result depends strongly of the
used template. Templates rich in contrast are usually better suited for optically interesting
results.  

Tip: The screen does not always show a view that enables a reliable evaluation of
the results. Therefore, print the result on your printer. Now you can judge the result
of the procedure relatively exactly and do not risk to waste expensive material!
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9 The Sidebar

The Sidebar is switched on or off via the Window menu.
CTRL+2

9.1 Term Definition Sidebar

A "sidebar" means a lateral toolbar with tabs. It is comparable to the so-called docking
bars in CorelDRAW. In summary, we find the layer editing (formerly Layerbox), the clip art
manager, object manager, file manager, and the macros.

Functionality of the Sidebar for the user:

The Sidebar summarizes different tools. Previously distributed toolbars such as Layerbar,
Clipart Manager were combined in a compact tab structure. The sidebar serves as a
central element of the object management.

9.2 The Anchorage Control

Fig. 9.2-1: Anchorage control with arrow and dotted line for moving and placing

Note: Only in the docked state, the Anchorage control is activated and visible.
The Collapse Button

Pressing the Collapse button folds in the sidebar so that only the tab bar and the Unfold
button stay visible on the right side.

The Unfold Button

Enabling the Unfold button folds out the sidebar to the previous set size.

The Close Button

Pressing the Close button removes the sidebar from the program user interface.

The Dotted Line

The Dotted Line is used to move the entire sidebar. While the left mouse button is hold
down, the sidebar can be moved to any place. Double-clicking on the dotted line looses
the sidebar as well. Double-clicking on the head or moving the mouse towards the right
edge of the bar anchors the sidebar.
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The Tab Bar

Fig. 9.2-2: Tab bar with activated layer tab

The selection is done by clicking on the appropriate tab.

Note: The bar may include, depending on the program version more, less or other
than those shown tabs.

9.2 The Anchorage Control
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9.3 The Layer Tab

The Sidebar is switched on or off via the Window Menu. Selection using
the Layer tab. CTRL+2

The Layer area serves for the coloring of objects, the definition of foil colors, the selection
of objects that have a layer color, the locking and the hiding of color layers as well as the
allocation of output tools.

9.3.1 A) The Layer Area

9.3.2 B) The Layer Options

Fig. 9.3-1: The New button

This option generates a new layer an opens the corresponding dialog.

Fig. 9.3-2: The Sel(ect) button

This option selects the clicked Layer.

9.3 The Layer Tab
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9.3.3 C) The Palettes Options

Layer numbers

The activation of this option switches on or off the numbering next to the color bar.

9.3.3.1 Layer Info Dialog

Layer Info...

opens the following Setup Layer dialog.

Fig. 9.3-3: Setup Layer Dialog

When mouse over layer, show following info,

the activated information is shown in so-called Tooltip.

9.3.3 C) The Palettes Options
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In addition, the used part of color bar to this info %, number of visible layers can be
defined and the window width of the layer toolbar can be changed interactively.

9.3.3.2 Layer Order Dialog

Fig. 9.3-4: The Change Layer Order Dialog

The sequence of the layers can be changed arbitrarily. To do so, please use the up,
down, to top, to bottom button.

9.3.3.3 Only sel. layer visible

Only shows the objects that lie in the selected layer.

9.3.3.4 Del sel. layer

The activation of this option deletes the selected layer.

Note: This option can only be activated if no objects lie in this layer, if the layer is
unused.

9.3.3.5 Delete unused layer

All layers that do not contain any objects (unused) are deleted.

9.3.3 C) The Palettes Options
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9.3.3.6 New

This option generates a new color palette.

Note: 6 base layers will always be created. Order and color can be changed anytime.

9.3.3.7 Load

Previously defined palettes can be loaded.

9.3.3.8 Save

With this instruction a newly defined or modified palette is saved on your harddisk.

Note: If a new or changed palette is named 'Default', this palette is used at every
restart of EuroCUT.

9.3.3.9 Save as

This instruction allows the renaming of a palette name and save the palette using the new
name.

9.3.3.10 Default (History)

This instruction loads the color palette that is delivered as standard with EuroCUT. It is a
Mactac foil table.

History

This function facilitates the loading of the last color palettes. At the end of the menu list the
names of the last edited color palettes appear.

9.3.4 Status Indicator Layer

Fig. 9.3-5: Layer status view

Object in layer color

Is a layer marked with this symbol, it means that objects are in this color or layer
assignment exists. The selection is easiest using the  button.

9.3.3 C) The Palettes Options
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Not visible layer

Is a layer marked with this symbol, it means that objects in this color or layer assignments
are not visible at present. They exist and can be switched visible if needed. In general
layers are set to invisible, if they are obstructive while designing.

Locked layer

Is a layer marked with this symbol, it means that objects in this color or layer assignments
are locked, thus can not be edited, moved or scaled.

Tool assigned

If a layer is marked with this symbol, this means that a tool from the selected device driver
has been assigned to this layer. All objects that are in this layer are given out using this
tool.

Layer active but not occupied

Is a layer marked with a frame, it means that no objects are available in this color or layer
assignment, but the layer is active. Now, for example, objects can be filled with that color
or contour and layer assignments can be done. The number indicates the layer number
and the depth of arrangement.

Note: The term depth of arrangement means that objects with a lower number are
drawn before those with higher numbers. The layer order also has an influence on
the drawing sequence.

Object in layer and active

Is a layer marked with a frame and this symbol, it means that the layer is active and there
are objects in that color (or layer assignments) on the desktop. The number indicates the
layer number and the depth of arrangement.

Note: The term depth of arrangement means that objects with a lower number are
drawn before those with higher numbers. The layer order also has an influence on
the drawing sequence.

9.3.4 Status Indicator Layer
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9.3.5 I. Layer Settings Output Setup

Fig. 9.3-6: Layer Settings dialog with toll / mode list - Output setup

Note: Here the tool is assigned to the layer color - Red Cut Path - Tool TZ Cutting

9.3.5 I. Layer Settings Output Setup
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9.3.6 II. Layer Settings Color Setup

The following view appears after you press the color button.

Fig. 9.3-7: Layer - color, material name, color number and define properties - color setup

In the layer settings dialog the following three color models are available.

1. CMYK - Cyan, Magenta, Yellow, Kontrast
2. RGB - Red, Green, Blue
3. HSB - Hue, Saturation, Brightness

Layer button

Save

This instruction saves an additional layer containing individual settings.

9.3.6 II. Layer Settings Color Setup
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Insert

Inserts a layer into the Layer toolbar.

Delete

This instruction deletes a layer from the Layer toolbar.

Save palette

This option saves all modifications in the corresponding palette file into the pal subfolder.

Properties

Locked

Locked means that objects which are in this color layer can not be marked or selected. In
front of the locked layer appears symbolic a U-lock.

Not visible

Not visible lets disappear all objects from the desktop which are assigned to this layer. In
front of the not visible layer appears symbolic a stroked eye.

Note:  Both functions can be undone at any time by activating the layer settings
dialog using the right mouse button in the color bar. Now the resetting of properties
is possible.

Color

Material name

In the field Material name you can assign to a color layer an individual name.

Color number

In the field color number you can enter the name associated with this type of material or
color number.

Note: The advantage of the allocation of foil name and color number is that you can
assign all materials to color layers - tailored to your stock. In designing these
materials can be taken into account so that the assignment is visible during output.
For each choice of films or types of materials a palette that is used in the design can
be stored.

Output button

The activation of the output button switches to the Output setup.

Important note: This dialog is only enabled when this option was set in the driver!
Only then the output button appears.

9.3.6 II. Layer Settings Color Setup
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Spot color

The color name that is entered in this field is written into the output file if an EPS export is
done.

Note: Often, this option is used for the definition of cutting paths, or the spot color
is treated as a special channel in Photoshop.

Palette history

This function facilitates the loading of the last color palettes. At the end of the menu list the
names of the last edited color palettes appear.

Sel button

Fig. 9.3-8: Sel(ect) button

If the sel button is pressed all objects which lie in the selected layer are marked.

9.3.7 Hotkeys in the Layer Processing

The following hotkeys are available in the layer processing. 

Adjacent hotkey opens the Layer Settings dialog box L

Jump in the toolbar

POS 1 key Jump to the first layer
END key Jump to the last layer
PgUp key Jump to 1/10 of the total layer number
CURSOR up / down Jump to the next layer

Color assignment via the toolbar

Double-click assigns the layer color to marked objects
Double-click + CTRL
key

assigns to marked objects a pen contour in the active layer
color

Movement of single layers / modification of the sequence

1. Step: Position mouse cursor on wanted layer
2. Step: Press left mouse button and keep pressed
3. Step: Move layer to the wanted position
4. Step: Press once right mouse button
5. Result: The layer is at the new position

9.3.7 Hotkeys in the Layer Processing
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9.4 The Cliparts Tab

9.4.1 Clipart Management

The Cliparts tab is switched on or off via the window menu.

The Cliparts tab serves for the administration of your cliparts.

You can take these so-called cliparts from the wnate clipart group via drag &
drop to the EuroCUT working sheet and edit them further.

CTRL+2

9.4.1.1 Definition Clipart

What is a Clipart? Cliparts are objects, parts of jobs or whole jobs that have been added
to the cliparts tab. Cliparts serve primarily to direct and quick access to design elements.
As clip art is therefore virtually everything that is needed for quick or frequent job
generating, for example sign plates of different sizes, logos, design templates, and much
more.

Cliparts are similar to jobs in the handling.

Note: Aid lines are not saved.

9.4.1.2 Add Cliparts

Cliparts can be added via drag & drop or right mouse button context menu activation
submenu "Add Cliparts".

9.4.1.3 Delete Cliparts

Cliparts can be deleted from the group using the DEL key.

9.4.1.4 Definition Clipart Folder

Folder is the structural generic term. In a Clipart Folder, several Clipart Groups can be
included.

9.4.1.5 Definition Clipart Groups

Group is the structural generic sub term. Individual cliparts are collected in Clipart
Groups.

9.4 The Cliparts Tab
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Fig. 9.4-1: Clipart area with control elements

Fig. 9.4-2: Clipart info window

The Clipart info window is displayed if the mouse cursor whiles a short period of time
above the desired thumbnail.

9.4.1 Clipart Management
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9.4.1.6 Add Clipart Folder… Button

9.4.1.7 Settings Tab

Folder Field

The selected folder in the Folder field is added to the list of clip art management.

Monitor Folder Option

With this option, the directory monitoring is turned on, ie, whenever a new file is stored in
this folder, a thumbnail is created.

With Subfolders Option

All subfolders are included in the monitoring if this option is also enabled.

9.4.1 Clipart Management
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9.4.1.8 Macro Assignments Tab

Using the Macro Assignments tab events (e. g. double-click or enter key) can be
assigned to specific functions. The possible function assignments are listed in the
Available functions area.
Additionally functions can be added to the context menu via drag & drop. After this
procedure they are listed in the Current Functions area.

9.4.1.9 Create New Clipart Group… Button

Clipart Folder Field

In this field the name of a new clipart group can be entered.

9.4.1 Clipart Management
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9.4.1.10 Rename Clipart Group Button

Clipart Folder Field

Clicking on the ... button allows the selection of the clipart folder that should be renamed.

9.4.1.11 Edit Clipart Folder… Button

Folder Field

The directory field in the selected directory can be edited.

Monitor Folder Option

With this option the folder monitoring is turned on that is, every time when a new file is
stored in this directory a thumbnail is created.

With Subfolders Option

All subfolders are included in the monitoring if this option is also enabled.

9.4.1.12 Import Clipart Files… Button

By means of this function elder CLA files can be read. All previous versions of EuroCUT
used the cla file format when saving cliparts. This function converts them into the new
format.

9.4.1 Clipart Management
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9.4.1.13 Refresh Button

Rereads the clipart group and generates up to date thumbnails.

9.4.1.14 Save Changes Button

9.4.1.15

Saves the current state of the clipart management.

9.4.1.16 Diminish Presentation of Folder Levels… Button

Shortens the visible path by one folder level. This provides clarity in a complex and
widespread clipart folder structure.

9.4.1.17 Increase Presentation of Folder Levels… Button

The visible path is extended by one more folder level.

9.4.1.18 Common Settings… Button

Fig. 9.4-3: Setup dialog of the Clipart Manager

Thumbnails Tab

9.4.1 Clipart Management
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Compression

This option determines which compression rate will be used when generating preview
images (Thumbnails).

Priority

This option adjusts, how the thumbnail creation  behaves in relation to the main
application. The higher the priority, the more CPU time the process gets assigned.

Other Settings

Prefer contour mode image option

Enabling this option displays the thumbnails in contour mode i. e. without color fill -
analogous to the contour mode.

9.4.1.19 Number of Thumbnails per Line Button

9.4.1.20 Slider

The slider serves to determine the number of thumbnails that can be displayed in a line.
This is based on the current width of the sidebar. Here there are 6 thumbnails that are
displayed per line.

9.4.1.21 Show Name

This option shows in the activated state the name of the clipart file in addition to the
thumnbnail.

9.4.1.22 Thumbnail View / List View Button

9.4.1.23 Thumbnail View

9.4.1 Clipart Management
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9.4.1.24 List View

9.4.1.25 The Search Field

9.4.1.26 Search by File Name

By default, is searched in the order of the letters, how they are entered.

Note: Permitted are also wildcards such as * and ?. 

Example:

Be* - searches for all file names beginning with Be

B??ling - searches for all filenames that start with B, then have 2 characters in between
and end up with ling, such as Billing

9.4.2 The Context Menus

9.4.2.1 Context Menu 1

Description of menu items: please refer to 9.4.1.6: Add Clipart Folder… Button ff

9.4.2.2 Context Menu 2

Description of menu items: please refer to 9.4.1.6: Add Clipart Folder… Button ff

9.4.2.3 Context Menu 3 Search Field

9.4.1 Clipart Management
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9.4.2.4 Context Menu 4 Clipart

9.4.2 The Context Menus
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10 Add Ons

10.1 The PhraseWriter

The PhraseWriter is an application that creates and administers text modules - also
independent from EuroCUT. These text modules can be inserted in active applications.

10.1.1 How to build Text Modules?

Step 1: In the left category field activate the context menu with the right mouse button and
create a "new entry" with the new-instruction and name the new text module.

Step 1a: If step 1 is repeated before a text was entered in the text module edit field, a
folder, a so-called category, is created in the tree structure!

Step 2: Enter a text in the text module edit field via the keyboard or insert a text from
Windows clipboard.

Step 3: Allocate a name for the XML file with the menu entry file, save as.

10.1.1.1 Category selection in minimized status:

The selection is done via the context menu (right mouse button) in the Windows info bar.
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Fig. 10.1-1: Main dialog with tree structure of the categories, text module-entries (left), text
module-edit field and list of variables (right)

10.1.2 The Icon In The Windows Info Bar

Fig. 10.1-2: Icon in the Windows info bar

The icon above is the central control element if the main dialog of the PhraseWriters was
minimized. A double click on the icon reactivates the main dialog and shows the window in
the foreground. A click with the right mouse button on the icon activates the context menu
in the info bar.

10.1.3 The Context Menu In The Info Bar

Via the option add entry all categories (folders) with text modules are shown.

10.1.1 How to build Text Modules?
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Fig. 10.1-3: Context menu of the icon in the info bar (right mouse button)

10.1.3.1 Add entry

This option creates a new category with text modules.

Categories

This option lists all available text module files (*.xml).

Settings

This option opens the main dialog and moves the cursor into the right input window - ready
for entering a new text module.

Quit

This option ends the application.

10.1.4 The Settings Window

Fig. 10.1-4: Setup dialog with shortcuts

Textfile

By means of the … button the path of a text module file (*.XML) can be set.

10.1.3 The Context Menu In The Info Bar
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Shortcut

Via the keyboard a shortcut for the PhraseWriter can be defined.

Language

This option allows the change of the language if translations are available for the
PhraseWriter.

Start with Windows

If this option is activated, the PhraseWriter is started automatically at every new start of
Windows. The icon is - down right -in the info bar of the Windows desktop.

Show tooltip

If this option is activated, an explaining info text is shown when moving the mouse cursor
above the buttons.

Insert formatted text

If this option is activated, also formatted texts from the Windows clipboard are inserted.

Fig. 10.1-5: Toolbar

The sequence of the buttons from left to right: new, open, save, move upwards, move
downwards, settings

10.1.4.1 The context menu left

Fig. 10.1-6: The context menu of the category and text modules entries

Rename

This option allows renaming categories or text module entries.

New

This option creates a new text module entry. Repeating this instruction immediately
creates a folder, a category in the tree.  

10.1.4 The Settings Window
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Copy

This option creates a copy with the same name of a category or a text module entry.

Delete

This option deletes a category or a selected text module entry.

Attention: when deleting no direct safety inquiry is done. Only when quitting you are
asked if the carried out modifications shall be saved. If this question is answered
with "yes" the deletion cannot be made undone.

Sort

This instruction sorts all entries of a selected category ascending, from A to Z.

Sort all

This instruction sorts all entries of all categories ascending, from A to Z.

10.1.4.2 The context menu right

Fig. 10.1-7: The context menu in the text module edit field

Cut

This instruction cuts a marked text part and puts it into the Windows clipboard. 

Copy

This instruction copies a marked text part and copies it into the Windows clipboard. 

Paste

This instruction pastes a text part from the Windows clipboard to the edit field.

10.1.4 The Settings Window
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Font

This instruction opens the font dialog and modifies the font of a marked text.

List of variables

The selection of a variable is done with a mouse click. After clicking they are inserted in
the text module entry field.

Variables

In this field all available variables are listed. Right next to the name of the variable an
example with the respective formatting are shown.

10.1.5 Reference Part PhraseWriter

10.1.5.1 The File Menu

10.1.5.1.1 The New Command

With the new instruction a new XML file is being created. CTRL+N

10.1.5.1.2 The Open Command

With the open instruction a new XML file is loaded. CTRL+O

10.1.5.1.3 The Import Command

With the import instruction a XML file is imported into an already loaded file. CTRL+I

10.1.5.1.4 The Save Command

With the save instruction a XML file is saved on a data carrier. CTRL+S

10.1.5.1.5 The Save As Command

With the save as instruction a XML file is saved under a new name.

10.1.5.1.6 The Quit Command

With the quit instruction the PhraseWriter is terminated. ALT+F4

10.1.5.2 The Edit Menu

10.1.5.2.1 The Rename Command

With the rename instruction text module categories and text modules can be
renamed.

10.1.5 Reference Part PhraseWriter
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10.1.5.2.2 The New Command

With the new instruction a new entry in a text module category is created.

10.1.5.2.3 The Copy Command

With the copy instruction a new entry with the same name is created in the
activated text module category.

10.1.5.2.4 The Delete Instruction

With the delete instruction an entry is deleted from a text module category.

10.1.5.2.5 The Sort Command

With the sort instruction the entries of a text module category are sorted
ascending from A to Z.

10.1.5.2.6 The Sort All Command

With the sort all instruction all entries of all text module categories are
sorted ascending from A to Z.

10.1.5.3 The Settings Menu

10.1.5.3.1 The Standard Settings Command

With the standard settings instruction the dialog for setting the
PhraseWriter parameters is opened.

In detail: please refer to 10.1.1: How to build Text Modules?

10.1.5.3.2 The Default Font Command

The default font instruction opens a dialog in which the display font for the
PhraseWriter can be determined.

10.1.5.3.3 The Window List Command

The window list instruction opens a dialog in which all currently opened
application windows are listed. All selected windows are ignored by the
PhraseWriter.

10.1.5.4 The Help Menu

10.1.5 Reference Part PhraseWriter
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10.1.5.4.1 The Help Command

With the help instruction the PhraseWriter help is loaded. F1

10.1.5.4.2 The About… Command

With the about instruction a window is opened in which the version and a
link to the manfufacturer's website is shown.

10.1.5 Reference Part PhraseWriter
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10.2 Fontmanager

For Type 1, TrueType, and BE fonts with an own database management

Fig. 10.2-1: EuroCUT Fontmanager with database, TrueType, and Type1 font lists window

10.2.1 What Can The Fontmanager?

Preface

The Fontmanager for TrueType, Type 1 and URW BE fonts works database-oriented, i.e.
the fonts are installed only once from any data medium in any font database.
Subsequently, the files belonging to a font are no longer needed. When generating a font
database, for example in a network environment, all the fonts will be available to all users.
It is no longer necessary for every user to keep or maintain font files locally on his hard
disk.

The number of installed fonts is limited only by the available disk capacity. Fonts can be
grouped into different databases. Once installed fonts are available at any time even if
Jobs are loaded which include fonts which are not active at the moment.

10.2 Fontmanager
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10.2.1.1 Performance Characteristics (PC)

What can such a tool, or in other words, for what do you need such a tool?

The following features will shed light on the key features that describe the use of such a
tool, and should demonstrate their value.

10.2.1.1.1 PC1: Font Databases for TrueType, OpenType, Type 1, and BE*
Font Formats

For the 3 above mentioned font formats, you can create your own databases. It serves for
clarity and it is advantageous if the change between different formats and databases at
any time is possible.
All fonts can be used in different formats for job preparation.

*) A font format of URW Signus.

10.2.1.1.2 PC2: Font Management

Font Management means adding, activating, deactivating, duplicating, exporting and
importing of fonts.

10.2.1.1.2.1 Advantages of the EuroCUT font management:

- All fonts are inserted into the EuroCUT font list at run time.

- There is a central place to manage "font matters".

- In addition to the Windows font management, you have the possibility to create custom
categorization of fonts such as script, sans serif, roman, etc..

- If necessary, any font can be enabled or disabled. This is for the clarity of the font list.

10.2.1.1.3 PC3: Kerning - Kerning Editor With Inter-Active Interface

With the Kerning Editor the character spacing in fonts can be changed permanently. This
is usually necessary when in the production of fonts no such kerning pairs were
generated. The number of existing kerning pairs is a quality criterion for fonts.

10.2.2 Toolbars

10.2.2.1 The File Toolbar

10.2.1 What Can The Fontmanager?
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10.2.2.1.1 The New Button

By means of activating the New button you can create a new font database. Along with the
name type and folders can be specified.

10.2.2.1.2 The Open Button

By means of activating the Open button you can open a font database. All existing links
will be displayed in a list.

10.2.2 Toolbars
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10.2.2.1.3
The Import Button

By means of activating the Import button a font database can be imported.

10.2.2.1.4 The Clipboard Button

Enabling the Clipboard button opens a window with the content of the clipboard. By
means of the clipboard fonts can be transferred from one database into another.

10.2.2.1.5 The True Type Font Window Button

Enabling the True Type Font Window button open a window with all installed TrueType
fonts.

10.2.2.1.6 The Adobe Type 1 Font Window Button

Enabling the Adobe Type 1 Font Window button open a window with all installed Type
1 fonts.

10.2.2 Toolbars
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10.2.2.2 The Font Toolbar

10.2.2.2.1 The Add Button

Fig. 10.2-2: Add fonts

Enabling the Add button opens the window, in which the choice to install fonts is possible.
The selection of font file formats may vary depending upon the choice of the database.
The selection is made by clicking on the desired fonts. With CTRL + click a single font (see
figure) can be selected with SHIF + click additionally other fonts can be selected.

10.2.2.2.2 The Activate Button

Fig. 10.2-3: Activate fonts

A click on the Acitvate button makes the selected font in EuroCUT usable. Afterwards it is
listed in the list of useable fonts.

10.2.2 Toolbars
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The first four fonts are de-activated und can be activated using the Activate button, i.e.
can be used in the EuroCUT text editor.

10.2.2.2.3 The Deactivate Button

Fig. 10.2-4: Deactivate fonts

A click on the Deactivate button deletes the selected font in the EuroCUT font list. This
function is the reverse function of the activate function.

10.2.2.2.4 The Rename Button

Fig. 10.2-5: Rename fonts

By means of activating the Rename button a font can be renamed. This is particularly
useful if the Fonthersteller has used other names than the industry name or if instead of
font names digits were used.

10.2.2 Toolbars
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10.2.2.2.5 The Duplicate Button

Fig. 10.2-6: Duplicate fonts

Acitvating the Duplicate button doubles the font entry in the database and allows
renaming. The dupicated font now can be moved into another database.

10.2.2.2.6 The Search Button

Fig. 10.2-7: Search fonts

With this option in the activated database window can be searched for fonts. It can be
searched by file name or font name. Additionally the search for font weights (bold, italic) is
possible. The result ist displayed in a separate font window.

10.2.2.2.8 The Export Button

Fig. 10.2-8: Export fonts

Enabling of the Export button opens the following dialog.

10.2.2 Toolbars
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10.2.2.2.9 The Import Button

Fig. 10.2-9: Import fonts

Enabling this button opens a dialog in which you can select the folder, where the to import
fonts are located. Valid file formats are: *.ECF, *.MDB and *.DBF.

10.2.2 Toolbars
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10.2.2.2.10 The Preview Button

Fig. 10.2-10: Font preview

A click on the Preview button opens the font preview window. It shows - in an enlarged
bitmap view - how the selected font looks like.

Note: The font preview window can also be activated by double clicking on the
desired font.

Note: + and - on the num keyboard increases resp. decreases the view in the font
preview.

10.2.2 Toolbars
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10.2.2.3 The Clipboard Toolbar

Its functionality is comparable with the Windows Clipboard.

10.2.2.3.1 The Cut Button

Activating the Cut button deletes the selected font from the list and copies it into the
clipboard.

10.2.2.3.2 The Copy Button

Activating the Copy button copies the selected font into the clipboard.

10.2.2.3.3 The Paste Button

Activating the Paste button inserts the selected font from the clipboard into the selected
database.

10.2.2.3.4 The Delete Button

Activating the Delete button removes the selected font or fonts from the database.

10.2.2.3.5 The Undo Button

Activating the Undo button resets into the state ahead of the last action.

10.2.3 Reference Section

10.2.3.1 The File Menu

10.2.2 Toolbars
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10.2.3.1.1 The New Command

With the New command a new database can be generated. CTRL+N

In addition to the name of the database, its type and destination folder can be specified
too.

10.2.3.1.2 The Open Command

With the Open command a database can be opened. CTRL+O

The to open database can be chosen from a list, that lists all existing font databases.

10.2.3 Reference Section
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10.2.3.1.3 The Clipboard Command

With the Clipboard command fonts can be transferred from one database
into another.

ALT+Z

The clipboard can contain one ore more fonts. The selection of the fonts is done by
marking the fonts in a font window.

10.2.3.1.4 The Windows Fonts Command

10.2.3.1.4.1 The Adobe Type 1… Command

The Adobe Type 1 command opens a window in that will be listed all available fonts in the
Type 1 file format. This fonts can be used in EuroCUT and are listed in the list of font
types.

10.2.3 Reference Section
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10.2.3.1.4.2 The TrueType… Command

The True Type command opens a window in which will be listed all True Type fonts that
are available. This fonts can be used in EuroCUT, if the Use True Type Fonts option was
enabled in the Text menu.

10.2.3 Reference Section
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10.2.3.1.4.3 Der OpenType… Command

The OpenType instruction opens a window, that lists all in your windows system available
fonts in the OpenType file format.

10.2.3.1.4.4 The TrueType and OpenType… Command

The TrueType and OpenType instruction opens a window, that lists all in your windows
system available fonts in the OpenType and TrueType file format together in one font
window.

10.2.3 Reference Section
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10.2.3.1.5 The Font Folders Command

10.2.3.1.5.1 The URW / BE… Command

This instruction serves opening and listing of fonts in the URW BE file format in a new font
window. After selecting the appropriate folder, in which the fonts are located, a window
with these fonts is displayed. Then you can select these fonts and copy them in another -
mostly a standard font window - to activate them.

10.2.3.1.5.2 The Adobe Type 1… Command

This instruction serves opening and listing of fonts in the Type 1 file format in a new font
window. After selecting the appropriate folder, in which the fonts are located, a window
with these fonts is displayed. Then you can select these fonts and copy them in another -
mostly a standard font window - to activate them.

10.2.3.1.5.3 The TrueType and OpenType… Command

This instruction serves opening and listing of fonts in the Type 1 file format in a new font
window. After selecting the appropriate folder, in which the fonts are located, a window
with these fonts is displayed. Then you can select these fonts and copy them in another -
mostly a standard font window - to activate them.

10.2.3.1.6 The Quit Command

The Quit command finishs the program. ALT+F4

10.2.3.2 The Edit Menu

10.2.3.2.1 The Cut Command

The Cut command deletes the selected font in the active font window and
copies it into the Clipboard for re-usage.

CTRL+X

10.2.3.2.2 The Copy Command

With the Copy command the selected fonts in the active font window are
copied into the Clipboard for re-usage.

CTRL+C

10.2.3.2.3 The Insert Command

The Insert command puts the content of the Clipboard into the active font
window.

CTRL+V

10.2.3.2.4 The Delete Command

The Delete command removes the selected fonts in the active font window. DEL

10.2.3 Reference Section
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10.2.3.2.5 The Delete All Command

The Delete All command removes all selected fonts in the active font window.

10.2.3.2.6 The View Menu

10.2.3.2.6.1 The Symbols Submenu

The Symbols submenu entry allows the setting of the size of the symbols ahead of the
font name in the font window.

10.2.3.2.6.2 The Small Command

The Small command sets the symbols at a size of 16 x 16px.

10.2.3.2.6.3 The Middle Command

The Middle command sets the symbols at a size of 24 x 24px.

10.2.3.2.6.4 The Large Command

The Large command sets the symbols at a size of 32 x 32px.

10.2.3.2.6.5 The Extra Large Command

The Extra Large command sets the symbols at a size of 48 x 48px.

10.2.3.2.6.6 The Checkmarks Command

The Checkmarks command switches the Checkmarks symbol on resp. off.

10.2.3.2.6.7 The Font Names Command

With the Font Names command only font names are displayed in the font window.

10.2.3.2.6.8 The Font + File Name Command

With the Font + File Name command additionally to the font names their file names are
displayed too.

10.2.3.2.6.9 The File Name Command

With the File Name command only the font's file names are listet in the font window.

10.2.3.2.6.10 The Postscript Name Command

With the Postscript Name command the font's Postscript names are listet in the font
window.

Note File name, font name and Postscript name of a font can be different. Which
name is displayed depends on personal preference.

10.2.3 Reference Section
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10.2.3.2.6.11 The Reset Command

The Reset command sets the display in the Font window back to its initial state.

10.2.3.2.7 The Selection Menu

10.2.3.2.7.1 The Select All Command

The Select All command marks all fonts in the active font window.

10.2.3.2.7.2 The Reset Command

The Reset command sets the view of the font window back into its intial state.

10.2.3.2.7.3 The Invert Command

The Invert command reverses the selection state, that means, that all marked fonts will be
deselected and all unmarked fonts will be selected.

10.2.3.2.8 The Sort Menu

10.2.3.2.8.1 The Ascending Command

The Ascending command sorts all entries of the font window from A to Z.

10.2.3.2.8.2 The Descending Command

The Descending command sorts all entries of the font window from Z to A.

10.2.3.2.8.3 The Sort Case-Sensitive Command

If this option is enabled, the case sensitivity is taken into account when sorting.

10.2.3.3 The View Menu

10.2.3.3.1 The Menu Bar Command

The Menu Bar command switches the menu bar off.

Note: The menu bar can be switched on again using the context menu of the
program bar.

10.2.3.3.2 The Status Bar Command

The Status Bar command switches the info line, which is located at the bottom of the font
window, on resp. off.

10.2.3 Reference Section
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10.2.3.3.3 The Themes Command

This menu item allows the selection of so called themes or skins, which determine the
appearance of the application regarding color, background and buttons. The user can
select a theme that suits his personal taste. 

10.2.3.3.4 The Symbol Bar Command

The Symbol Bar menu entry manages the view of the toolbars.

10.2.3.3.4.1 The File Command

The File command switches the File tool bar on resp. off.

10.2.3.3.4.2 The Font Command

The Font command switches the Font tool bar on resp. off.

10.2.3.3.4.3 The Clipboard Command

The Clipboard command switches the Clipboard window on resp. off.

10.2.3.3.4.4 The Miscellaneous Command

This command shows or hides the Miscellaneous toolbar. 

10.2.3.4 The Font Menu

10.2.3.4.1 The Preview Command

The Preview command opens the font preview window. It shows in an
enlarged bitmap view how the selected font looks.

F5

Note: The Font Preview window can also be enabled by a doubleclick on the desired
font. With the "+" and "-" key on the num keypad the view of the font preview can be
enlarged or diminished.

10.2.3.4.2 The Character Table Command

This command switches the character table of the selected font on or off.

10.2.3 Reference Section
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10.2.3.4.3 The Add Command

The Add command opens the window in which the selection of the to install fonts is
possible. The selection of the font formats may vary depending upon the choice of the
database. The selection is made by clicking on the desired font. Using CTRL+click
individual fonts (see figure) can be selected. Using SHIFT+click sequences of fonts can be
marked.

10.2.3.4.4 The Duplicate Command

The Duplicate command doubles a font entry in the database and allows renaming. The
duplicatd font now can be moved into another database.

10.2.3.4.5 The Rename Command

Using the Rename command a font can be renames. This is particularly useful, when the
font manufacturer uses a font name which is not the font's industry name or if he uses
digits instead of font names.

10.2.3 Reference Section
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10.2.3.4.6 The Search Command

With the Search commad a font search in the active database window can
be done. Criteria can be file name or font name. Additionally the search of
type faces (bold, italic) is possible. The search result is displayed in a
separate font window.

CTRL+F

10.2.3.4.7 The Export Command

With the Export command fonts can be exported into the *.ECF file format. CTRL+E

10.2.3 Reference Section
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10.2.3.4.8 The Import Command

With the Import command external databases can be imported. This
function is to ensure that, on multiple computers in a company, the same
font stock can be used.

ALT+I

After confirmation of the Open button, this import file is read. The information contained
in this file are displayed in a font list. The to import fonts can be selected.

10.2.3 Reference Section
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10.2.3.5 The Link Menu

10.2.3.5.1 The Rename Command

With the Rename command a database can be renamed.

10.2.3.5.2 The Delete Command

The  Delete command removes the selected database.

10.2.3 Reference Section
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10.2.3.5.3 The Set as Default Command

The Set as Default command defines a standard database that is, these fonts are made
available at startup.

10.2.3.5.4 The Font Database Menu

10.2.3.5.4.1 The Add Command

This instruction open an existing database and inserts it into in the management as a new
link.

10.2.3.5.4.2 The Copy Command

This instruction copies the database of the aktive linkage into another folder.

10.2.3.5.4.3 The Delete Command

This instruction removes an existing database linkage.

10.2.3.5.4.4 The Compress Command

The Compress command rectifies the selected database. While compressing the index is
reorganized, the to delete marked entries will be deleted, ... After compressing, the size of
the database file will be smaller than before.

10.2.3.6 The Miscellaneous Menu

10.2.3.6.1 The Settings Command

With the Settings command ... ALT+F7

10.2.3 Reference Section
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10.2.3.6.2 The Open Font File Command

With Open font file command a font file in the *.PFM, *.TTF, *.OTF, *.BE can be opened.

10.2.3.6.3 The Default Link Command

With Default Link command a database link can be defined as default. This link then used
when the program starts. As result of this operation it is set, which fonts are available after
starting the program.

10.2.3 Reference Section

332



10.2.3.6.4 The Global Font Search Command

With the Global Font Search command will be searched for a particular
font in all database links of the selected type.

SHIFT+F7

10.2.3.6.5 The Use Fonts Command

10.2.3.6.5.1 The Windows TrueType Fonts Command

This option switches the usage of fonts in the TrueType font format on or off.

10.2.3 Reference Section
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10.2.3.6.5.2 The Windows Adobe Type 1 Fonts Command

This option switches the usage of fonts in the Adobe Type 1 font format on or off.

10.2.3.6.5.3 The URW / BE Database Fonts Command

This option switches the usage of fonts in the URW / BE Database font format on or off.

10.2.3.6.5.4 The Adobe Type 1 Database Fonts Command

This option switches the usage of fonts in the Windows system using the Adobe Type
1 Database fonts on or off.

10.2.3.6.5.5 TrueType Font Files

The Use TrueType Font Files Menu Entry

Switches the usage of in the Windows system installed TrueType font files on resp. off.

The Properties Menu Entry

This menu item applies only to Windows fonts. Other directories as the Windows font
directory can also be used, but only temporarily for the session of EuroCUT Basic 8,
where as they are not installed in the Windows system.

Advantage: You can work with the fonts just as if they were installed.

10.2.3.6.5.6 Adobe Type 1 Font Files

The Use Adobe Type 1 Font Files Menu Entry

Switches the usage of in the Windows system installed Adobe Type 1 font files on resp.
off.

The Properties Menu Entry

This menu item applies only to Windows fonts. Other directories as the Windows font
directory can also be used, but only temporarily for the session of EuroCUT Basic 8,
where as they are not installed in the Windows system.

Advantage: You can work with the fonts just as if they were installed.

10.2.3.6.6 The Windows Character Sets Command

10.2.3.6.6.1 The Adobe Type 1 Fonts… Menu Entry

10.2.3 Reference Section
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Using this option an other character set for an in your Windows system installed Adobe
Type 1 font can be chosen. This new selected character set is used for the display on your
EuroCUT desktop.

10.2.3.6.6.2 The TrueType / OpenType Fonts… Menu Entry

Using this option an other character set for an in your Windows system installed
TrueType/OpenType font can be chosen. This new selected character set is used for the
display on your EuroCUT desktop.

10.2.3.7 The Window Menu

10.2.3.7.1 The Close Command

With the Close command the active window is closed. CTRL+F4

10.2.3.7.2 The Close All Command

The Close All command closes all open font windows.
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10.2.3.7.3 The Next Command

With the Next command can be switched to the next open font window. CTRL+F6

10.2.3.7.4 The Previous Command

With the Previous command can be switched to the previous open font
window.

SHIFT+F6

10.2.3.7.5 The Arrange Symbols Command

The Arrange Symbols command arranges all symbols at the bottom of the window.

10.2.3.7.6 The Cascade Command

The Cascade command let overlap the font windows.

10.2.3.7.7 The Split Vertical Command

The Split Vertical command divides the working sheet vertical in as many equal parts, as
how many font windows are open, and and displays them side by side horizontally.

10.2.3.7.8 The Split Horizontal Command

The Split Horizontal command divides the working sheet horizontal in as many equal
parts, as how many font windows are open, and and displays them side by side vertically.

10.2.3.7.9 The List of Open Windows

In this list all font windows are displayed, that are open. A click switches any window into
the foreground.

10.2.3.7.10 The Font Window Command

Activation of the Font Window command open a window, which list all active databases
resp. font windows. The Activate button enables the selected font database, that means,
that the database can be used in EuroCUT.

10.2.3 Reference Section
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10.2.3.8 The Help Menu

10.2.3.8.1 The Info Command

The Info command informs about the version status of the software. In addition, data are
made with regard to memory size and usage.
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10.2.4 The Context Menus

10.2.4.1 The Context Menu in The Program Header

The Context Menu in The Program Header is enabled using the right mouse button in
the upper area of the program window. Using this context menu, menu line and
toolbars can be individually enabled or disabled.

10.2.4.2 The Context Menu in The Database Window

The Context Menu in The Database Window is enabled, by clicking with the right
mouse button in the area beside the font name. Using this context menu functions can be
selected, which are also present in the menus. Each particular function are described in
detail in the reference section of this manual.

10.2.4 The Context Menus
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11 Tips & Tricks - Trouble Shooting

Often, it is just a bagatelle that makes the "implementation" of new software
difficult. Similar to a new machine, there are questions and problems with new software
that often can be explained and solved easily. Therefore, we have explained a selection of
questions that occur daily at our hotline- and support routine more closely.

11.1 Code is not accepted with Windows 7, 8, 10 or 11 (No
Dongle)

Error message: Invalid code or after each program start the code must
be entered again

The program must be executed once with aministrator rights. Click with the
right mouse button in the program menu on EuroCUT Basic 8 and select
"Execute as administrator".

Note: Don't change anything on the given activation data resp. license
data.

Tip 1

11.2 Buffer Overflow Serial Port

The cutter cuts the first characters neatly and then starts to draw
indefinable curves. 

With serial activation of the cutter, this is a typical buffer overflow problem
and occurs if the protocol for the serial transfer is not set correctly. Most
cutters are activated with the following parameters with a serial data
transfer: bits per second: 9600, data bits: 8, parity: none, stop bits: 1,
protocol resp. flow control: hardware

Tip 2

11.3 Output Size Mimaki

The output size on a Mimaki cutter does not correspond with the
configured size but is more than twice as big.

The Mimaki cutter of the CG series is delivered ex works with a plot
resolution of 0.025 mm even if they can work with a resolution of 0.01 mm
and do so internally. The drivers of EuroCUT are set to these
„device”-resolution because the cutters can be activated faster and more
accurate.
For the adjustment of this plot resolution you switch on the cutter, press the
< button at the control panel and after the cutter has measured the roll you
press the function key until "interface" appears in the display. Then, you
press the ENTER key until you reach the menu item "Stepsize" and then the
^-button. The display now shows „0.01”. Confirm the selection with ENTER
and END.

Tip 3
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11.4 Output Size Graphtec

The output size on my Graphtec cutter does not correspond with the
configured size but is more than twice as big.

Setting the step size:

In the GP-GL mode it is possible to set the minimal distance of the cutting
knife's path to one of the following widths: 0.01 mm, 0.025 mm, 0.05 mm or
0.1 mm. The default setting is 0.1 mm. This value must be changed, if your
program's driver uses another step size.

Step 1: Switch into the command mode "GP-GL".

Step 2: Press the enter key; the menu step size appears.

Step 3: Press , key to select the desired value (0.100 mm, 0.050 mm, 0.025
mm, or 0.010 mm) and confirm with enter key. Press (NEXT) or (PREV.)
to undo your selection.

Step 4: Press (PAUSE) key in order to cancel the PAUSE mode.

In the case of controlling the plotter from EuroCUT, the value of the step
size must be set to 0.025. This is the resolution which is preconfigured in the
drivers.

Tip 4

11.5 Calibration of the Output Size

Problem: The size entered in the software and the output size of the
objects do not match.

Solution: Calibration must be performed on the connected cutter.
Calibration means: checking and, if necessary, changing the values stored
in the driver to the values you have measured.

Method:

Activate the following dialog in the Settings / Standard Settings / Output
Devices... menu.

Tip 5

11.4 Output Size Graphtec
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Clicking the Calibrate button opens the Calibrate Device dialog.

11.5 Calibration of the Output Size
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Now carry out the calibration step by step.

Step 1: Specify the size of the rectangle to be output. Get the cutter ready
for output. Start the output by clicking on the Rectangle button.

Step 2: Weed the rectangle and measure it with a ruler. Enter the measured
values in the Length (X) and Width (Y) fields under Measure (Step 2). Then
click on the Calibrate button. The new values are now entered into the
driver.

Note: You can repeat this process. The maximum accuracy to be
achieved depends only on the connected device. Low-cost devices
often only achieve an accuracy of +/- 0.5 mm. Professional vinyl
cutters achieve an accuracy of ≥ +/- 0.1 mm.

11.6 Computer without serial COM port

My computer provides no serial COM port, but a USB port. How can I
connect my cutting plotter, which provides only a serial interface?

In this case there is a computer accessory called - USB serial adapter-  that
provides one or more serial COM ports on one USB port.

Tip 6
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Note: Not all adapters offered work properly, especially the use on
64-bit operating systems is sometimes not free from errors. It may be
that different adapters must be tried.

11.7 Tracing (Vectorization)

Which resolution should be used when tracing to get a good tracing
result?

You should use the optical resolution (i.e. 600 dpi) of the scanner if you have
qualitative good templates. Please consider not confusing this with the
highest possible resolution as most of the scanners can transfer nowadays a
resolution more than twice as high (interpolated). This may be a quality
advantage for scans of photos but it is not convenient for the tracing. Very
small originals (i.e. logos on business cards) should first be enlarged with a
photocopy machine and then scan. With bad originals you should use a
smaller resolution.

Tip 7

11.8 Cutter Does Not Respond!

a. First check if you have selected the correct cutter driver and the correct
port: for example <device name> at COM2 in the EuroCUT cutting dialog

b. COM connection: Check if the parameters of the port are set correctly. To
do so, call up the system control of Windows. In the device manager, select
the corresponding connection, for example: COM.

Popular standard parameter are: Baud: 9600, data bits: 8, parity: none, stop
bit: 1, protocol / flow control: hardware

The settings in the system control and at the cutter must be identical
otherwise no or only faulty data transfer will take place.

c. USB connection: Check if the correct USB driver is installed for the
device. The settings are in the Windows device manager under USB
controller. The USB driver for the cutting cutter must be entered in this list
otherwise no activation is possible.
If the USB driver does not appear there, install it from the delivered data
carrier of your device.

d. Original cable: Check if you use the original cable recommended by the
manufacturer. If this is not the case, there might be bigger problems during
the data transfer. EuroCUT „communicates” during the data transfer with the
cutter so that missing or faulty connected data cable with the cutter lead to
input or output errors.

Tip 8
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11.9 Buffer Overflow

The cutter reports „buffer overflow” or does not cut the whole job

This is often because of an incorrect setting of the used protocol of the serial
(COM) port. In most cases it is sufficient to set the protocol respective the
flow control of the port to hardware.

Tip 9

11.10 Fonts and Windows 10 / 11

Fonts are present in the font list, but are not displayed on the working
sheet.

Select the font(s) you want to install in the Windows Explorer, then right-click
and select the Install for all users option.

Important note: This operation cannot be performed in the Font folder.
The fonts must be first copied into another folder and the installation
process must be carried out from the "other" folder as described
above.

Tip 10

11.11 Script Font Welding

The automatic welding of script fonts does not work as expected

The success rate with the automatic welding increases clearly if the letter
spacing is reduced from 100% to 99.9% or even 99%. This results in the fact
that two nodes that lie mathematically exactly on top of the other can be
slightly moved so that they can be "identified" as two dots.

Indication: Another possibility is the modification of the kerning in the
Fontmanager for Adobe fonts with which problematic kerning pairs
can be edited.

Tip 11

11.12 Generate Circle Segments

With the construction of logos or signets often circle segments are needed.
They can be created as follows with the help of node editing function.
please refer to 7.4: The Node Toolbar

draw a circle with the wanted radius or diameter•   
mark all nodes with the node tool•   
double click on the origin•   
select separate•   

Tip 12
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Afterwards, all circle segments are available and can be selected with the
arrow tool. 

11.13 Data Import From Apple Computers

Data import from Apple computers in EuroCUT

When exporting Apple data you have to pay attention to some settings to
have a perfect data export. All popular Apple compatible illustration and
graphic applications can export EPS data. (Illustrator, Freehand, …)

For the contours, as line width only hairline (0.01 mm) must be
entered.

1. 

No fillings should be transferred.2. 
All texts must be converted to graphical objects. (text in curves)3. 
Grouped or combined objects must not be available. (break up
before)

4. 

Especially with the Freehand-export the export filter for the
Illustrator-format must be selected.

5. 

As file name extension .eps should be used and you should not
use umlauts as ü, ä, ü.

6. 

Tip 13

11.14 Typical Sources of Errors When Cutting

a) The foil is clamped too loose

Consequence: the knive moves the foil during the cutting and the contour is
not closed completely.

Remedy: when inserting the foil pay attention that the foil is clamped evenly
and does not undulate.

b) The speed is too high

Consequence: small foil parts especially serifs and counters are
unscrewed.

Remedy: reduce speed and lower the pressure.

c) The tool pressure is too high

Consequence: the release paper is also carved, character parts are
unscrewed and parts of the release material get stuck at the characters. The
weeding of the foil gets more difficult.

Remedy: reduce pressure and correct the depth of the knife if necessary.

Tip 14

11.12 Generate Circle Segments
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d) The tool pressure is too low

Consequence: foil and adhesive were only partly cut through. The weeding
is possible only with difficulty or not at all.

Remedy: increase the pressure and correct the depth of the knife if
necessary.

e) The knife is set too deep

Consequence: foil, adhesive and release material were cut. Foil cannot be
used any more.

Remedy: correct the setting of the depth of your cutting knife.

f) The knife is used up

Consequence: only the foil and not the adhesive is cut through.

Indication: when using standard foil the using up of the knife is little.
When using reflection or sandblast foil the using up is much higher.

Remedy: use new original knife.

g) The characters were unscrewed

Consequence: The weeding border is possible only with difficulty. The
unscrewed parts stick to the foil and cannot be detached any more.

Generally is presumed: the smaller the font size the thinner the foil must be;
the adhesive force of the gluten is higher.

Remedy: reduce the speed and if necessary the tool pressure until this
effect does not occur any more.

h) The release paper is also cut

Consequence: the release material sticks to the foil. The weeding is
possible only with difficulty or not at all.

Remedy: correct the setting of the depths of the cutting knife and also
reduce if necessary the tool pressure.

11.15 Plotter Via USB Is Not Working!

Error message: Cannot open interface!

Check first, if your cutter is listed in the Device Manager (Control Panel /
System / Device Manager). If not, reinstall the device driver as described in
the plotter manual.

Tip 15
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Check then, if the USB port for your cutter is selected in the EuroCUT
Device Settings. You'll find the Device Settings window in the Settings /
Common Settings / Devices menu.

Note: A USB cable should be no longer than 5 m without booster.

11.16 Summa Plotter Does Not Read Out!

Error message: Waiting for response... Cannot open interface...

Check, if your plotter is set on the device language DMPL. If the cutter is set
to HPGL, read out via cable is not possible.

Tip 16

11.17 The Values for Cutting Pressure And Speed Are Not
Saved

After changing the values it is often forgottten to confirm the values. Please
press the  button beside the Enter Material field and enable the Save
Material Data option.

Tip 17

11.18 Error Message While Output into File

Error message: "Error for CreateFile"

This error message is given out, if the access right Write for the program
folder of EuroCUT is not set.

Relief: Enable write rights for the program folder.

Tip 18

11.15 Plotter Via USB Is Not Working!
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11.18 Error Message While Output into File
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Annex

A Hotkey Overview

Key F1 F2 F3 F4 F5 F6 F7
Function help zoom in

arbitrary

zoom out show all

objects

undo redo display

interruptible

Key A B C F G H K
Function axial change show material in

output-preview

clipart

toolbar

mill

hatch fill

change sel.

size

guidelines contour line

Key U V W X Y DELETE SPACE
Function inverse order

of layer

vectorize

trace

welding mirror

horizontally

mirror

vertically

delete object toggle arrow and

node tool

Key B C H I J K
SHIFT working area

output

Clipart-

Manager

guidelines

visible

rulers set

adjusting

markers

combine

Key 1 2 3 4 5 6 7
CTRL standard

toolbar

layer

toolbar

setup

toolbar

tools

toolbar

text editor

toolbar

node editing

toolbar

object para-

meter toolbar

Key F G H I J K L
CTRL crosshairs group define guidelines import file settings text to

curves

load file

Key U V W X Z
CTRL completely

backwards

insert from

clipboard

refresh window cut into

clipboard

undo

1 step

Key F8 F9 F10 F11 F12 ESC right mouse
Function show text contour mode object info save directly – close output

dialog

activate context

menu

Key – M O P R S T
Function – measure outline help for

positioning

arrange

objects

output enter text

Key – > < + -
Function – rotation clockwise rotation

counterclockwise

zoom in zoom out

Key L V Z F4 F7 F10 left mouse
SHIFT break

combination

revectorize text in rows show sel.

objects

undo / redo

on / off

properties restrain

hor. or vert.

Key 8 9 A B C D E
CTRL object info

status bar

element info

status bar

mark all break

grouping

copy from

clipboard

duplicate export file

Key N O P Q R S T
CTRL file new on top print file quit EuroCUT raster save file edit text

 Key R S T Y
SHIFT+
CTRL 

round save as text box always on

top
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B The ANSI Character Table

Under Windows, besides the characters on the keyboard there are many other characters
available. These are particularly the ANSI-characters from number 128 to 255. To shorten
the search for the correct character, we have integrated an ANSI list in the EuroCUT text
input. To insert a special character in EuroCUT, use the character table in the Textbox….

Attention: Not all font-character sets have the same allocation. It can vary from font
to font!

Example: to insert the character „¾” in the text, enter following number via the keypad:
ALT+0190. 

B The ANSI Character Table

351



C EuroCUT Basic 8 Fonts

Industrial Name Comparable With EuroCUT Font

Antique Olive EC Martinique Compact
Avant Garde Book EC Avalon
Avant Garde Book Oblique EC Avalon Italic
Avant Garde Demi EC Avalon Bold
Avant Garde Demi Oblique EC Avalon Bold Italic
Avenir 55 Roman EC Avenue
Avenir 95 Black EC Avenue Bold
Bodoni Poster EC Bodnoff
Brush Script EC Banff
Caslon Open Face EC Casablanca Open Face
Cheltham Book EC Chelsey
Cheltham Bold EC Chelsey Bold
Cheltham Bold Italic EC Chelsey Bold  Italic
Cheltham Italic EC Chelsey Italic
Compacta Bold EC Kompakt Bold
Compacta Bold Italic EC Kompakt Bold Italic
Cooper Black EC Cupertino
Cottonwood EC Cottage
Courier EC Standard
Courier Bold EC Standard Bold
Courier Bold Oblique EC Standard Bold Italic
Courier Oblique EC Standard Italic
Eurostile EC Euro
Eurostile Bold EC Euro Bold
Eurostile Bold Oblique EC Euro Bold Italic
Eurostile Oblique EC Euro Italic
Eurostile Demi EC Euro Demi
Eurostile Demi Italic EC Euro Demi Italic
Franklin Gothic No2 Roman EC Frankfurt
Frutiger 65 Bold EC Frank 65
Frutiger 95 Ultra Bold EC Frank 95
Freestyle Script EC Freeport
Futura Book EC Fujiyma
Futura Bold EC Fujiyma Bold
Futura Bold Italic EC Fujiyma Bold Italic
Futura Condensed EC Fujiyma Condensed
Futura Condensed Bold EC Fujiyma Condensed Bold
Futura Condensed Bold Italic EC Fujiyma Condensed Bold Italic
Futura Condensed Extra Bold EC Fujiyma Condensed Extra Bold
Futura Condensed Extra Bold Italic EC Fujiyma Condensed Extra Bold Italic
Futura Condensed Italic EC Fujiyma Condensed Italic
Futura Condensed Light EC Fujiyma Condensed Light
Futura Condensed Light Italic EC Fujiyma Condensed Light Italic
Futura Extra Bold EC Fujiyma Extra Bold
Futura Extra Bold Italic EC Fujiyma Extra Bold Italic
Futura Heavy EC Fujiyma Heavy
Futura Heavy Italic EC Fujiyma Heavy Italic

C EuroCUT Basic 8 Fonts
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Garamond Book EC Gatineau
Garamond Bold EC Gatineau Bold
Garamond Bold Italic EC Gatineau Bold Italic
Garamond Light EC Gatineau Light
Garamond Light Italic EC Gatineau Light Italic
Glypha 55 Roman EC Glister
Glypha 65 Bold EC Glister Bold
Gothic 13 EC Goethe
Helvetica Roman EC Swiss
Helvetica Thin EC Swiss Thin
Helvetica Thin Italic EC Swiss Thin Italic
Helvetica Bold EC Swiss Bold
Helvetica Bold Italic EC Swiss Bold Italic
Helvetica Compressed EC Swiss Compressed
Helvetica Italic EC Swiss Italic
Helvetica Neue Bold EC Swiss Neue Bold
Helvetica Neue Bold Italic EC Swiss Neue Bold Italic
Helvetica Neue Italic EC Swiss Neue Italic
Helvetica Neue Roman EC Swiss Neue
Helvetica Neue Thin EC Swiss Neue Thin
Helvetica Neue Thin Italic EC Swiss Neue Thin Italic
Hobo EC Homeward Bound
Juniper EC Jupiter
Künstler Script EC Kunst Script
Linotext EC Oldlinus
Linotype Centennial 55 Roman EC Centenniol
Linotype Centennial 65 Italic EC Centenniol Italic
Memphis Medium EC Memm Medium
Memphis Extra Bold EC Memm Extra Bold
Omnia EC Opitan
Peignot Bemi EC Peridon Demi
Present EC Perfect
Rockwell Roman EC Rocky
Rockwell Light EC Rocky Light
Rockwell Bold EC Rocky Bold
Rockwell Italic EC Rocky Italic
Shelley Allegro Script EC Shell Script
Times EC Roman
Times Bold EC Roman Bold
Times Bold Italic EC Roman Bold Italic
Times Italic EC Roman Italic
Trajan EC Troja
Univers Regular EC Usa
Univers Bold EC Usa Bold
Univers Bold Italic EC Usa Bold Italic
Univers Italic EC Usa Italic
Univers Black EC Usa Black
Univers Black Italic EC Usa Black Italic
Univers Thin EC Usa Thin
Univers Thin Italic EC Usa Thin Italic
Universal Greek with Math Pi EC Greek Meathe Symbole
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VAG Rounded Bold EC Helios Bold
Zapf Chancery Medium Italic EC Zürich Calligraph Italic
ID Automation EC-EAN
#-key assigned with ,- EC Plak
#-key assigned with ,- EC Plak Bold
#-key assigned with ,- EC Plak Bold Italic
#-key assigned with ,- EC Plak Italic
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D EuroCUT fonts

D EuroCUT fonts
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356



D EuroCUT fonts

357



D EuroCUT fonts
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D EuroCUT fonts
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D EuroCUT fonts
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D EuroCUT fonts
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D EuroCUT fonts
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D EuroCUT fonts
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D EuroCUT fonts
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E EuroCUT symbol fonts

E.1 Sign symbols (ECSignsymbole)

E EuroCUT symbol fonts
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E.1 Sign symbols (ECSignsymbole)
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E.1 Sign symbols (ECSignsymbole)

374



E.2 Sport symbols (ECSportsymbole)

E.2 Sport symbols (ECSportsymbole)
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E.2 Sport symbols (ECSportsymbole)
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E.3 Frame symbols (ECRahmensymbole)
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F Driver List

New or updated drivers can be downloaded from
www.eurosystems.lu/driver/index.dml?sprache=eng.

Allen Datagraph
824 830 836
848 936

Anagraph
ANA Express AE-101 ANA Express AE-101e ANA Express AE-120
ANA Express AE-120e ANA Express AE-60 ANA Express AE-60e
ANA Express AE-70 ANA Express AE-75e

Aristo
AG 130 Signline AG 50 Offline AG 50 Signline
AG 600 AG 75 Signline AG 75 Signline ABS
GL_TL ARISTOMAT 1310 ARISTOMAT 1317
ARISTOMAT 1617 ARISTOMAT 1625 ARISTOMAT 20x/30x/40x

Artsign
Artsign

ASC365
ASC365

Atlas
Atlas

Automated Cutting
Systems

ACS Design Studio Eagle

Calcomp
Classic

Cogi
CA 1300 CA 730 CP 630
CT 1200 CT 630 E 1360
E 720 E 870

Cole
CL1100 CL1350 CL720
CL870

COPAM
CP-2500 CP-3050 CP-3500
CP-4050 CP-4500
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Creation
PCUT CR1080 PCUT CR1200 PCUT CR630
PCUT CR900 PCUT CS1080 PCUT CS1200
PCUT CS630 PCUT CS900 PCUT CT1000
PCUT CT1200 PCUT CT1300 PCUT CT1600
PCUT CT630 PCUT CT635 PCUT CT900
PCUT CTN1080E PCUT CTN1200E PCUT CTN1500
PCUT CTN630 PCUT CTN630E PCUT CTN900
PCUT CTN900E

Creation HK
King Cut KCUT A1200 King Cut KCUT A24 King Cut KCUT A36
King Cut KCUT A48 King Cut KCUT A900 King Cut KCUT B24
King Cut KCUT B48 King Cut KCUT B900 King Cut KCUT CT1200
King Cut KCUT CT24 King Cut KCUT CT36 King Cut KCUT CT48
King Cut KCUT CT630 King Cut KCUT CT760 King Cut KCUT CT900

DAS
SmartCutter 12 SmartCutter 24

DCS
DCS-F300

Desay
XP-300P XP-380P XP-450P
XP-540P XP-660P

DGI
Omega OM-100 Omega OM-130 Omega OM-150
Omega OM-40 Omega OM-60 Omega OM-70
Omega OM-80

Emblem
EC 120 EC 60

Encad
NovaCut Series

Foison
C12 C24 C48
CT-1200 CT-630 FS-24
FS-48 S24

GCC
AR 24 Bengal BN-60 Bobcat BI-60
Expert 24 Expert 24 LX Expert 52
Expert 52 LX Expert II 24 Expert II 24 LX
Expert II 52 Expert II 52 LX Expert Pro-132S
Expert Pro-60 i-Craft Jaguar II 101
Jaguar II 132 Jaguar II 61 Jaguar III 101
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Jaguar III 132 Jaguar III 183 Jaguar III 61
Jaguar IV 101 Jaguar IV 132 Jaguar IV 183
Jaguar IV 61 Jaguar JG 101S Jaguar JG 132S
Jaguar JG 61 Jaguar JG 76S Jaguar V 101
Jaguar V 101 LX Jaguar V 132 Jaguar V 132 LX
Jaguar V 160 Jaguar V 160 LX Jaguar V 183
Jaguar V 183 LX Jaguar V 61 Jaguar V 61 LX
Jaguar V LX 101 Jaguar V LX 132 Jaguar V LX 183
Jaguar V LX 61 Puma II 132 Puma II 60
Puma III 132 Puma III 60 Puma IV 132
Puma IV 132 LX Puma IV 60 Puma IV 60 LX
Puma IV LX 132 Puma IV LX 60 Puma SP 132S
Puma SP 30 Puma SP 60 RX II-101S
RX II-132S RX II-183S RX II-61
RX II-61-CR RX-101S RX-132S
RX-183S RX-61 Sable SB-60
SignPal GRC Series SignPal LYNX S-132S SignPal LYNX S-30
SignPal LYNX S-60 Ultra GRC-101S Ultra GRC-132S
Ultra GRC-50 Ultra GRC-61 Ultra GRC-76S

Gerber
EmbossTrack Envision 375 Envision 750
FasTrack FasTrack 1300 FasTrack 550
FasTrack 650 GS15 HS 15 /750
Odyssey P2C 1200 P2C 1400
P2C 1400 Tangential P2C 1600 P2C 1600 Tangential
P2C 600 Sprint/4B old Sprint/4B Fastboard
Sprint/4B new

Grafityp
CSR CSR Ecom 92 CSRTurboDMPL
Flatbed

Graphtec
(HPGL) old CE 1000-60 (HPGL) CE 3000-120 (+USB)
CE 3000-40 (+USB) CE 3000-60 (+USB) CE 3000Mk2
CE 5000-120 CE 5000-40 CE 5000-60
CE 6000-120 CE 6000-40 CE 6000-60
CE 7000-130 CE 7000-160 CE 7000-40
CE 7000-60 Craft ROBO Craft ROBO PRO II
FC Series (GPGL) FC4100-100 (HPGL) FC4100-130 (HPGL)
FC4100-75 (HPGL) FC5100-100 (HPGL) FC5100-130 (HPGL)
FC5100-75 (HPGL) FC7000-100 FC7000-130
FC7000-160 FC7000-60 FC7000-75
FC8000-100 FC8000-130 FC8000-160
FC8000-60 FC8000-75 FC8600-100
FC8600-130 FC8600-160 FC8600-60
FC8600-75 FC9000-100 FC9000-140
FC9000-160 FC9000-75 JX 1060 (HPGL)
JX 1130 (HPGL) w/o perforation old Sign Jet Series
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Gravograph
Gravo-BOX 97 IS6000 IS800

Helo
HSP 1360 HSP 360 HSP 720

Hengxing
Rabbit HX-1000 Rabbit HX-1120 Rabbit HX-1360
Rabbit HX-630 Rabbit HX-720 Rabbit HX-800
Rabbit HX-960

HobbyCut
ABH-1351 ABH-361 ABH-721

Houston
100C DMPL 69C DMPL

HP
Latex 54 Latex 54B Latex 64

Ioline
Ioline Artpro 3500 Artpro 3700
Artpro 4000 Classic Signmaker 5000
SmarTrac I/S 110 SmarTrac I/S 130 SmarTrac I/S 60
SmarTrac I/S 85 Studio 7 Studio 8
Super 88

Jiachen
JC-1100DS JC-1100E JC-1100H
JC-1350DS JC-1350E JC-1350H
JC-720DS JC-720E JC-850DS
JC-850E JC-850H

Kierner
KS 90 (DCS)

Kimoto
Freecut 130 Freecut 150 Freecut 60
Freecut 75

Kuhlmann
MVP

LG Palopoli
MLP-24

Liyu
HC 1201 HC 751 HC 901
MC 631 MC 801 SC 1261
SC 631 SC 801
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Master
XP-300P XP-380P XP-450P
XP-540P XP-660P

Masterplot
Masterplot

MAX
CM-200

Mimaki
CG-100 CG-100EX CG-100Lx
CG-100SR II CG-100SR III CG-101
CG-12 CG-121 CG-130 FX II
CG-130EX CG-130FX CG-130Lx
CG-130SR II CG-130SR III CG-160 FX
CG-160 FX II CG-45 CG-5
CG-50 CG-51 CG-6
CG-60EX CG-60i CG-60SR
CG-60SR II CG-60SR III CG-60st
CG-61 CG-75 FX CG-75 FX II
CG-9 CG-90i CG-90SD
CJV-30-100 CJV-30-130 CJV-30-160
CJV-30-60 ME 500 ME 650
MY CUT

Mutoh
Junior 24 Kona 1400 Kona 1650
Kona 760 MC-1000 MC-1000S
MC-1300 MC-1300S MC-1650
MC-650S MC-750S SC Series
SC-1000E SC-1300E SC-550
SC-650E SC-750E TC-1000
TC-1300 TC-650 TC-750
Ultima SC 1400D ValueCut VC-1300 ValueCut VC-1800
ValueCut VC-600 XP-1251C XP-521C
XP-621C XP-941C

New Star
Omega OM-100 Omega OM-130 Omega OM-150
Omega OM-40 Omega OM-60 Omega OM-70
Omega OM-80

ORXYZ
Elite HX-Series JML-Series
LX-Series OR-Series
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Pericut
1000 1000/1300 IT (Transfer) 1300
901 901/1000/1300

PERITEC
1000/1200

RCS-Isert
Fräse,Gravierer

Redsail
RS1120C RS1360C RS720C
RS800C

Refine
EH-1101 EH-1351 EH-721
EH-871 MH-1101 MH-1351
MH-721 MH-871

Roland
CJ-500 CM 12 CM 24
CM 300 CM 400 CM 500
CX 12 CX 24 CX-300
CX-400 CX-500 EGX-350
GR-420 GR-540 GR-640
GR2-540 GR2-640 GS-24
GX-24 GX-300 GX-400
GX-500 GX-640 PC 50
PC 60 PNC 1000 PNC 1100
PNC 1200 PNC 1210 PNC 1410
PNC 1800 PNC 1850 PNC 1860
PNC 2100 PNC 2300 PNC 2700
PNC 5000 PNC 900 PNC 910
PNC 950 PNC 960 SP-300 (USB)
SP-300 (USB) Print & Cut SP-540 SP-540 Print & Cut

Secabo
C120 C40 C60
C60 II S120 S160
S60

SEI
Flatbed PLT 70 / 100

Seiki Tech
SK-1100H SK-1100T SK-1350H
SK-1350T SK-720H SK-720T
SK-850H SK-850T SK-870T
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Silhouette
Cameo

Summa
S One D120 S One D140 S One D140 FX
S One D160 S One D60 S One D75
S-Class 2 S120 D S-Class 2 S120 T S-Class 2 S120 TA
S-Class 2 S140 D S-Class 2 S140 T S-Class 2 S140 TA
S-Class 2 S160 D S-Class 2 S160 T S-Class 2 S160 TA
S-Class 2 S75 D S-Class 2 S75 T S-Class 2 S75 TA
S-Class S120 D S-Class S120 T S-Class S120 TA
S-Class S140 D S-Class S140 T S-Class S140 TA
S-Class S160 D S-Class S160 T S-Class S160 TA
S-Class S75 D S-Class S75 T S-Class S75 TA
SummaCut D1020 SummaCut D120 / D120 SE SummaCut D120R
SummaCut D1220 SummaCut D140 SummaCut D140R
SummaCut D15 SummaCut D160R SummaCut D500
SummaCut D520 SummaCut D60 / D60 SE SummaCut D60R
SummaCut D60R FX SummaCut D620 SummaCut D75R
SummaCut D760 SummaSign Pro D-Series SummaSign Pro D1010
SummaSign Pro D1300 SummaSign Pro D1400 SummaSign Pro D1600 SL
SummaSign Pro D610 SummaSign Pro D750 SummaSign Pro T 750
SummaSign Pro T-Series SummaSign Pro T1010 SummaSign Pro T1300
SummaSign Pro T610 SummaSign T 1400 Pro SummaSign T 1600 Pro SL
SummaSign T1010A SummaSign T600

Summagraphics
D1000 T1000

Technoplot
Millennium T 610 Pro Millennium T 750 Pro

Teetz
Controller

Universal Drivers
DMPL 0.025 HPGL 0.01 HPGL 0.025
HPGL 0.05 HPGL/2

USCutter
MH-1101 MH-1351 MH-721

VCS
MultiCAM

VHF
VHF1
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Vinyl Express
Bobcat Lynx Panther I 24
Panther I 30 Panther I 40 Panther I 50
Panther II 24 Panther II 30 Panther II 40
Panther II 50 Panther III 24 Panther III 30
Panther III 40 Panther III 50 Puma I
Puma II Q Series 100 Q Series 130
Q Series 160 Q Series 24 Q Series 30
Q Series 42 Q Series 54 Q Series 60
Q Series 64 Q Series 75 Qe60
Qe60+ R Series 19 R Series 24
R Series 31 R Series 39 R Series 44
R Series 53 ULTRA 24 ULTRA 30
ULTRA 40 ULTRA 50

VULCAN
FC-500VC

VyTek
GEM40 GEM54

WEEKE
Fräse

Wild-Leica
TA 10 TA 10 BL TA 10 BXL
TA 10 S TA 100 TA 100 BL
TA 100 BXL TA 100 S TA 2
TA 2L TA 30 TA 30 w/o Mat. Tr.
TA 40 TA 40 TP TA 400
TA 400 (Stop bef. Tr.) TA 400 G TA 400 G (Stop bef. Tr.)
TA 400 MC TA 400 MC (Stop bef. Tr.) TA 400 TP
TA 400 TP (Stop bef. Tr.) TA 41 TA 410 E / ES
TA 410 with suction bar TA 500 TA 500 MC
TA 510 TA 510 S

WISSNER
115 ( HPGL )

Zünd
2XL-3000 2XL-3000cv 3XL-3000
3XL-3000cv L-1200 L-1200cv
L-1600 L-1600cv L-2500
L-2500cv L-3000 L-3000cv
L-800 L-800cv LH-1600
LR-1600 M-1200 M-1200cv
M-1200s M-1600 M-1600cv
M-800 M-800cv P-1200
P-1600 P-2000 P-700
S-800 S-800cv XL-1200
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XL-1200cv XL-1600 XL-1600cv
XL-2500 XL-2500cv XL-3000
XL-3000cv XL-800 XL-800cv

Drivers marked with  are for flatbed milling and engraving machines and are only basis
drivers.
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G Dictionary of Technical Terms

Active and Passive Jobs Active jobs are those that are being cut. Passive jobs are
waiting in the queue for output.

Additional Programs Additional programs are program modules or stand-alone
programs that are part of the delivery.

Auto Import Plug-Ins Auto import plug-ins are used to automatically import
data from other programs - without intermediate steps.

Automatic Contour Pen
Conversion

This feature means that before the data is transferred the
software 'looks' for objects with the attribute 'contour'. If
so, the user can decide whether the contour is to be
converted or not. If the contour should be converted, then
a vector object with the width of the contour is
automatically generated!

Bitmap Functions Bitmaps are pixel images or photos. Bitmap
functions means all functions which are not vector tools
like node editing, and which are only applicable on
bitmaps.

By Color This is a welding function, which deletes all
surfaces, which are covered by overlying colors.

Bypass Cutting Direct cutting - without window - before output on the
cutter

CMX Data Transfer CMX data transfer means the handing over of data using
CorelDRAW's CMX data format. CorelDRAW had
created this format in order to ensure the exchange of
data within the Corel program families. CMX is a public
data format and is used for the exchange of data. This
has the advantage compared to EPS, that Corel specific
types of data can be copied 1:1, without making a
conversion of the format.

Cap Height Setting Cap height is the typographical correct unit of capital
letters. The text editor uses this unit by default when
calculating the font size.

Circular Text Is a special feature of the text editor with that text
blocks can be placed on or in a circle.

Clipart Tab Cliparts are job-similar files - often logos or patterns -
which are useful for the design of an output job. The
clipart tab is a sub-tab of the Sidebar, with that the
cliparts can be managed.
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Clone This function is usually used when creating labels and
series. Changes at the control object are transferred to
all clone objects.

Close
Objects (Automatically)

When importing DXF or HPGL data, many or all objects
are not closed. On a cutter only closed objects can be
processed reasonable. This function will automatically
close all vector objects. In the basic settings the
threshold for the closing of objects can be changed.

Contour Line (Print & Cut) Unlike the outline / inline bitmaps are here provided with
a vector contour. This function is regularly needed in the
creation of labels and stickers.

Create / Edit Text Block Text blocks are blocks of text that can be used more
frequently because they appear identical or similar in
many jobs - such as your address. With the PhraseWriter
arbitrary blocks of text can be created and modified as
needed.

Cut Out Region Is a bitmap function which provides the tracing of parts of
a bitmap. You can cut out any vector form out of a
bitmap.

Device Control This section deals with device control functions on the
output side.

Digitize Mode This feature means a drawing tool, that  similar
to digitizing tablet with a magnifier, draws nodes on the
working sheet.

Dongle Protection A dongle is a hardware copy protection that is stuck on
the USB port of the computer to make run the software.
The dongle protects producers against unauthorized
copying of its software and at the same time it protects
the investment of the buyer, since its competitors do not
get the software free of charge. Thus from dongle
protection both sides benefit - producers and buyers.

Drill Holes Drill holes is a special drawing tool, that marks the
position of a drill hole, using a crosshair cursor. If the
connected machine is capable of producing drill holes,
then the position is transmitted to the device driver.
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Files Tab Is a sub-element of the Sidebar, with that Jobs can be
managed. Job is the file extension, which is used from
EuroCUT.

Flatbed Cutter All cutters that have a flatbed as a cutting surface.

Folder Monitoring This function means that the software monitors a
selected folder on hard disk or network. Every time when
a change in the monitored folder occurs - by saving or
deleting of jobs -  the thumbnail gets updated.

Fontmanager The Fontmanager manages fonts in databases. The
advantage of this method is that the database can be
copied from one computer to another and thus the same
set of fonts is available on both computers.

Full Surface Is a welding function, which underfills objects in one
color, whose surfaces overlap another. The partially
hidden objects are treated in a way, that they are
underlaying all overlying objects.

Hatching In this milling method the area, which should be
removed, is provided with a hatching. The area gets
removed along the hatching using the milling tool.

Hotfolder Management A folder can be defined as a so-called hot folder. All
output jobs that are stored in this directory are supplied
to the output.

Job Calculation The Job Calculation means a function with that
preliminary costing can be done easily. This function is
particularly well suited for calculating charges of material
costs.

Job Info The Job Info can - referring to each job - save additional
information such as order number, customer address,
material, time spent, a. s. o..

Job Rerun Any job that is still in the job history can be cut again
identically. The actual to the machine transmitted data is
stored. All parameters are given out into the output file.

Laser Engraver Name for all devices which don't use an engraving
needle but a laser unit.

 - This device type is supported by the software suite
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OptiScout. Full info at: www.optiscout.com

Layer Tab Is a sub-element of the Sidebar, with that layers can be
managed. Layers are color levels which determine and
control output order and tool parameters - besides object
position.

Material Display Each color layer can be assigned a specific material with
an exact material description. The assigned material is
displayed before the output in the Job Calculation, Job
Info and the layer itself.

Milling & Engraving This rubric lists the specific functions and tools which
were implemented for milling and engraving.

Monitor Output Process With monitoring, we mean that the output process can be
suspended, stopped and continued. Active jobs can be
switched to passive and if necessary be re-activated.

Multi Inline In this milling method the area, which should be
removed, is provided with multiple Inlines. The area gets
removed along the inlines - from outside to inside.

Multi Port Support With this we mean that all ports on a given computer -
which are suitable for the issue - can be used. Typically,
these are all COM and USB ports.

Multi User Versions
Available

For every main license multi-user version can be
purchased. The additional versions here have the same
serial number as the main license.

Multi-functional Cutter Multi-functional cutters are devices which can use
various tool heads beside a cutting tool head. They are,
for example, oscillating knives, spindles, and hemming
tools.

 - This device type is supported by the software suite
OptiScout. Full info at: www.optiscout.com

Multiple Cutting Option to cut easier thick and resistant materials

Node Editing Main tool for the creation and editing of vector objects.

Objects Tab Is an sub-element of the Sidebar with that objects can be
managed. A large number of object attributes such as
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visible / invisible, do not output, do not print, can be
individually defined for each object.

Open Trimming Is a welding function, which creates open vector objects,
after they were separated at their intersections.

Optimization Targets of the optimization are: diminishing of rejection
rate, material saving, time saving, optimization and
shortening of job preparation. The optimizing of objects
can be done on the working sheet or in the output
preview. The objects are sorted so that the material
consumption, without nesting of objects, is minimized.

Outline / Inline Outline is a special function, where vector object is
contoured automatically with a contour in a predefined
distance. In contrast to the contour line, the outline
creates - in case of internal objects - so called Inlines.

Parallel Device Output This function can simultaneously provide data on multiple
machines, which are connected to a computer, if
sufficient computing power on the PC is given.

PhotoCUT PhotoCUT is a program module which can convert
halftone drafts into vector stripes. The so generated
vector stripes can be cutted on each usual cutting plotter
and, generate - with the appropriate viewing distance -
one photo-like effect.

PhraseWriter The PhraseWriter is a program module for the
management and use of text blocks. It is automatically
started at startup and is accessible at any time using the
right mouse button context menu. The specified text
block is selected and then inserted and displayed on the
desktop.

Plot Manager The Plot Manager is a separate program module, which
'background' controls and monitors the output of the data
on the selected device.

Plot Server Function
(TCP/IP)

A computer at which multiple output devices are
connected can act as a plot server. The data transfer can
take place via the network using TCP / IP. Assuming the
appropriate licenses, any number of client computers can
give out on the plot server devices.

Plot to File The output of the plot data can be redirected to a file.
The user only has to activate the appropriate option in
the output dialog.
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Posterize Posterize is a bitmap function which performs a reduction
on any number of color hues per color layer.

Preview *.CDR and *.CMX The files tab can display besides *.JOB also contents of
*.CDR and *.CMX files (CorelDRAW formats).

Productivity Tools Productivity tools are special tools, which - because of
their workings - enhance the productivity of sign making
processes. These are usually such tools, which
distinguish a cutting software from illustration programs
such as Illustrator and CorelDRAW.

Program Type This section summarizes certain criteria which
characterize the use of the program.

Reference Job (*.JRF) In a so-called Reference Job the environment, the tool
parameters and the device drivers are stored. In this
way, it is possible to output the job in an identical manner
as many times as wished.

Register Mark Is a special drawing tool, with that marks, for the making
of multi-colored foil signages, are drawn. This register
marks can consist of a cut-through or a filled square and
are positioned by the user to the desired position on the
output job. While the output these registration marks are
always cutted at the same position on the vinyl
(layer independently), so then the precise assembly of
various colors is possible.

Roll Cutter Roll cutter means all cutting plotters, which can only
handle material rolls.

Screen Printing Is a welding function, which allows the changing of the
color stack. Thus, the order of the colored vinyls can be
re-sorted - interactively - from light to dark.

Segmentation with Overlap Segmentation is always necessary when the job is larger
i.e. longer or wider than the connected device is able to
plot. The overlap is necessary when the individual
segments are to be completed to a whole again. Joining
otherwise would lead to undesired white gaps.

Sidebar Sidebar means a movable control element that can be
made visible on the desktop. The individual sub-elements
are activated by clicking so-called 'tabs'.

Sort with Simulation In this function, all objects are sorted according to a
certain criterion. For some output devices such as lasers
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or milling machines the sequential processing of the
objects is important. Therefore, the output can be
simulated and the collation can be adapted to the
requirements of the output device.

Space (1/1, 1/2, 1/4, 1/8) Special function with that micro-typographical-correct
spaces (keyword: em quad) and thus word / letter
spacing can be generated. These special spaces can be
directly entered via the keyboard.

Spool Function When the Plot Manager is activated with the parameter
!SPOOL!, it runs independently without starting the main
program. Output data can be activated and given out via
Drag & Drop.

Spot Colors Definable Spot colors are color layers, which are defined in a way
that color values are additionally given out. Some hybrid
devices and RIPs use spot color values for the control of
output processes. When printing the corresponding color
plates are given out.

Stacking Stacking means that at first as many objects are
positioned adjacent as will fit on the material. The
following objects are then positioned above it. This
process is repeated until all objects are positioned on the
material.

Stand-alone Software "Stand-alone" means that this program can be used
without any other so-called host program. It has all the
tools that are needed for the design, layout, and the
output of jobs.

Start Tool Paths When milling and laser engraving it often happens that
immersion traces are visible at the start point of an
object. To ensure that the quality of the objects which are
milled is not affected, the start point can be laid outside
the object. This task is performed by so-called start tool
paths.

Status Display Material
Consumption

In the output preview at the bottom of the window is a
status line where the material consumption of the job is
displayed in square meters. Since this happens before
the output, this feature can also be used to order exactly
as much of a material as is required currently for the job.

Symmetrical Object This is a tool that can create stars and polygons. With it
the initial shape (circle, ellipse) and the number of edges
can be specified. With its own drawing tool then the
symmetric objects on the desktop are drawn.
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Templates (*.JTP) Templates or patterns are jobs which have no
name (untitled) when opened. Templates can always be
created if they can serve as an example for other similar
jobs. The advantage is that the working sheet and layout
are predefined.

Test Run Before the actual output a so-called test drive can be
carried out to examine whether, for example, the material
is sufficient. During the test run the raised tool head
moves along the vectors.

Text Editor Text editor means program functions that include all the
tools necessary for professional capturing and editing
texts. Typographic special tools that are essential for
signmaking were implemented.

Text Import (*.TXT, *.RTF,
*.ECT)

External texts can be imported directly into the so-called
text box, with the above formats being used. For
formatted text the RTF format must be used. It can be
saved from every professional word processing program.

Thumbnail Preview Thumbnails are small low-resolution pixel previews of file
contents. All in the selected folder located files will be -
by means of the thumbnail preview - visible and
manageable.

Tool Parametrization Means that specific settings for a tool can be done by the
user. This can be values for speed, drive, depth, angle,
pressure, acceleration or other parameters. The device
driver provides the parameter fields. The user can edit
corresponding parameter values before the output on the
device.

Tool Assignment To each color layer a specific tool can be assigned. This
makes creation and processing of jobs much easier. The
selected device driver provides all possible tools. The
assignment itself can be done by the user individually.

Track Logging For each tool the distance will be recorded. In addition,
the date, time and device names are stored.

Trimming Is a welding function, which separates closed vector
objects using lines or curves. The resulting partial objects
are re-closed then automatically.

TrueType, OpenType, Type
1, BE Fonts

These 4 font formats can be managed with the
Fontmanager i. e. add, enable and disable.
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URW BE Fonts The BE-type format was created by the company URW.
The BE-format is a vector font format that was shipped
with SIGNUS systems.

Vectorization, Tracing Vectorization means the conversion of bitmaps (pixel
images) to vector contours.

Video Marks (Print & Cut) Video marks are marks that can be detected by cutters
with optical sensors or cameras to compensate for
inaccuracies of the print result. In the print and cut
process they are used also for the contouring of print
objects.

Wait After Segment If a job has to be segmented, then the user receives this
option with the ability to re-equip the machine before the
next segment is processed. By means of a message
window the process can be continued at any time.

Weed-Ex Driver Option It is a specially laminated flex or flock material of Witpac
GmbH. First, the actual vector lines are cut. In the
second step, the components that need to be weeded,
are cut out in a way, that they 'fall out' automatically at
the end. So you have already reached the entire plot
result after peeling off the medium and you don't have
to weed manually.

Weeding Lines horiz. / vert. In addition to the global weeding frame, which is
generated around the entire output job, individual
weeding lines can be added horizontally or vertically in
the output preview. Large, bulky jobs can thus be
divided.

Welding Welding functions are needed for the treatment of
overlapping of layers or vinyls. These functions are in the
signmaking and screen printing department essential for
the processing of vinyls.
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H Glossary

Additive color system The ~ is based on mixing the additive, luminous spectral colors
red, green and blue (RGB), for example in color TVs or color
monitors

Adjustment Modification of the distance between two adjacent characters
so that a harmonic type face is being created. This is reached
by correcting the character - or word distance.  With distances
below 100% you speak of kerning and with values above 100%
of spacing out.

Adjustment handles ~ are the 9 black squares that are drawn around the object and
in the middle when marking objects.

Antialiasing Edge smoothing with bitmaps

Application tape Foil that is used to apply the cut foil after the weeding on the
lettering area. The adhesive force must be strong enough so
that the text - even the tiniest letters - can be released from the
substrate without problems. After application, the ~ must also
be released without problems. 

Ascender Term for the part of a character that extends above the middle
length.

Backup Data backup

Bit-depth also shade ~ is the mathematically possible number of colors with a
specific number of bits, for example:
1 bit color depth = 21 = 2 possible colors (black/white)
8 bit color depth = 28 = 256 possible colors/shades of gray
24 bit color depth = 224 = 16.8 millions possible colors

Bitmap Pixel-graphic

Bold Font that a bit thicker than the standard typeface.

Byte Smallest addressable unit in the computer memory, consisting
of 8 bits.

Calibration Adaptation of printer, monitor, cutter or adaptation to desired
values.

Cap height This is the height of the capital letters, the capitals. As
measurement usually the height of the letter „H” from the font
line to the top edge of the character is used.

Center justification A break justification where the text block is justified at the same
time on the left and on the right side. To do this, the word
space within a text line is varied (usually extended) so that on
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the left and right side a clean text edge is created. This is not
only applied for the the last line of a break.
compare also: forced block

Clipart(s) ~ are jobs or job parts that were added to the Clipart toolbar .
They are saved in a separate directory. (C:\Program
Files\EUROSYSTEMS\EuroCUT Basic 8\CLIP)

Clipboard ~ is used for temporary storage in Windows.
The ~ is used to exchange data fast between applications. 

CMYK Cyan, magenta, yellow, contrast (key, black) Standard colors
for the four-color printing.

CMYK-color area ~ is the total number of colors that can be displayed by the
colors used when printing (CMYK).

Color depth ~ is the number of possible color tones that can be recognized
by a scanner or reproduced on a color monitor.

Container A container - more exactly an image or text container - is a
vector object, that similar to a real container can take up
arbitrary image data or texts. In conjunction with macro scripts
contents can be exchanged semi-automatically or
automatically.

Context menu Context menus are called so because the structure adapts and
changes depending on the number and type of the selected
objects (context). Context menus are always activated with the
right mouse button. They serve for the faster access to
important functions and tools and also to those functions that
cannot be activated via the main menu.

Contrast Contrast; range of brightness between bright and dark parts of
a picture.

Cursor ~ is the blinking, vertical line in an editable field.

Decoration Accentuation of text parts by modification of the text attributes,
for example bold, italic.

Descender This is the part of a character that protrudes below the font line.

Desktop The area besides the working surface that can be used for the
draft. It is comparable to a desk on which are the tools.

Digitalization Conversion of a picture template into a digital form. The
capture is done point for point or line by line by means of a
digitalization tablet or by reading the template with a scanner.

Dongle

H Glossary

397



Means the copyright that is part of the scope of delivery of
EuroCUT. It is inserted in the USB interface of your computer.
Without ~ the software cannot be started.

Download Downloading applications or files from the internet to your
computer.

DPI Acronym for Dots Per Inch; resolution fineness (1 inch = 2.54
cm)

EPS Acronym for „Encapsulated Postscript Format”. In this file
format the text and picture information is saved in the page
description language postscript. This format also contains
besides text and raster data also a preview bitmap which
allows displaying a copy of the data on the screen.

Foil Two production processes are common: calendaring and
casting. Cast foil is created without drawing frame and thus has
a lesser shrinking tendency. The costs are usually higher than
with calendared foil. Calendared is cheaper, has a shorter
period of usage and shrinks more.
Cutting foils are built in three layers:
1. Substrate; the lowest layer
2. Gluten layer; is between the foil and the substrate
3. the foil itself.

Font Type cut within a type face in digital form. Most type faces
have the fonts normal, bold, italic and bold-italic. Often, the font
is used for the same type face. Correct would be that each cut
is a separate font.

Font line ~ is a thought line on which the characters of a row are
standing. Even if different font types and font sizes are used
in a row, all characters must stand on a common font line.

Font size ~ is the size of a font. It corresponds to the block height, which
means it also comprises the ascender and descender as well
as a certain space above and below the characters. 

Forced justification Justification where all text lines - also the last- are adapted to
the width of the column or the working area. In EuroCUT this
justification is called „force justification”.

Gamma correction The ~ is a method for the correction of color graduation
considering the perception of the human eye if there are two
adjoining areas of different color.

Group Combination of arbitrarily many objects to a group. The
position of the objects itself does not change any more within
the group.
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Halftone image(s)  ~ are pictures which contain shades of gray or hues. The tonal
value between pure white and pure black is called halftone.

Hotfolder A Hotfolder is a directory monitored by the Plot-Manager. If a
file is copied into this directory, the Plot-Manager carries out
automatically specific configurable functions.

Inch Measurement unit for the length
1 Inch = 2.54 cm

Job File-ending of EuroCUT; name for EuroCUT file

Justification Alignment of a text block on the working area. EuroCUT offers
justification left-aligned, right-aligned, centered, center
justification, forced center justification and adjust cap height.

Kerning If two characters stand closer together than it would
correspond to their standard thickness, you speak of ~. With
character combinations as for example „Te” you have a
balanced type face.

Laminating Covering with transparent plastic films.

Live-Update Updating of software via the internet.

Macro A ~ automates program flows. The automation can thereby be
realized with the program's own commands or a macro
language.

Marking function ~ means marking objects by keeping pressed the left mouse
button, then drawing a frame around the objects to be marked
and letting go the mouse button only if all objects to be marked
are completely within the frame. 

Process colors Printing scale of colors for four-color-printing with cyan, yellow,
magenta and black (key). By mixing these colors, it is possible
to print all colors.

Profile The appearance of program surfaces is called ~. The shown
tools and menu items can be individually adjusted to the
user. Intention is to simplify the user interface.

Raster Image Processor short: RIP - Software that rasterizes vector data and controls
the printing on a large format printer.

Resolution Number of pixels per track unit. It is indicated in dpi (dots per
inch). Laser printers have a resolution from 600 to 1200 dpi.

Scan resolution Fineness of the resolution when scanning analogue images
Formula:
Resolution (in DPI) = printing length (L/cm) x 2 (quality factor) x
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enlargement factor x 2.54 (when converting from cm into inch)

Subsidiary line These are lines for the virtual alignment of objects on the
working area or the desktop. Subsidiary lines are only visible
on the monitor are neither plotted nor output on the printer.

Superscript The characters are set higher than the characters standing on
the baseline. They usually have a bit smaller font size than the
basic font.

Toolbar can be freely moved and positioned on the working area of an
application. Often, also the composition of the tools can be
defined.

Trapping A small overlapping zone at the limit of superposed colored
elements. This ~ guaranteed that no white gaps occur at the
color borders. The overlapping can happen through overfilling
or underfilling.

Upload Upload is the sending of files or applications to a networked
server

Weeding means the removal of unnecessary foil parts after the cutting
with a cutting plotter. 

White gaps ~ are the gaps on the edges of overlapping or abutting color or
foil areas. Disadvantageous especially with silk-screens or
when printing.

x-height Height of the lower case/character „x” respective the lower
case without the ascender of a font.
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A

Access rights  22, 70, 71

Activate fonts  313

Active Jobs  165, 191, 266, 267, 268, 269, 272, 387, 390

Add fonts  313

Adjust curves  257

Adjust height of caps  196

Align  21, 126, 142, 176, 200, 230

Always print black  110

Anchor line  215

Attributes tab  20, 98, 103

Auto import plug-ins  24, 387

AutoCAD  8, 24, 39, 42, 43, 84

Automatic welding  81, 227, 243, 344

Automation  23, 354, 399

Autosave  24, 115

Axial change  349

B

Backup  3, 5, 13, 24, 396

Backup file  24

Bitmap fill  21, 248, 249

Bitmap fill  21, 248, 249

Block shadow  19

BMP  22, 49, 68, 97, 133, 250, 274
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Break combination  123, 349

Break group  122

Bridges  21, 74, 128

Brightness  19, 248, 397

C

Cap height  97, 178, 195, 196, 387, 396, 399

CCJ  22

CDR  20, 22, 26, 392

CDT  22, 26

Character spacing  23, 81, 179, 180, 195, 215, 243, 310

Character table  23, 196, 216, 217, 326, 351

Circular Text  172, 196, 214, 387

Clipart  20, 128, 174, 281, 292, 293, 294, 295, 296, 297, 298, 299, 300, 349, 387, 397

Clipart group  20, 128, 292, 295, 296, 297

Clipart tab  128, 387

Clockwise  127, 215, 231, 232, 235, 349

Clone  23, 84, 122, 171, 172, 173, 185, 205, 388

Close objects  23, 151, 203, 232

CMX  20, 22, 36, 68, 387, 392

CMYK  20, 154, 248, 289, 397

Color graduation  60, 120, 173, 246, 247, 252, 398

Color palette  149, 154, 155, 240, 247, 286

Color reduction  255

Combine  24, 122, 149, 173, 199, 203, 349

Context sensitive menu  223
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Contour cutting  85

Contour line  23, 76, 79, 84, 86, 124, 133, 172, 203, 225, 226, 227, 259, 260, 261, 349,
388, 391

Contour pen  123, 135, 387

Contrast  19, 275, 280, 391, 397

Convert to bitmap  19

CorelDRAW  8, 15, 22, 24, 26, 34, 36, 40, 41, 84, 281, 387, 392

CoRUN  39, 40, 41, 42, 84, 167, 191, 192

Counterclockwise  127, 231, 232, 235, 349

Crop marks  141, 144

Cross hair  251

Crossfade  19

Curve to line  21

Cusp  21

Cut region  19, 172

D

Deactivate fonts  25, 314

Delete nodes  21, 199

Device driver  43, 44, 53, 59, 60, 146, 287, 346, 388, 394

Device Options  272

Device Options  272

Digitize mode  125, 171, 388

Dimensioning  21, 209

Drag & Drop  20, 22, 292, 295, 393

Drill holes  388
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Driver  4, 26, 38, 43, 44, 47, 52, 53, 55, 57, 58, 59, 60, 62, 65, 66, 72, 75, 87, 108, 145,
146, 188, 189, 206, 232, 265, 271, 287, 290, 340, 342, 343, 346, 378, 388, 394, 395

Duplicate  19, 25, 121, 122, 138, 151, 315, 327, 349

Duplicate Fonts  25, 315

DXF  22, 43, 49, 388

E

Edit program  134

EMF  22, 49

Encrypt document  70

Envelope  19

EPS  22, 68, 73, 84, 291, 345, 387, 398

Export Fonts  315

F

File formats  116, 147, 175, 313, 316

Files tab  389

Fills  41, 250

Filter contours  257

Foil optimization  95, 187, 203

Font color  211

Font preview  25, 317, 326

Font size  24, 195, 196, 215, 346, 387, 398, 400

Font weight  24, 195

Fontmanager  25, 136, 137, 194, 309, 344, 389, 394

Forward one  131

Freehand  8, 19, 39, 84, 125, 126, 171, 345

D
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Full surface  19, 76, 77, 79, 80, 81, 82, 96, 98, 100, 101, 103, 238, 239, 244, 245, 256,
261, 389

G

Gamma correction  19, 398

GIF  22, 49, 97

Gradient fill  21, 246

Grid  24, 157, 158, 162, 193

Grouping  90, 122, 131, 209, 349

GTP  22, 49

H

Hairline  79, 123, 173, 238, 239, 345

Hatch  22, 172, 349

Hatch fill  22, 349

Hatching  389

Horizontal mirror  121, 187, 203

Hot folder  389

HPGL  22, 49, 68, 347, 380, 384, 385, 388

HSB  20, 248, 289

I

IK  22, 49

Illustrator  8, 24, 34, 35, 39, 41, 84, 345, 392

Import  20, 22, 24, 25, 41, 43, 49, 50, 51, 97, 102, 147, 148, 149, 150, 151, 173, 175, 177,
193, 249, 250, 296, 306, 312, 316, 329, 345, 349, 387, 394

Import filter  22, 51, 147

Inline  22, 78, 135, 225, 388, 390, 391

Inner circle  260
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Insert fill bitmaps  248

Insert nodes  21

Insert program  117

Invert  19, 325

Invisible  20, 119, 158, 160, 162, 170, 287, 391

Island fill  22

J

Job info  23, 115, 119, 193, 254, 262, 389

Job-calculation  173

Join nodes  21, 199

JPG  22, 97, 250

Justification  157, 195, 215, 396, 398, 399

K

Keep reference point  145

Kerning  23, 179, 180, 223, 310, 344, 396, 399

L

Laser  25, 76, 182, 389, 393, 399

Last version  115

Line spacing  24, 177, 178

Line to curve  21

Local device  57, 60

M

Macro  43, 97, 295, 397, 399

Macros  4, 20, 23, 41, 129, 281
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Macros Tab  20

Magnifying glass  206, 207

Margins  24, 47, 48

Mask bitmap  172

Material consumption  25, 90, 391, 393

Max. width  196, 212

Measure  21, 125, 134, 196, 207, 217, 253, 342, 349

Memo field  23, 119, 262

Metric  21, 157, 209

Milling  36, 44, 46, 57, 85, 89, 127, 128, 133, 145, 156, 182, 198, 386, 389, 390, 393

N

Navigator  20

New origin  21, 65, 145, 198

Node editing  21, 171, 172, 181, 196, 197, 202, 344, 349, 387, 390

Not visible  287, 290

Number of copies  25, 87, 110, 226

Number of outputs  25, 272

O

Object list  21, 127

Object names  21

Object preview  21

Object selection with preview  21

Object tree  21

Offset  24, 63, 69, 120, 138, 142, 144, 157, 245, 251, 260

Online help  24

M
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Online support  4, 167, 192

Open Job  20, 193

Open trimming  20, 81, 135, 242, 243, 391

OpenType  25, 310, 322, 335, 394

OPI  22, 68, 73, 84

Optical sensor  34, 38, 72, 84, 86

Optimization  23, 24, 26, 90, 91, 94, 95, 187, 203, 234, 235, 237, 391

Orientation  16, 23, 47, 48, 108, 138, 157, 158, 161, 209, 232, 233, 235, 251, 257

Orthogonalize  21, 200

Outline  21, 22, 25, 36, 38, 39, 76, 78, 79, 84, 86, 120, 133, 136, 173, 225, 226, 227, 239,
240, 250, 251, 256, 259, 349, 388, 391

Output preview  26, 63, 66, 89, 92, 171, 187, 188, 189, 192, 206, 232, 391, 393, 395

Overlap  81, 82, 83, 95, 146, 243, 257, 336, 389, 392

P

Page margin  142

Passive Jobs  25, 266, 267, 268, 269, 387

Password Protection  22, 23, 70, 263

Password protection  22, 23, 70, 263

PCX  22, 49, 68, 97, 133, 250, 274

PDF  7, 22, 36, 49, 50, 70

Pen attributes  77, 123, 124, 238, 239, 240

Pen thickness  60, 239

Perspective  19

PhotoCUT  19, 133, 134, 274, 280, 391

PhraseWriter  25, 172, 301, 304, 306, 307, 388, 391

Plot Manager  58, 60, 66, 67, 117, 145, 265, 266, 270, 272, 391, 393
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Plot server  25, 58, 60, 265, 391

Plot to file  42, 64, 145, 267, 270, 273, 391

PLT  22, 42, 68, 271, 383

PNG  22, 97

Positioning  23, 24, 107, 122, 136, 157, 161, 196, 201, 210, 213, 217, 220, 251, 349

Positioning assistance  157

Posterize  19, 172, 392

Prepare to cut  120

Print & Cut  23, 34, 79, 84, 85, 383, 388, 395

Print and Cut marks  85

Print area  107, 113

Print on roll  22

Print to file  22, 110

Producer  5, 8, 86

Q

Queue  25, 387

R

Read out  146, 347

Recalculate  171, 188

Rectangle  63, 124, 131, 342

Redo  25, 118, 139, 161, 173, 193, 222, 228, 229, 349

Redo  25, 118, 139, 161, 173, 193, 222, 228, 229, 349

Reduce colors  19, 172

Reduce nodes  21, 128, 172, 181, 185, 197

Reference Job  23, 392
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Reference Point  63, 145, 157

Reference point  63, 145, 157

Refresh screen  132, 173, 174

Register mark  19, 126, 392

Register marks  34, 67, 84, 85, 134, 142, 143, 392

Registration marks  392

Relief  347

Remote maintenance  24

Rename Fonts  314

Retain skew  215

Revectorize  24, 172, 349

Reverse cutting  94

RGB  20, 48, 154, 248, 289, 396

Roll plotter  72

Round edges  181, 186

Rounding  21, 128, 186, 197, 202, 226

Ruler  24, 159, 160, 162, 169, 170, 248, 342

S

Saturation  19, 248

Save as  116, 187, 268, 269, 270, 273, 286, 301, 306, 349

Scale with object  239

Scan  117, 193, 249, 343, 399

Screen printing  17, 20, 81, 82, 94, 135, 242, 243, 244, 245, 392, 395

Seamless tiling  250, 251

Search Fonts  315

R
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Segment  23, 26, 63, 64, 94, 95, 145, 146, 171, 395

Segment optimization  94

Segmentation  26, 64, 93, 94, 95, 392

Select layer objects  20

Send via eMail  24

Separate  81, 93, 128, 149, 158, 315, 328, 344, 391, 397, 398

Serial numbers  23

Shades of gray  276, 399

Sharp node  198

Sharpen edges  181, 186

Sharpness  19

Show object attributes  21

Smooth  8, 15, 21, 183, 198, 201, 258

Smooth curve  21, 198

SOR  22

Sort with simulation  23

Special characters  70, 196

Spooler  59, 271

Spot color  36, 291

Stack  63, 67, 82, 131, 145, 146, 228, 229, 244, 392

Stack distance  146

Stack processing  145

Stack spacing  146

Start tool paths  182, 393

Step by Step  20, 72, 342

Stop watch  254
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Stripe direction  19

Stripe distance  19

Stripe form  19

Stripe width  19

Subscript  24, 195

Subsidiary lines  110, 161, 162, 400

Superscript  24, 195, 400

Symmetric node  198

Symmetric node  198

Symmetric objects  393

T

Tabulators  24, 196, 212, 213, 214

Template  94, 115, 149, 214, 249, 275, 277, 280, 397

Test drive  66, 189, 394

Text editor  23, 81, 98, 136, 172, 176, 194, 211, 243, 314, 349, 387, 394

Text export  24

Text in curves  345

Text modules  301, 302, 303, 304, 306, 307

Thumbnail  20, 293, 294, 296, 298, 389, 394

Thumbnails  297, 298, 394

TIF  22, 49, 68, 97, 133, 250

Tiling  110, 112, 250, 251

To back  131, 223

To front  130

Tool assignment  20, 53, 55, 63, 73, 142, 146
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Tool parameters  392

Trim  81, 82, 83, 242, 244

TrueType  136, 194, 309, 312, 322, 323, 333, 334, 335, 394

Type 1  23, 25, 136, 194, 309, 310, 312, 320, 323, 334, 335, 394

Type size  134

Typeface  396

U

Undo  25, 118, 139, 161, 173, 193, 222, 228, 229, 255, 318, 349

URW Signus  22

V

Vectorization  133, 255, 256, 343, 395

Vectorization  133, 255, 256, 343, 395

Vertical mirror  187, 203

Video marks  23, 63, 85, 86, 134, 395

W

Wait after segment  26, 145

Weed border distance  63, 90

Weeding frame  19, 26, 66, 91, 92, 93, 146, 150, 171, 188, 189, 192, 395

Weeding lines  26, 91, 92, 93, 171, 188, 189, 395

Welding  19, 37, 77, 78, 81, 82, 135, 227, 242, 243, 244, 344, 349, 387, 389, 391, 392,
394, 395

Wire frame mode  238, 239

WMF  22, 49

Word spacing  24, 178, 179, 195

U
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Zoom functions  202
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